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There are three categories of T3 Professional Development, each with a unique set of learning objectives. 
This workshop is focused on technology integration, and its objectives are as follows: 
 

Technology Integration 
 Emphasis on learning to use TI technology, with broad “how-to” coverage highlighting a 

wide range of features 
 Subject/content-focused training on appropriate usage of TI technology in the classroom 

• I am comfortable with essential technology skills for exploring math and science content. 
• I can design opportunities for students to use technology as a tool to deepen their 

understanding of mathematics and science. 
• I can locate and download TI activities that align to my standards. 
• I can describe the role technology should play in the successful implementation of my 

standards, and I can implement a vision of a classroom where students routinely use 
technology to engage in the practice and content standards. 

 
 

Workshops focused on instructional practices and content knowledge have the following objectives: 
 

Instructional Practices 
 Emphasis on classroom practices with technology as a tool to enhance student learning 
 Models CCSS, TEKS, and NGSS tasks using in-depth discussions, reflective practices, and 

essential technology skills 
• I can demonstrate the importance of teacher actions for students’ engagement in the 

Practices, and I can take actions that will enable students to become mathematical 
and scientific practitioners. 

• I can describe the role that technology should play in the successful implementation 
of my standards, and I can implement a vision of a classroom where students 
routinely use technology to engage in practice and content standards. 

• I can design tasks for students to employ the Practices, using technology as a tool to 
deepen their understanding of mathematics and science. 

• I can ask questions designed to make student thinking visible – to push them to think 
about connections, make comparisons, or probe their understanding. 

 

Content Knowledge 
 Emphasis on content with technology as support 
 Addresses critical, tough-to-teach topics and new content standards for CCSS or TEKS 

• I have a deeper understanding of the mathematics and science in my content area, 
and I am aware of the shifts in content that affect what I teach. 

• I can design opportunities for students to use technology as a tool to deepen their 
understanding of mathematics and science. 

• I can locate and download TI activities that align to my standards. 
• I can describe the role technology should play in the successful implementation of my 

standards, and I can implement a vision of a classroom where students routinely use 
technology to engage in the practice and content standards. 
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Activity Overview 
In this activity, you will see how easy and efficient it is to collect and analyze data using TI-Nspire™ 
technology and the built-in Vernier® DataQuest™ application. 
 
 

Materials 
• Vernier® EasyLink™ adapter 
• Stainless Steel Temperature probe 

 
 

 
 

Step 1:  

Turn on the TI-Nspire™ CX handheld, and create a new 
document by selecting New Document. 

• If asked to save the current document, select “Yes” or “No.” 

A new document will appear. Though you have the opportunity 
to add one of the seven built-in TI-Nspire applications, do not 
select an application at this time.  

 

 

 

Step 2:  

Obtain a TI Stainless Steel Temperature probe and the Vernier 
EasyLink adapter. 

Plug the TI Stainless Steel Temperature probe into the EasyLink 
adapter, and then connect the Vernier EasyLink adapter to the mini-
USB port on top of the handheld. 

This should launch the Vernier DataQuest application on Page 1.1.  
 

 

 

 

Step 3:  

Discuss the following questions with your partner: 

• What is the temperature? What are the units? 

• How often does the temperature reading update? 

• What are the default settings for the mode, rate, and duration? 

• What happens as e is pressed? 

• What do you think each of these icons represent?        
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Step 4:  

Let the temperature probe reach room temperature. Note your measure of the 
temperature of the room and compare it with others around you.  

• Are the values the same? 

• If not, how could one account for the differences? 

 

Step 5:  

Now we want to heat the temperature probe. Discuss with your 
partner how you might go about this, and share your plan with 
others in the room. 

Predict what a plot of temperature vs. time would look like if you 
implemented your plan.  

 

 

 

Step 6: 

The best way to perform most temperature change experiments is to start the temperature 
change event and then start the data collection. 

Prepare to start collecting the data by pressing e until the Start Collection button 
 at the top of the screen is highlighted. Start heating the probe. Then press ·. 

Alternately, you can hover the cursor over the Start Collection button and use the click 
button a on the Touchpad.  

 
Note:   The · and a buttons perform slightly different commands. The click a is like 

a left-click on a computer mouse and will activate the part of the screen that the 
cursor or pointer | is over. 

 

Step 7:  

During the data collection, a scaled graph will appear and the Start button will change to a 
Stop  button. After a brief period of time, end the experiment by clicking the Stop 
button. 

When the experiment ends, the check  appears. Clicking this will store the latest data set. 
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Step 8:  

Examine your results and compare with your prediction. Discuss the following questions: 

• Did you need the full time for the experiment, or did you end it early? 

• We are interested in the rate at which the temperature increased. How would you 
describe this rate? At the start? Toward the end?  

• What material did you use to warm the probe? Do you think that the material 
used to heat the probe matters? Why? 

• Check with others in the room, and see their results. How do they compare with 
your results? What material did they use to warm the probe? Would that account 
for the differences? 

 

Step 9: 

To look at the table of data from the experiment, use the Touchpad to position the pointer 
over the TableView icon  and press a.  

Explore your rate of warming by looking at the change in temperature over equal 
increments of time.  

• How could you quantify this change in rate of warming? 

• How does this compare with your earlier analysis? 

 

Step 10:  

To save the results from the first experiment, use the Touchpad to position the pointer 
over the Store latest Data icon  and press a. 

• What changes do you notice on the screen? 

 

Step 11:  

Now design an experiment that will cool the temperature probe.  

Consider changing some of the options by clicking an area of 
interest (Mode, Rate, Duration, Settings). For example, change 
the default settings of three minutes by clicking on Duration and 
entering a new value (in seconds). 
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Note that these options are also under the b. Based on what 

you learned in the heating experiment, adjust the settings as 
needed for your cooling experiment. 

 

Step 12:  

As you prepare for the cooling experiment, consider the 
following questions: 

• What will you use to cool the probe?  

• How long will it take to cool?  

• What units will you use? 

• What will the plot of temperature vs. time look like this time? 

 

 

 

Step 13:  

Collect the data using your design for cooling. Once the cooling begins, start the data 
collection as soon as possible. Highlight the Start button , and press · to start. 
 
Step 14:  

Explore your rate of cooling as before, and look at the table of data. Discuss the following 
questions: 

• Were the rates of cooling or heating the same in both experiments? Explain. 

• To compare the heating and cooling experiments, what variables should you control? 

 

Step 15:  

We might use this data again, so the experiment should be 
saved. To save the experiment as a document, press /S, 

name the document, and select a folder to place it in. If 
necessary, create a new folder. 
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Activity Overview 
In this activity, you will learn how to perform basic calculations in the Calculator application. You will also 
be introduced to various features and commands. 
 
 
1. Press c twice. There are three sections on the screen. In the bottom section, there are seven 

icons which represent seven different applications. Predict what these applications are:  
________________________________________________________________________________  

 
2. What happens to the screen when you press and hold / and then tap - several times? What 

happens when you tap + instead?  

________________________________________________________________________________ 
 
3. Open a New Document by using the Touchpad to move your cursor to New Document. Click by 

pressing x . If the handheld asks you, “Do you want to save?” answer ‘no.’ 
How did you answer “no”? _____________________________________ 

 
4. Select ‘Add Calculator’ by pressing ·. How else could you select it?  

________________________________________________________________________________ 
 
5. Press 6l5 and ·. How does the problem appear on your screen? ______________  

What is the answer? ___________ Press 28l and explain what happens when you press l.  
__________________________________________________________________________  
Where is the cursor located? _______________ Find 283 ___________________. 

 
6.  Find 362 __________. There is a quicker way to type 362 without using l. Instead we can use the 

q. Where is it located, and why is it faster this way? _____________________________________ 

 
7.  Type 3p8 and ·. What is the answer? _________  

Try 3p8 again, only this time press / and ·. What is the answer? _____________ 
One more time, type in 3p8, but this time include a decimal point at the end and then press 
·. What is the answer? _______________________________________________________ 

 
8.  Press / p. What appears on your screen? ________ Where is the cursor? ____________  

Type in 12, press e, type in 98, and press ·. 
What is the answer? _________ What did pressing e do? ___________________ 

 
9. Press £ once so the last answer is highlighted, and then press ·. What happens? 

________________________________________________________________________________ 
Press ¡ once. Where is the cursor? __________  
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Delete the current number by pressing .. Type in 28, and press ·. What is the answer? 

________________________________________________________________________________ 
 
10. Press £ several times, and then press ·. Try this a few times. What happens? 

________________________________________________________________________________ 
 
11. Press £ twice (to highlight the last problem you entered) and press ..  What happens? 

_______________________________________________________________________ 
Press . several more times. What is happening each time you press .? 
________________________________________________________________________________ 

 
12. Press / and £. What do you see? _____________  

Press .·. What does the screen say? _______________  

 
13. Press /0. This is a calculator screen, but what looks different about it? __________________ 

Now type in 3(5-8 and ·. What is the answer? __________  
You typed in 3(5-8, but what does the problem look like on the handheld? ________________ 

 
14. Press /q to get a square root. Then type 23-7, move one space to the right, and type 

+2·. What is the answer? ______  

What does the problem look like on the screen? _______________  
What happened to the square root bar? _____________  
Where did the cursor move when you moved one space to the right? ________________ 

 
15. Press (v17)q·. What is the answer? ______________ 

What makes the v button different from the - button? _______________________ 
 
16. Press c, and open a New Document. Select ‘No’ when it asks if you want to save the document. 

Press /c to turn off the handheld. These are the last things you should do on your 
handheld before you put it away each day! 

 
17. How can you clear your screen entirely? ______________________________________________ 
 
18. How can you recall the last answer? _________________________________________________ 
 
19. How do you know where you are typing on the Calculator screen? _________________________ 
 
20. How can you make sure your answer is in the form of a decimal and not a fraction? 

________________________________________________________________________________ 
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Open the TI-Nspire™ document Sweating_Alcohol.tns. 
 
Everyone is familiar with the effects of perspiration on the skin. The 
cooling effect is very refreshing on a hot summer day. What if we 
perspired some liquid other than water? Would we cool off more 
rapidly? Would we heat up? 
  
 
The goal of this activity is to help you begin to understand the "magic" of the water 
molecule. Without water and its incredibly unique characteristics, life as we know it would 
be impossible. Not only is water a really good solvent (a dissolver of things), it is a POLAR 
molecule, which means it is "charged" on either end; one end is positive and the other is 
negative. Thus, water molecules stick to each other. 

This "cohesion" of water molecules makes it hard to heat it up and cool it down. This may 
sound bad, but it is REALLY good for us living things! Since most organisms are made 
mostly of water, they retain their heat really well. On a grander scale, since Earth is 
covered mostly with water, the overall global temperature remains pretty constant. Again, 
this helps make life possible here. 
 
Move to pages 1.4 through 1.7. Press / ¢ and / ¡ to 

navigate through the lesson. 
Answer these questions on your handheld. 
1. Because of its properties, most of the water on Earth is very warm. True or False. 
2. In a solution of sugar-water, the sugar is called the ___, and the water is called the ___. 
3. A water molecule is considered to be "polar" because it is negatively charged on both 

"ends" of the molecule. 
4. What do you predict is the approximate percentage of water inside human beings? 

Express your answer as a percentage (ex: 30%). 
 
Move to page 2.1. 
 
5. Pour a small quantity of alcohol into the plastic cup (an inch or so). 
6. Plug in the temperature probe, and place it into the alcohol. 
7. Set the TI-Nspire™ handheld to collect data every second for 30 seconds. 
8. Click start to begin sampling, count to 2, THEN lift the probe straight out of the alcohol, 

keeping the tip pointed down, until the data collection is complete.  
• The data is graphed on Page 2.2. 
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Move to page 2.2. 
 
9. To determine the rate of cooling, select MENU > Analyze > Regression > Show 

Linear (mx+b). 
10. Record the equation in the data table below. 
11. Move back to the DataQuest™ page, and run a trial with water 

instead of alcohol. 
12. Move back to the graph, and start sampling. Store the previous run by 

clicking on the “filing cabinet” icon. 
13. Pour a little water into a clean cup, and repeat the procedure for 

water. 
14. Analyze the data as before, and record it in the data table to the right. 

Data Table 
Equation for Alcohol: 
 
Equation for Water: 
 
 
 

 
Move to page 3.1. 
 
Answer the following questions on your handheld or here on this worksheet. 
15. Which liquid showed a greater decrease in temperature? 
 
16. Which liquid seemed to evaporate more slowly? 
 
17. Which liquid “cooled” more quickly? 
 
18. In the equation that you generated for the regression line (y=mx+b), what is "b"? 
 
19. In the equation that you generated for the regression line (y=mx+b), what is "m"? 
 
20. What is another name for “slope”? 
 
21. In this activity, what data label should be included with the rate of change? 
 
22. If, rather than perspiring water, you perspired rubbing alcohol, would you cool off more 

slowly or more rapidly? 
 
23. Consider the heat that is produced and then is taken "away" by your perspiration. What 

is the source of this heat in your body? 
 
24. So, if you perspired something like rubbing alcohol, rather than water, how would your 

lifestyle need to change? 

12
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25. Is water a polar or a nonpolar molecule? 
 
26. Predict whether alcohol is a polar or a nonpolar molecule. 
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Science Objectives 
• Students will collect data for the cooling rates of water and 

isopropyl alcohol. 
• Students will compare and contrast the cooling rate data, both 

graphically and numerically. 
• Students will predict how human homeostasis would be different 

if we perspired a liquid other than water. 
• Students will draw conclusions about the physical and chemical 

characteristics of water and how those characteristics impact 
organisms and the ability of the Earth to sustain life. 

 
Math Objectives 
• Students will generate linear regression models and compare 

rates of change from those models. 
  
Materials Needed 
• TI-Nspire™ or TI-Nspire™ CX unit for each student  
• Data collection cradle (optional) 
• Vernier® EasyTemp™ probe or 2 stainless steel temperature 

probes 
• Small plastic cups 
• Bottle of rubbing (isopropyl) alcohol 
• Room temperature water 
 
Vocabulary 
• polar • solute 
• nonpolar • solution 
• cohesion • homeostasis 
• solvent  

 
About the Lesson 
• This activity involves collecting data with a temperature probe as 

two different liquids cool via evaporation. 
• As a result, students will: 

• Compare the two rates of cooling and predict the 
physiological and metabolic implications if we, as humans, 
perspired some liquid other than water. 

• Develop a deeper understanding of the properties of water 
and how those properties allow life to exist. 

 
 
TI-Nspire™ Technology Skills:  
• Download a TI-Nspire™ 

document 
• Open a document 
• Move between pages 
• Entering and graphing data 

using multiple applications 
• Tracing, interpolating, 

predicting 
 
Tech Tips:  
• Make sure the font size on 

your TI-Nspire handhelds is 
set to Medium.  

• You can hide the function 
entry line by pressing 
/G. 

 
Lesson Materials: 
Student Activity 
• Sweating_Alcohol_Student.

pdf 
• Sweating_Alcohol_Student.

doc 
TI-Nspire document  
• Sweating_Alcohol.tns 
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TI-Nspire™ Navigator™ System  
• Screen Capture to monitor student progress. 
• Live Presenter allows students to show their graphs to the class. 

 

 
Discussion Points and Possible Answers 
 

 
 

 
The goal of this activity is to help you begin to understand the "magic" of the water 
molecule. Without water and its incredibly unique characteristics, life as we know it would 
be impossible. Not only is water a really good solvent (a dissolver of things), it is a POLAR 
molecule, which means it is "charged" on either end; one end is positive and the other is 
negative. Thus, water molecules stick to each other. 

This "cohesion" of water molecules makes it hard to heat it up and cool it down. This may 
sound bad, but it is REALLY good for us living things! Since most organisms are made 
mostly of water, they retain their heat really well. On a grander scale, since Earth is 
covered mostly with water, the overall global temperature remains pretty constant. Again, 
this helps make life possible here. 
 
Move to pages 1.4 through 1.7. 
 
Answer these questions on your handheld. 
1. Because of its properties, most of the water on Earth is very warm. True or False. 
 

Answer: False. 
 

2. In a solution of sugar-water, the sugar is called the ___, and the water is called the ___. 
 

Answer: B. solute; solvent 
 

3. A water molecule is considered to be "polar" because it is negatively charged on both 
"ends" of the molecule. 

 
Answer: Wrong. 

 
4. What do you predict is the approximate percentage of water inside human beings? 

Express your answer as a percentage (ex: 30%). 
 

Answer: 60-65%. 
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Move to page 2.1. 
 
5. Pour a small quantity of alcohol into the plastic cup (an inch or so). 
6. Plug in the temperature probe, and place it into the alcohol. 
7. Set the TI-Nspire handheld to collect data at a rate of 1 sample/second for 30 seconds. 
8. Click start to begin sampling, count to 2, THEN lift the probe straight out of the alcohol, 

keeping the tip pointed down, until the data collection is complete.  
• The data is graphed on Page 2.2. 

 
Move to page 2.2. 
 
9. To determine the rate of cooling, select MENU > Analyze > Regression > Show 

Linear (mx+b). 
10. Record the equation in the data table below. 
11.  Move back to the DataQuest™ page, and run a trial with water 

instead of alcohol. 
12.  Move back to the graph, and start sampling. Store the previous run 

by clicking on the “filing cabinet” icon. 
13.  Pour a little water into a clean cup, and repeat the procedure for 

water. 
14.  Analyze the data as before, and record it in the data table to the right. 

Data Table 
Equation for Alcohol: 
     Answer: Answers may      
     vary 
Equation for Water: 
     Answer: Answers may      
     vary 

 
Move to page 3.1. 
 
Answer the following questions on your handheld or here on this worksheet. 
15. Which liquid showed a greater decrease in temperature? 
 

Answer: Alcohol  
 
16. Which liquid seemed to evaporate more slowly? 
 

Answer: Water 
 
17. Which liquid “cooled” more quickly? 
 

Answer: Alcohol 
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18. In the equation that you generated for the regression line (y=mx+b), what is "b"? 
 

Answer: The “y-intercept”, which is the temperature when the data collection started. 
 
19. In the equation that you generated for the regression line (y=mx+b), what is "m"? 
 

Answer: The rate of change (slope) in temperature in degrees per second. 
 
20. What is another name for “slope”? 
 

Answer: Rate of change. 
 
21. In this activity, what data label should be included with the rate of change? 
 

Answer: Degrees/second. 
 

22. If, rather than perspiring water, you perspired rubbing alcohol, would you cool off more 
slowly or more rapidly? 

 
Answer: More rapidly. 

 
23. Consider the heat that is produced and then is taken "away" by your perspiration. What 

is the source of this heat in your body? 
 

Answer: Cell respiration. 
 
24. So, if you perspired something like rubbing alcohol, rather than water, how would your 

lifestyle need to change? 
 

Answer: You’d need to eat more. 
 
25. Is water a polar or a nonpolar molecule? 
 

Answer: Polar. 
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26. Predict whether alcohol is a polar or a nonpolar molecule. 
 

Answer: Nonpolar. 
 

TI-Nspire Navigator Opportunity: Screen Capture 
See Note 1 at the end of this lesson. 

 

 

 
Assessment 
Formative assessment will consist of questions embedded in the TI-Nspire document. The 
questions will be graded when the document is retrieved. The Slide Show can be utilized to 
give students immediate feedback on their assessment. 
 
TI-Nspire Navigator 
Note 1 Screen Capture 
Screen Capture can be used to monitor student progress. 
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Open the TI-Nspire document Punnett_Pea_Predictor.tns. 
An allele is an alternative form of a gene located at a specific position 
on a specific chromosome, a DNA molecule. Alleles determine traits 
that can be passed on from parents to offspring. In many cases, a 
trait is determined by one pair of alleles—one allele from each parent. 
Complete dominance occurs when one allele is dominant and the 
other is recessive.  

The dominant allele is expressed and the recessive allele is masked. If an organism's genotype is 
homozygous, then the two alleles are the same; two dominant or two recessive. If the genotype is 
heterozygous, one of each allele is present. An organism’s phenotype is the trait that is outwardly 
expressed by the organism. 
The example explored here, height in pea plants, is determined by one pair of alleles: tall (T) is dominant 
and short (t) is recessive. The letters “T” and “t” are used to describe the genotype. The terms “tall” and 
“short” are used to describe the phenotype. 
 
Move to pages 1.2–1.4. 
1. Read the introductory information and then move to the Punnett 

square simulation on page 1.5. 

Press / ¢ and / ¡ to 

navigate through the lesson. 

Move to page 1.5. 
2. In the simulation on page 1.5, drag pairs of alleles into the correct 

box of the Punnett square to show the genotypic ratio for the F1 
(first) generation. Using the genotypes, you can also determine 
the phenotypic ratio. Make sure you drag TWO alleles into each 
box in the Punnett square, since each individual must have two 
alleles for this trait!  

Tech Tip: To drag an allele, click x on T or t, then move to the desired 

square, then click x again to drop the allele. Press to check the 

punnett square. Then, click to clear and get a new punnett square. 
3. Run the simulation several times until you discover the pattern of height inheritance in pea plants. 

Then answer the questions below. If you need to, return to the simulation. 
Move to pages 1.6–1.11. Answer the following questions here or in the .tns file. 
Q1. Two tall parent pea plants will produce tall offspring. 

A. always B. sometimes C. never 
Q2. Two short parent pea plants will produce short offspring. 

A. always B. sometimes C. never 
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Q3. One parent pea plant is heterozygous for height. In order to have an equal chance of producing tall 

or short offspring, the other parent pea plant must be ___________. 
A. heterozygous 
B. homozygous (tall) 

C. homozygous (short) 
D. The genotype of the other parent does not 

matter. There can never be an equal chance. 
Q4. One parent pea plant is homozygous tall. In order to have an equal chance of producing tall or 

short offspring, the other parent pea plant must be ___________. 
A. heterozygous 
B. homozygous (tall) 

C. homozygous (short) 
D. The genotype of the other parent does not 

matter. There can never be an equal chance. 
Q5. How many different parent combinations could lead to an equal chance of tall or short offspring? 

A. 0 
B. 1 

C. 2 
D. 3 

Q6. Explain your response to Question 5. 
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Science Objectives 
• Students will use a Punnett square simulation to predict 

phenotypic and genotypic ratios of F1 generation. 
• Students will predict parental genotypes. 
• Students will explain the relationship between Punnett squares 

and probability. 
 
Vocabulary 
• allele 
• dominant 
• genotype 
• heterozygous 
• homozygous 
• phenotype 
• Punnett square 
• recessive 
 
About the Lesson 
• This lesson allows students to explore patterns of genetic 

inheritance through a simulation. 
• As a result, students will: 

• Manipulate Punnett squares to model the inheritance of 
height in pea plants. 

• Predict genotypic and phenotypic ratios of offspring. 
 
TI-Nspire™ Navigator™ 
• Send out the Punnett_Pea_Predictor.tns file. 
• Monitor student progress using Screen Captures. 
• Use Live Presenter to spotlight student answers. 
• Enter items as appropriate for use of TI-Nspire Navigator. 
 
Activity Materials 
• Punnett_Pea_Predictor.tns document 
• TI-Nspire™ Technology 
 

 
 
TI-Nspire™ Technology Skills: 
• Download a TI-Nspire 

document 
• Open a document 
• Move between pages 
• Use a slider 
• Drag an object to a target 

area 
 

Lesson Materials: 
Student Activity 
• Punnett_Pea_Predictor_Stu

dent.doc 
• Punnett_Pea_Predictor_Stu

dent.pdf 

TI-Nspire document 
• Punnett_Pea_Predictor.tns 
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Discussion Points and Possible Answers 
 

 

Students will read the following background information in the 
student activity sheet. 
An allele is an alternative form of a gene located at a specific position 
on a specific chromosome, a DNA molecule. Alleles determine traits 
that can be passed on from parents to offspring. In many cases, a 
trait is determined by one pair of alleles—one allele from each parent. 
Complete dominance occurs when one allele is dominant and the 
other is recessive. 

 

The dominant allele is expressed and the recessive allele is masked. If an organism's genotype is 
homozygous, then the two alleles are the same; two dominant or two recessive. If the genotype is 
heterozygous, one of each allele is present. An organism’s phenotype is the trait that is outwardly 
expressed by the organism. 
The example explored here, height in pea plants, is determined by one pair of alleles: tall (T) is dominant 
and short(t) is recessive. The letters “T” and “t” are used to describe the genotype. The terms “tall” and 
“short” are used to describe the phenotype. 
Move to pages 1.2–1.4. 
1. Students should read the instructions on pages 1.2–1.4 and then move to page 1.5. 
Move to page 1.5. 
2. On page 1.5, students will run the Punnett square simulation 

several times. Students should click on the alleles on the right 
side of the page in order to drag them into the appropriate 
squares. You may need to remind them to make sure they put 
TWO alleles into each square. This would be a good time to 
review with them the need for two alleles for a trait—one coming 
from the mother and the other from the father. 

 

 

Tech Tip: To fill in a Punnett square (instead of dragging the boxes), click 
where the 1 is in the slider, type in –1 and hit · and it will fill in 

automatically. You can choose whether or not to share this with students. 

Teaching Tip: After the students have gone through a couple of 
simulations, ask them to predict results BEFORE filling in the Punnett 
square. Use the tech tip below to automatically fill in the squares to check 
the students’ predictions. 
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  TI-Nspire Navigator Opportunities 
Create a new Punnett square and project for the class to see. Have students predict what the results will 
be before filling in the square. Use the Tech Tip (below) to quickly complete the square and see if 
students’ predications were correct. 
 

Below are possible results from the Punnett Square simulation. 

   

3. Instruct students to repeat the simulation until they recognize the different patterns of height 
inheritance in pea plants. 

Move to pages 1.6–1.11. 
Have students answer the questions on either the handheld, on the activity sheet, or both. 
Q1. Two tall parent pea plants will produce tall offspring. 
 
 Answer: B. sometimes 
 

Q2. Two short parent pea plants will produce short offspring. 
 
 Answer: A. always 
 

Q3. One parent pea plant is heterozygous for height. In order to have an equal chance of producing 
either tall or short offspring, the other parent pea plant must be ___________. 

 
 Answer: C. homozygous (short) 
Q4. One parent pea plant is homozygous tall. In order to have an equal chance of producing tall and 

short offspring, the other parent pea plant must be ___________. 
 
 Answer: D. The genotype of the other parent does not matter. There can never be an equal 

chance. 
Q5. How many different parent combinations could lead to an equal chance of tall and short offspring? 
 
 Answer: C. 2 
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Q6. Explain your response to the Question 5. 
 
 Answer: The parents have to be Tt and tt to have a chance to have an equal number of tall and 

short offspring. 
 

 

Wrap Up 
When students are finished with the activity, pull back the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. 
 
Assessment 

• Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved by TI-Nspire Navigator. The TI-Nspire Navigator Slide 
Show can be utilized to give students immediate feedback on their assessment. 

• Summative assessment will consist of questions/problems on the chapter test, inquiry project, 
performance assessment, or an application/elaborate activity. 
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Open the TI-Nspire document Exploring_Diffusion.tns. 
 
This lesson involves using a dynamic model of diffusion through a 
selectively permeable membrane.  
 

 
About Diffusion and Osmosis 
 
Diffusion occurs when particles of a higher concentration of a substance move to an area of lower 
concentration; often across the cell membrane. Diffusion is a form of passive transport because no 
cellular energy is required for it to occur. Active transport occurs when ATP energy is required to move 
a substance from one area to another. 
 
Osmosis is the particular case of diffusion where the substance that moves through the membrane is 
water. 
 
When free movement through the membrane is possible, then that membrane is said to be permeable. 
If some things can pass through and some can't, the membrane is selectively permeable. All living 
cells are contained within a selectively permeable membrane, which allows movement in and out of 
certain molecules. 
 
Understanding the processes of diffusion and osmosis is important if we are to understand how living 
things function. 
 
Move to page 1.6. 
 

 

1. On page 1.6, use the sliders (or arrow keys) to change the 
number of molecules, and the permeability of the membrane. 

2. Observe the effects of these changes, and answer the questions 
on pages 1.7-1.11. 
 

 

 

 Tech Tip:  Select “GO!” and “STOP” to start and stop the 

simulation. Select “RESET” to reset the simulation to the initial state. 
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Move to pages 1.7 through 1.11. 
3. Set the permeability slider to 0%.  Set the number of particles to 50. Look to the RIGHT side of the 

membrane. We might expect to see________ particles. 
• 0 
• less than 25 
• more than 25 
• around 50 

4. Set the permeability slider to 50%.  Set the number of particles to 50. Look to the RIGHT side of the 
membrane. We might expect to see________ particles. 

• 0 
• less than 25 
• more than 25 
• around 50 

5. Set the permeability slider to 100%.  Set the number of particles to 50. Look to the RIGHT side of 
the membrane. We might expect to see________ particles. 

• 0 
• less than 25 
• more than 25 
• around 50 

6. Set the number of particles to 20.  To observe around 5 particles on the RIGHT side of the 
membrane, what would the permeability need to be? 

• 0% 
• 25% 
• 50% 
• 100% 

 
7. In each example, you have been directed to observe the number of particles on the RIGHT side of 

the membrane. Explain the relationship between the concentration of particles and the direction of 
movement. 
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Science Objectives 
• Students will define diffusion and osmosis. 

• Students will describe the process by which particles of matter 
can or cannot move through different materials. 

 
Vocabulary 
• diffusion 
• membrane 
• permeable and selectively permeable 
• osmosis 
• passive transport 
• active transport 
 
About the Lesson 
• By using a simulation, students will explore the concept of 

diffusion through a selectively permeable membrane. 
• As a result, students will: 

• Conduct experiments related to diffusion and osmosis in a 
range of settings. 

• Define diffusion and osmosis. 

• Describe the process by which particles of matter can or 
cannot move through different materials. 

 

TI-Nspire™ Navigator™ 
• Quick Poll 
• Send/Receive files 
 

Activity Materials 

• Compatible TI Technologies: TI- Nspire™ CX Handhelds, 

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 

 
 

 
 
Tech Tips: 
• This activity includes screen 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using. 

• Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  

 
Lesson Files: 
Student Activity 
• Exploring_Diffusion_Stu 

dent.pdf 
• Exploring_Diffusion_Stu 

dent.doc 

TI-Nspire document  
• Exploring_Diffusion.tns 
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Discussion Points and Possible Answers  

 
Start on page 1.6. 
After reading introductory information on their activity sheets, students move to page 1.6 of the activity. 
Students will use the permeability slider (or arrow keys) to change the permeability of the membrane, 
from 0 to 100%, and the number slider (or arrow keys) to change the number of particles. They will 
observe the effects of these changes and answer questions. 

 Tech Tip:  Students should select “GO!” and “STOP” to start 

and stop the simulation. They can select “RESET” to reset the simulation to 
the initial state. 

Move to pages 1.7 – 1.11. 
 
1. Set the permeability slider to 0%.  Set the number of particles 

(number) to 50. Look to the RIGHT side of the membrane. We 
might expect to see________ particles. 

 
Answer: 0 particles. 
 

 

2. Set the permeability slider to 50%.  Set the number of particles (number) to 50. Look to 
the RIGHT side of the membrane. We might expect to see________ particles. 

 
Answer: Less than 25. 

3. Set the permeability slider to 100%.  Set the number of particles to 50. Look to the RIGHT side of 
the membrane. We might expect to see________ particles. 

 
Answer: Less than 25. 

4. Set the number of particles to 20.  To observe around 5 particles on the RIGHT side of the 
membrane, what would the permeability need to be? 

 
Answer: 25%. 

 
5. In each example, you have been directed to observe the number of particles on the RIGHT side of 

the membrane. Explain the relationship between the concentration of particles and the direction of 
movement. 

 
Answer: The left side has the higher concentration of particles and diffusion involves 
particles moving from higher to lower concentrations – from left to right in this example.  
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TI-Nspire Navigator Opportunity: 
Use Quick Poll and Live Presenter to assess student understanding throughout the exploration. 

 

 

Wrap Up 
Students should be prepared to explain their conclusions, along with demonstrating an understanding of 
diffusion and osmosis. 
 
Assessment 
Teacher should collect completed .tns files from class and use these to assess student learning and 
understanding. 
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Open the TI-Nspire document Boyles_Law.tns. 
 
In this activity, you will use a Gas Pressure Sensor to measure the 
pressure of an air sample inside a syringe. Using graphs, you will 
apply your results to real-world examples. 

 
 

 
What is the mathematical relation between volume and pressure for a confined gas? To answer this 
question, you will perform an experiment with air in a syringe connected to a Gas Pressure Sensor. 
When the volume of the syringe is changed by moving the piston, the change in the pressure will be 
measured. It is assumed that temperature and moles of gas will be constant throughout the 
experiment. Pressure and volume data pairs will be collected during this experiment and then 
analyzed. Using the data and the graph, the type of mathematical relationship between pressure 
and volume of the confined gas can be determined. Historically, this relationship was first 
established by Robert Boyle in 1662 and has since been known as Boyle’s law. 
 
Move to page 1.6. 
 
Q1. As volume increases, pressure: 
 A. increases         B. decreases               C. remains the same  

1. With the syringe disconnected from the Gas Pressure Sensor, move the piston of the 
syringe until the front edge of the inside black ring (indicated by the arrow in the picture 
to the right) is positioned at the 10.0 mL mark. 

2. Turn on your TI-Nspire handheld, and close any documents that are open. 
3. Attach the syringe to the probe as shown to the right. (Do not 

twist too tightly—the syringe just needs to be secure.) 

 
4. Plug the pressure probe into the EasyLink™, and plug the EasyLink into the USB port 

in the top of the handheld. The DataQuest APP should open automatically. 
• What is the default unit for collection with this sensor? 

 
5. Select MENU > Experiment > Collection Mode > Events with Entry. 
6. Type in volume for Name, press e, and type mL for Units.  Press ·. 
7. Click the start  button to start data collection, or press e until the start arrow is 

highlighted, then press · when ready. It is best for one person to take care of the 

syringe and for another to operate the handheld. 
8. To collect your first data reading, click on the Store Latest Data Set  button to save the data.  

Enter a value of 10, since you set the syringe at 10 mL earlier. Click on OK, or press ·. 
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9. Depress and hold the plunger to the 9 mL mark. When the pressure value on the left 
side of the screen has stabilized, click on the Store Latest Data Set  button and type 
in 9, and press ·. 

10. Continue this procedure, collecting data at 8, 7, 6, and 5 mL. After you have collected 
data for 5 mL, click on the Stop  button.   

• To view your data in graph form click on the Graph View   button.  
 
11. Explore the various regression models to determine the best mathematical relationship 
for your data set. 
 
12. Based on the graph of pressure vs. volume, decide what kind of relationship exists 

between these two variables—direct or inverse. 
• While on the DataQuest app page, select MENU > Analyze > CurveFit > Power. 
• Scroll down to see the curve fit statistics for the equation in the form y = Ax^B , 

where x is volume, y is Pressure, A is a proportionality constant, and B is the 
exponent of x (Volume). 

Note: The relationship between pressure and volume can be determined from the value 
and sign of the exponent, B. 

• If the mathematical relationship has been correctly determined, the regression line 
should closely fit the points on the graph (that is, pass through or near all of the 
plotted points). 

Move to page 2.3. 
 
Q2. Which variable is considered to remain constant during a Boyle’s Law Experiment? 
 
 A. pressure B. volume C. temperature D. all of these 
 
13. To linearize the data and confirm that an inverse relationship exists between pressure 

and volume, plot a graph of pressure vs. reciprocal of volume (1/Volume) in DataQuest: 
• Select MENU > Data > New Calculated Column. 

• Type InverseV for Name. 

• Short Name: 1/V 

• Units: 1/mL 

• Expression: 1/Volume 

• Click OK, or press ·. 

• Select MENU > Graph > Select X-axis > InverseV. 
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14. Calculate the regression line y = mx + b where x is 1/volume, y is pressure, m is a 
proportionality constant, and b is the y-intercept. On the DataQuest page, select MENU 
> Analyze > Curve Fit > Linear. 

 
Q3. When a quantity of gas is compressed, the pressure of the gas is expected to _______. 
 
 A. decrease B. remain the same C. increase D. double 
 
Q4. The expected mathematical relationship between pressure and volume is __________. 
 
 A. direct B. inverse C. indirect D. impossible to determine 
 
Move to page 3.2. 
 
Q5. If the volume is doubled from 5 to 10 mL, what does the data show happens to the 

pressure? 
  
 A. increases  B. decreases  C. doubles D. cut in half 
 
Q6. If the volume is halved from 20 to 10 mL, what does the data show happens to the 

pressure? 
 
 A. increases  B. decreases  C. doubles  D. cut in half  
 
Q7. Based on the data, what would be expected to happen to the pressure if the volume in 

the syringe were increased from 10 to 40 mL? 
 
 A. increase  B. decrease  C. quadruple  D. cut to 1/4th 
 
Q8. From the answers to the above three questions and from the shape of the curve of the 

plot, of pressure vs. volume, what is the relationship between the pressure and volume 
of a confined gas? 

 
 A. inverse  B. direct  C. quadratic  D. impossible to determine 
 
Q9. What two experimental factors are assumed to be constant during this experiment? 

(select two) 
 
 A. pressure  B. volume  C. moles of the gas  D. temperature 
 

35



  Boyle’s Law Name   
Student Activity Class   

 

©2014 Texas Instruments Incorporated 4 education.ti.com 

Q10. Using P, V, and k, write an equation representing Boyle’s Law. 
 
 
Q11. Which of the following produced a constant value? 
 
 A. pressure x volume  B. pressure/volume  C. volume/pressure  D. none of these 
 
Q12. Summarize what you have learned about the relationship between pressure and volume. 
 
 
 
Move to page 4.1. 
 
Extension: Effect of Temperature on Boyle’s Law 
Follow the instructions on Pages 4.1-4.3 for the simulation, and then answer the following 
questions from Pages 4.4 and 4.5: 
 
Q13. When the temperature is doubled, how does the pressure change? 
 
 A. The pressure doubles.  B. The pressure is reduced by ½.  

C. The pressure is 4X larger.  D. The pressure does not change. 
 
Q14. At a higher temperature, the relationship between pressure and volume is a(an) 

_______ relationship. 
  
 A. direct  B. inverse  C. quadratic  D. impossible to determine 
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 Science Objectives 
• Use a Gas Pressure Sensor and a gas syringe to measure the 

pressure of an air sample at several different volumes. 
• Determine the relationship between gas pressure and volume. 
• Use the results to predict the pressure at other volumes. 
 
Math Objectives 
• Mathematically describe the relationship between gas pressure 

and volume. 
• Evaluate an inverse mathematical relationship. 
• Generate and analyze a power regression model. 
• Linearize an inverse relation. 
  
Materials Needed 
• Vernier® EasyLink™ 
• Vernier Gas Pressure Sensor 
• 20 ml syringe 
 
Vocabulary 
• pressure  
• volume 
• inverse 

 

 
About the Lesson 
• This activity makes use of the Gas Pressure Sensor in an inquiry 

activity that enables the student to understand Boyle’s Law 
through experimentation and data collection. 

• As a result, students will: 
• Built a mathematical model to show the inverse relationship 

between gas pressure and gas volume. 

• Analyze that mathematical model, and make predictions from 
the model through interpolation and extrapolation. 

• Apply Boyle’s Law to the real-life situation of human 
respiration. 

 

TI-Nspire™ Navigator™ System 
• Screen Capture to monitor student progress. 
• Live Presenter allows students to show their graphs to the class. 

 
 
TI-Nspire™ Technology Skills:  
• Download a TI-Nspire 

document 
• Open a document 
• Move between pages 
• Entering and graphing data 
• Tracing and interpolating 
 
Tech Tip:  
Access free tutorials at 
http://education.ti.com/calculator
s/pd/US/Online-
Learning/Tutorials 
 
Lesson Files: 
Student Activity 
• Boyles_Law_Student.pdf 
• Boyles_Law_Student.doc 
TI-Nspire document  
• Boyles_Law.tns 
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Activity Overview 
• Please print the student worksheet and make available to students before beginning the lab.  Lab 

background information as well as lab procedures are included only in the student worksheet. 
Always remember to review any safety precautions thoroughly with your students prior to starting 
the lab. 

• Students may answer the questions posed in the .tns file and submit for grading with TI-Nspire 
Navigator (optional) or students may answer directly on the student worksheet 

• Ensure that students collect data on the 5 known substances and look at the graph before they 
actual measure the absorbance of the unknown solution.  This will allow them to make 
predictions and to look at the graph of the data first.  

 
Discussion Points and Possible Answers 

 
 

 
  TI-Nspire Navigator Opportunity 
Use the TI-Nspire Navigator System to monitor student progress using screen capture. 
 

 
Pre-lab Information and Questions. 
Have students read the background information on pages 1.2 – 1.5. Then, they should answer 
the pre-lab question on page 1.6. 
 
Q1. As volume increases, pressure ________. 

 
Answer: decreases 
  

Lab Procedure. 
The lab procedure is in the student worksheet and is not duplicated here. Please refer to the 
student handout. 

Boyles Law Lab.tns 
Have students move to pages 2.3 – 2.5 and answer the questions in the .tns file or on the worksheet. 
 
Q2. Which variable is considered to remain constant during a Boyle's Law experiment? 

 
Answer: temperature 

 
Q3. When a quantity of gas is compressed, the pressure of the gas is expected to _______. 

 
Answer: increase 
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Q4. The expected mathematical relationship between pressure and volume is __________. 
 
Answer: inverse 

 
Q5. If the volume is doubled from 5 to 10 mL, what does the data show happens to the pressure? 

 
Answer: cut in half 

 
Q6. If the volume is halved from 20 to 10 mL, what does the data show happens to the pressure? 
 

Answer: cut by one-third 
 
Q7. Based on the data, what would be expected to happen to the pressure if the volume in the syringe 

were increased from 10 to 40 mL? 
 

Answer: doubles 
 
Q8. From the answers to the above three questions and from the shape of the curve of the plot, of 

pressure vs. volume, what is the relationship between the pressure and volume of a confined gas? 
 

Answer: inverse 
 
Q9. What two experimental factors are assumed to be constant during this experiment? 

(select two) 
 

Answer: moles of gas and temperature 
 
Q10. Using P, V, and k, write an equation representing Boyle’s Law. 
 

Answer: P = k/V 
 
Q11. Which of the following produced a constant value? 
 

Answer: pressure times volume 
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Q12. Summarize what you have learned about the relationship between pressure and 
volume.  
 

Answer: Answers will vary. Students should indicate the inverse relationship between pressure and 
volume 

 
Q13. When the temperature is doubled, how does the pressure change? 
 

Answer: The pressure doubles. 
 
Q14. At a higher temperature, the relationship between pressure and volume is a(an) 
______ relationship. 
 

Answer: inverse (same as before) 
 

TI-Nspire Navigator Opportunity: Screen Capture 
See Note 1 at the end of this lesson. 

 

Wrap Up 
Use Boyle’s Law to offer a practical application such as human breathing. 
 
Assessment 
Formative assessment will consist of questions embedded in the pre-lab TI-Nspire 
document. Summative assessment questions are found in the lab and post-lab TI-Nspire 
document. The questions will be graded when the TI-Nspire documents are retrieved. The 
Slide Show can be utilized to give students immediate feedback on their assessment. 
 
TI-Nspire Navigator Notes 
Note 1 Screen Capture 
Screen Capture can be used to monitor students. 
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Open the TI-Nspire document Like_Moths_Around_a_Flame.tns. 

Imagine that you have a piece of red construction paper on your desk 
in front of you. If you wrote your name on the construction paper with 
a red marker and then wrote your name on the same paper with a 
black marker, which would be easier to read? If you showed the 
paper to one of your friends across the room, which do you think they 
would see? A similar scenario happens all the time in nature. 
Blending into the environment (camouflage) can help an animal avoid 
being seen, which may help it avoid being eaten by a predator. 

 

 
In England, there is a species of insect called the peppered moth that provides us with a great example 
of camouflage, and this helps us understand the process of natural selection. Some of these moths are 
dark-colored, and some are light-colored. The color of each moth is determined by its genes for color, so 
a moth that is born dark stays dark, and a moth that is born light stays light. 
 
The peppered moth is most active during the nighttime hours (nocturnal) and it spends its days resting on 
things like tree trunks. From the mid-1800s until the mid-1900s, people observed that the number of 
moths of each color changed. Why did these changes occur? In this activity you will examine data about 
moths, graph the data, and draw some conclusions. 
 
Move to page 1.2. 
1. Examine the data in the spreadsheet, which shows the number of 

moths of each color by decade. In 1860, for example, if a sample 
of 100 moths were counted, 90 of them would have been light 
(lmcount) and 10 of them would have been dark (dmcount). In 
this activity, you can assume that the counts for the sample 
accurately reflect the proportions in the entire population. 

 

 

Move to pages 1.3 and 1.4. Answer the following questions here or in the .tns file. 
Q1. Which of the following is an independent variable in this activity?  

(More than one response may be correct.) 
A. the number of dark-

colored moths 
B. the number of light-

colored moths 
C. the year 

Q2. Which of the following is a dependent variable in this activity?  
(More than one response may be correct.) 
A. the number of dark-

colored moths 
B. the number of light-

colored moths 
C. the year 
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Move to page 1.5. 
2. Select the x-axis to choose an independent variable(s) for the x-

axis. Choose a dependent variable(s) for the y-axis. To add a 
second variable to the y-axis, select Menu > Plot Properties > 
Add Y Variable. Examine the graph and look for trends in the 
data.  

  

Tech Tip:  To add a second variable to the y-axis, select   > Plot 
Properties > Add Y Variable. You may need  to back-out to the main 

Tools Menu  to see the desired menu option. 

Move to page 1.6. Answer question 3 here or in the .tns file. Answer questions 4–11 here. 
Q3. Describe the trend(s) you see in the numbers of light-colored moths as the decades passed. Also, 

describe the trend(s) you see in the numbers of dark-colored moths. 
 
 
 
Q4. From 1950 to 1970, what was the change in the number of light-colored moths? During this time, 

what was the change in the number of light-colored moths per year? per decade?  
 
 
 
Q5. From 1950 to 1970, what was the change in the number of dark-colored moths? During this time, 

what was the change in the number of dark-colored moths per year? per decade?  
 
 
 
Q6. Using your answers for questions 4 and 5, predict when (after 1970) you would expect the number 

of each type of moth to be the same. Explain your prediction. 
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Q7. During the middle 1800s, England began what was called the Industrial Revolution. Industry 
increased rapidly, and with that increase came a much greater need for energy. Since nuclear 
power plants were still decades away, what was the source of energy that England used to 
power their huge increase in industry? What was the environmental impact of using this type of 
fuel? How do you think this impact influenced the numbers of light- and dark-colored moths? 

 
 
 
Q8. During the middle 1900s, environmentalists really started voicing their concerns about the harmful 

effects that industry was having on the environment. England and other countries started paying 
closer attention to cleaning up the environment by reducing emissions from industrial factories. 
These concerns helped to promote policies like the Clean Air Act in many countries. As these 
policies became implemented, new forms of energy started being used, and industry was required 
to reduce emissions from their existing factories. What was the environmental impact of the Clean 
Air Act? How do you think this impact influenced the numbers of light- and dark-colored moths? 

 
 
 
Q9. Explain how your answers to questions 7 and 8 could be used to explain the effects of natural 

selection on the population of peppered moths in England. 
 
 
 
Q10. What do you think would happen to the environment and to the moth population if factories went 

back to using older energy sources for their power, and the Clean Air Acts were eliminated? 
Explain your response. 

 
 
 
Q11. Brainstorm and then describe another example of natural selection in animals, and one in plants. 
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Science Objectives  
• Students will determine how humans can influence natural 

selection by manipulating the environment. 
• Students will relate two sets of data, and analyze the patterns in 

long-term data. 
• Students will develop an understanding of the effect of the 

environment on natural selection. 
 
Vocabulary 
• camouflage 
• dependent variable 
• environmental impact 
• independent variable  
• natural selection 
• nocturnal 
 
About the Lesson 
• In this lesson, students examine some data about moths.  
• As a result, students will: 

• Understand that the environment has an effect on natural 
selection. 

• Graph data and compare two sets of data. 

• Find patterns in long-term data and draw conclusions. 

 

TI-Nspire™ Navigator™ 
• Send out the Like_Moths_Around_a_Flame.tns file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
 

Activity Materials 

• Compatible TI Technologies: TI- Nspire™ CX Handhelds, 

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 

 

 

 
Tech Tips: 
• This activity includes screen 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using. 

• Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  

 
Lesson Files: 
Student Activity 
• Like_Moths_Around_a 

_Flame_Student.doc 
• Like_Moths_Around_a 

_Flame_Student.pdf 

TI-Nspire document  
• Like_Moths_Around_a 

_Flame.tns 
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Discussion Points and Possible Answers 
 

 
 

Move to page 1.2. 
1. Students examine the data in the spreadsheet, which shows a 

comparison of the number of moths of each color by decade. In 
1860, for example, if 100 moths were counted, 90 of them would 
have been light, and 10 of them would have been dark. In this 
activity, students are told to assume that the counts for the 
sample accurately reflect the proportions in the entire population.  

Teaching Tip: In this activity, there are two sets of data that have the 
same independent variable. Make sure students realize that both 
dependent variables share the same independent variable.  

 
Move to pages 1.3 and 1.4 
Have students answer questions on either the device, on the activity sheet, or both. 

Q1. Which of the following is an independent variable in this activity?  
(More than one response may be correct.) 

 
Answer: C. the year  

 
Q2. Which of the following is a dependent variable in this activity?  

(More than one response may be correct.) 
 

Answer: A. the number of dark-colored moths and B. the number of light-colored moths 
 
Move to page 1.5. 
2. Students construct a graph by choosing variables for each axis. 

To add a second y-axis variable, they will select Menu > Plot 
Properties > Add Y Variable. Their graphs should look like the 
graph at the right. Students then look for trends in the data. 

 

 

Tech Tip:  To add a second variable to the y-axis, students should 

select   > Plot Properties > Add Y Variable. Students may need  to 
back-out to the main Tools Menu to see the desired menu option. 
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Move to page 1.6. 
Have students answer question 3 in the .tns file, on the activity sheet, 

or both, and questions 4–11 on the activity sheet. 

 

Q3. Describe the trend(s) you see in the numbers of light-colored moths as the decades passed. Also 
describe the trend(s) you see in the numbers of dark-colored moths. 

 
Answer: The light-colored moth population decreases until 1950, and then starts to increase. 
The dark-colored moth population increases until 1950, and then starts to decrease. 

Q4. From 1950 to 1970, what was the change in the number of light-colored moths? During this time, 
what was the change in the number of light-colored moths per year? per decade? 

 
Answer: The count of light-colored moths increased by 15. This was an increase of  
.75 light-colored moths per year and an increase of 7.5 light-colored moths per decade. 

 
Q5. From 1950 to 1970, what was the change in the number of dark-colored moths? During this time, 

what was the change in the number of dark-colored moths per year? per decade? 
 

Answer: The count of dark-colored moths decreased by 15. This was a decrease of  
.75 dark-colored moths per year, and a decrease of 7.5 dark-colored moths per decade. 

 
Q6. Using your answers for questions 4 and 5, predict when (after 1970) you would expect the number 

of each type of moth to be the same. Explain your prediction. 
 

Answer: I expect the counts of each type of moth to be equal in the 1990s. Explanations will vary. 
 
Q7. During the middle 1800s, England began what was called the Industrial Revolution. Industry 

increased rapidly, and with that increase, came a much greater need for energy. Since nuclear 
power plants were still decades away, what source of energy did England use to power their huge 
increase in industry? What was the environmental impact of using this type of fuel? How do you 
think this impact influenced the numbers of light- and dark-colored moths? 

 
Answer: The source of energy that England used to power their huge increase in industry 
was coal. The environmental impact of using this type of fuel was that there was more soot in 
the air, falling onto the trees and discoloring the light-colored bark. The impact on moths: 
Dark-colored moths would increase, and light-colored moths would decrease. 
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Q8. During the middle 1900s, environmentalists really started voicing their concerns about the harmful 
effects that industry was having on the environment. England and other countries started paying 
closer attention to cleaning up the environment by reducing emissions from industrial factories. 
These concerns helped to promote policies like the Clean Air Act in many countries. As these 
policies became implemented, new forms of energy started being used, and industry was required 
to reduce emissions from their existing factories. What was the environmental impact of the Clean 
Air Act? How do you think this impact influenced the numbers of light- and dark-colored moths? 

 
Answer: The environmental impact of the Clean Air Act was that there was less soot in the air, 
so less fallout onto the trees. The impact on moths: Light-colored moths would increase, and 
dark-colored moths would decrease. 

Q9. Explain how your answers to questions 7 and 8 could be used to explain the effects of natural 
selection on the population of peppered moths in England. 

 
Answer: Depending on the color of the tree bark, either the light- or dark-colored moths would 
be selected for or selected against. Those selected for would be more likely to reproduce, 
while those selected against would not. 

 
Q10. What do you think would happen to the environment and to the moth population if factories went 

back to using older energy sources for their power, and the Clean Air Acts were eliminated? 
Explain your response. (Point students back to the answer from question 7 if they need help 
identifying “older energy sources”.) 

 
Answer: It is likely that the population of the dark-colored moths would increase because of 
the darker colored bark. Dark moths would be selected for. 

 
Q11. Brainstorm and then describe another example of natural selection in animals, and one in plants 
 

Answer: Answers will vary. 
 

TI-Nspire Navigator Opportunities 
 

Use TI-Nspire Navigator to capture screen shots of student progress and to retrieve the file from each 
student at the end of the class period. The student questions can be electronically graded and added to 

the student portfolio. 
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Wrap Up 
When students are finished with the activity, pull back the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. Make sure the concept of balancing 
torques is firm in their understanding and not balancing forces.  
 
Assessment 

• Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved. The Slide Show will be utilized to give students immediate 
feedback on their assessment. 

• Summative assessment will consist of questions/problems on the chapter test. 
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Open the TI-Nspire document Watch_the_Birdie_Breathe.tns 

In this activity, you will analyze data in a spreadsheet and graph to 
explore the relationship between the outside temperature and the 
amount of oxygen a bird uses.  

 

 
 
Birds and mammals are very unique critters! They are like reptiles, amphibians, and fish in a lot of ways. 
But they have one characteristic that sets them apart from all other animals—they are “warm-blooded”. 
The technical word for warm-blooded is endothermic, which means “inside” (endo-) “heat” (-therm).  
 
YOU are an endotherm! You regulate your body heat inside yourself, and you work very hard to keep 
your body heat at a constant temperature. On the other hand, ectotherms, or “cold-blooded” animals, 
largely depend on the heat in their environment to keep their bodies warm. Fish, amphibians, and reptiles 
are ectotherms. Being an endotherm has its advantages, but there is a price to pay. As you look at the 
data in this activity and answer the questions, think about what this price is and how endotherms deal 
with it. 
 
Move to page 1.2.  

1. Review the data in the spreadsheet. The temperatures represent 
the environmental temperatures in degrees Celsius and the 
oxygen used data is in mL/g of body weight/hour for a small bird, 
such as a sparrow. Note that the first four temperatures are 
negative values.  

 

Move to page 1.3.  

2. Review the scatter plot. Generate a line of best fit for the data. 
Select Menu > Analyze > Regression > Show Linear (mx+b).  

 

Tech Tip: To generate a line of best fit, select > Analyze > 
Regression > Show Linear (mx + b). 

Move to page 1.4. Use the data to help answer the following questions below. 

Q1. Write the equation for your line of best fit: _________________________ 
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Q2. What is the rate of change (slope) of the relationship between temperature and oxygen 
consumption? Make sure you label the rate with units. 

 
 
Q3. Which variable is the independent variable in the graph: temperature or oxygen consumption? 
 
 
Q4. Which variable is the dependent variable in the graph? 
 
 
Q5. Describe the appearance of the graph. 
 
 
 
Q6. What is the relationship between temperature and oxygen consumption? 
 
 
 
Q7. What is the source of the heat that an endotherm generates? 
 
 
Q8. The colder it gets, the more oxygen the bird uses. What is the process the bird uses to consume 

the oxygen that it inhales? 
 
 
Q9. When would a bird need to eat more: in the summer or in the winter? Explain. 
 
 
 
Q10. What are a bird’s “choices” for finding and consuming food when the weather gets really cold? 
 
 
 
Q11. Why does a bird’s oxygen consumption decrease as temperature increases? 
 
 
Q12. What label should be attached to the rate of change (slope) in this problem? Describe what the 

rate of change means in the context of this problem. 
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Q13. If the data in the original data table are from observations of a small bird like a sparrow or a robin, 
predict how the data would differ for a much larger bird, such as a bald eagle. 

 
 
 
Q14. Predict which birds, small birds or large birds, would need to eat more food per gram of body 

mass. Explain. 
 
 
 
Q15. How do you predict the data and graph would be different if you were analyzing oxygen 

consumption for an ectothermic (cold-blooded) animal, such as a lizard or a turtle? 
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Science Objectives  
• Students will analyze a mathematical model for the graphical 

representation of a data set. 

• Students will develop an understanding of the relationship 
between environmental temperature and animal metabolism. 

 

Vocabulary 
• dependent variable 
• ectotherm 
• endotherm 
• independent variable 
 
About the Lesson 
• This lesson involves students using TI-Nspire technology to 

analyze a graph of data representing the relationship between 
the environmental temperature and the resulting metabolism of 
an endothermic animal. 

• As a result, students will: 
• Draw conclusions about how temperature affects 

metabolism. 

• Compare the temperature effects on both endothermic and 
ectothermic animals. 

 

TI-Nspire™ Navigator™ 
• Send out the Watch_the_Birdie_Breathe.tns file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
 
Activity Materials 

• Compatible TI Technologies:  TI-Nspire™ CX Handhelds,  

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 

 

 
Tech Tips:  
• This activity includes class 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.  

• Access free tutorials at 
http://education.ti.com/ 
calculators/pd/US/Online-
Learning/Tutorials 

 
Lesson Files: 
Student Activity 
• Watch_the_Birdie_Breathe 

_Student.doc 
• Watch_the_Birdie_Breathe 

_Student.pdf 

TI-Nspire document  
• Watch_the_Birdie 

_Breathe.tns 
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Discussion Points and Possible Answers 
 

 
 

Temperature affects the metabolism of animals in different ways. Endothermic (warm-blooded) animals 
maintain a fairly constant body temperature, which gives them the advantage of being able to live in 
virtually any environment on Earth. Ectothermic (cold-blooded) animals have a body temperature that is, 
in large part, regulated by their external environment. Because of this, they are most abundant in warm 
environments and have a difficult time surviving in cold environments.  

Birds and mammals, the only classes of endotherms, must eat more food in colder environments. This is 
because they lose so much heat to the environment. Ectotherms show the opposite behavior; eating 
more when it’s warmer because of the increase in their metabolisms. The food energy that an organism 
consumes is “burned” during aerobic cellular respiration, which requires oxygen. Therefore, the higher 
the bird’s metabolism, the higher the rate of cellular respiration and therefore oxygen consumption. 

Students will explore this through data in this activity. After analyzing data in the spreadsheet, they will 
model the graph data with a regression model.  

Move to pages 1.2–1.3.  

1. Review the data in the spreadsheet. The temperatures represent 
the environmental temperatures in degrees Celsius and the 
oxygen used data is in mL/g of body weight/hour for a small bird, 
such as a sparrow.  

 
 

2. The regression equation in the form of y = mx + b appears when 
the linear regression is generated. To generate the regression 
equation, select Menu > Analyze > Regression > Show Linear 
(mx+b). 

 

Tech Tip: To generate a line of best fit, have students select  > 
Analyze > Regression > Show Linear (mx + b). 

Tech Tip: To analyze which variable should be the independent 

variable, students may wish modify the graph. The variable for an axis can 
be changed by select a variable name along the x or y axis. Students can 

also modify the variable by selecting,  > Plot Properties > Remove X 

56



 Watch The Birdie—Breathe!   TEACHER NOTES 

SCIENCE NSPIRED   
 

©2014 Texas Instruments Incorporated 3 education.ti.com 

Variable (or Remove Y Variable). Then, they can add a variable by 

selecting the box that appears on the axis or by selecting  > Plot 
Properties > Add X Variable (or Add Y Variable).   

 
Move to page 1.4. Have students answer the questions on their worksheet. 
Q1. Write the equation for your line of best fit: _________________ 
 

Answer: y = –0.09x + 3.488  
 
Q2. What is the rate of change (slope) of the relationship between temperature and oxygen 

consumption? Make sure you label the rate with units. 
 

Answer: –0.09 mL / g / hour / °C 
 
Q3. Which variable is the independent variable in the graph, temperature or oxygen consumption? 
 

Answer: temperature (temp) 
 
Q4. Which variable is the dependent variable in the graph? 
 

Answer: oxygen consumption (o2cons) 
 
Q5. Describe the appearance of the graph. 
 

Answer: Answers will vary: As temperature goes up, oxygen consumption goes down. 
 
Q6. What is the relationship between temperature and oxygen consumption? 
 

Answer: Inverse 
 
Q7. What is the source of the heat that an endotherm generates? 
 

Answer: Burning of food via cellular respiration 
 
Q8. The colder it gets, the more oxygen the bird uses. What is the process the bird uses to consume 

the oxygen that it inhales? 
 

Answer: Cellular respiration 
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Q9. When would a bird need to eat more, in the summer or in the winter? Explain. 
 

Answer: Winter, because they burn up their food faster in the winter in order to maintain their 
body temperature. 

 
Q10. What are a bird’s “choices” for finding and consuming food when the weather gets really cold? 
 

Answer: Eat more or find somewhere warmer to live (migrate). 
 
Q11. Why does a bird’s oxygen consumption decrease as the temperature increases? 
 

Answer: There is not as great a difference between body temperature and environmental 
temperature (not as steep of a temperature gradient), so heat is not lost as quickly. 

 
Q12. What label should be attached to the rate of change (slope) in this problem? Describe what the 

rate of change means in the context of this problem. 
 

Answer: mL O2/g/hour/degree C. For each degree increase or decrease, the oxygen 
consumption increases or decreases by a certain value 

 
Q13. If the data in the original data table is from observations of a small bird like a sparrow or a robin, 

predict how the data would differ for a much larger bird, such as a bald eagle. 
 

Answer: The oxygen consumption per gram would not have been as high because of the volume 
of the larger bird 

 
Q14. Predict which birds, small birds or large birds, would need to eat more food per gram of body 

mass. Explain. 
 

Answer: Small birds because they lose heat to the environment more quickly because of their 
high SA/V ratio 

 
Q15. How do you predict the data and graph would be different if you were analyzing oxygen 

consumption for an ectothermic (cold-blooded) animal, such as a lizard or a turtle? 
 

Answer: It would have been just the opposite: as temperature increased, the oxygen 
consumption would have increased 
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  TI-Nspire Navigator Opportunities 
Perhaps make a student a Live Presenter to demonstrate to the other students how to generate a linear 
regression.  
 

 
 

Wrap Up 
When students are finished with the activity, pull back the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. 
 
Assessment 

• Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved by TI-Nspire NavigatorTM. The TI-Nspire NavigatorTM Slide 
Show can be utilized to give students immediate feedback on their assessment. 

• Summative assessment will consist of questions/problems on the chapter test, inquiry project, 
performance assessment, or an application/elaborate activity. 
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Open the TI-Nspire document Enzyme_Catalysts.tns. 

In this activity, you will: 
• Describe the difference between anabolism and catabolism. 
• Identify factors that affect the rate of chemical reactions. 
 

 

Enzymes are very important biological molecules. Enzymes help speed up reactions in and around cells. 
Many enzymes are known as anabolic enzymes, and these build larger molecules from smaller ones. 
Others are catabolic, which break down larger molecules into smaller ones. You produce hundreds of 
different enzymes in your cells, all of which facilitate some chemical reaction in the body. 
Here’s an example: Hydrogen peroxide (H

2
O

2
) is produced naturally inside many of your cells. The trouble 

is that it is very toxic to us. To deal with this, we produce an enzyme called catalase, which serves to 
break down hydrogen peroxide into a couple of pretty harmless substances: 

2H
2
O

2
  2H

2
O + O

2 

Let’s discuss some things about enzymes for a minute. Enzymes are globular proteins that are 
responsible for most of the chemical activities of living organisms. They act as catalysts—substances that 
speed up chemical reactions without being destroyed or changed during the process. Enzymes are very 
efficient, and they can be used over and over again. One enzyme may very well catalyze hundreds, or 
even thousands, of reactions every second! 
Enzymes, however, can be temperamental. Most enzymes are very picky about the situations in which 
they will work. Temperature and pH are very important factors. If the environment is too hot or too cold, or 
too acidic or too basic, the enzyme may not catalyze its reaction at all. In fact, if the conditions are too 
extreme, the enzyme may quit working altogether because its structure may become distorted. In these 
cases, we say that the enzyme has become denatured. 
Have you seen the bubbles that form when you place hydrogen peroxide (H2O2) on a cut? This is a 
reaction between hydrogen peroxide and catalase? Where is catalase found in living organisms? There is 
a fair amount of catalase in blood! In addition, it can be found in many different tissues in both plants and 
animals. 
In this experiment, you will measure the rate of enzyme (catalase) activity under various conditions. To do 
this, you will measure the pressure of oxygen gas in a flask as it is released during the chemical reaction 
between hydrogen peroxide and catalase. 
 

Problem 1 – Preliminary Questions 

Move to page 1.2. 
Press / ¢ and / ¡ to 

navigate through the lesson. 
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1. Read the introduction on page 1.2. 

 

Move to pages 1.3–1.7. Answer the following questions here or in 

the .tns file. 

 

Q1. The bubbles that appear when H2O2 is put on an open wound are ____________. 
A. water bubbles 
B. oxygen gas 

C. catalase gas 
D. gas from exploding red blood cells 

Q2. Why do you think hydrogen peroxide is stored in a brown bottle? 
A. Because it is 

photosensitive. 
B. To prevent it from being 

destroyed by catalase. 
C. People prefer to buy chemicals 

in brown bottles. 
Q3. The following reaction would be anabolic: A + B  AB 

A. True B. False 
Q4. The process of cellular respiration, which is breaking glucose into water and carbon dioxide, would 

be a (an) ____________ reaction. 
A. anabolic B. catabolic 

Q5. Photosynthesis, which builds glucose from CO2 and H2O, would be a (an) ____________ reaction. 
A. anabolic B. catabolic 

Problem 2 – Reaction Rate Data Collection 

Move to page 2.1. 

2. Page 2.1 is a blank DataQuest application. Connect the EasyLink 
to the TI-Nspire, and then connect the Gas Pressure Sensor to 
the EasyLink. Set the TI-Nspire to collect data every 1 second for 
30 seconds. 

3. Attach the tube to the pressure sensor, and then attach the black 
stopper to the tube. 

4. Use the graduated cylinder to measure 5 mL of hydrogen 
peroxide and pour it into the flask. 
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5. Draw 1 mL of the catalase suspension into the syringe.  
6. Press Start Data Collection  on the TI-Nspire, and immediately add the catalase suspension to the 

flask. Then, quickly put the stopper firmly in the mouth of the flask. 
Move to page 2.2. 

7. View the collected data in the Data & Statistics application on 
page 2.2. Use the Entry Line to set the x-axis to the variable 
run1.time and the y-axis to run1.pressure. Use the Moveable 

Line tool (Menu > Analyze > Add Moveable Line) to fit a line to 
the collected data. Be sure to fit the line to the data collected 
during the initial phase of the chemical reaction.  

Move to page 3.2. 

8. Observe the slope of the fitted line to determine the rate at which 
the pressure of the gas changes. Record these data in the Lists & 

Spreadsheets application on page 3.2. 

 

Problem 3 – Manipulation of Reaction Variable 

9. Modify a variable from the investigation in Problem 2. You may want to modify any of the following 
variables: 
• Amount of hydrogen peroxide in the flask 
• Amount of enzyme added to the flask 
• Temperature of flask (placed in hot or cold water) 
• Type of enzyme used (use “boiled” enzyme instead) 

10. Repeat the experiment from Problem 2 with a modified variable and view the collected data on 
page 2.1. Be sure to rinse and dry the reaction flask between experiments. 

11. For each set of newly collected data, determine the rate of reaction and record it on page 3.2. 

Problem 4 – Analysis 

Move to pages 4.1–4.10. Answer the following questions here or in the .tns file.  

Q6. Catalase is an enzyme; it is also a protein. What are the monomers of proteins? 

A. amino acids 
B. monosaccharides 

C. triglycerides 
D. nucleotides 

Q7. Since catalase is a protein, where in the cell is it probably made? 

A. in the nucleus 
B. in the chloroplasts 

C. on the surface of the Golgi bodies 
D. on ribosomes 
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Q8. Because catalase is a protein, where are the instructional blueprints for making catalase? 

A. on the plasma membrane 
B. in the DNA in the nucleus 

C. on the RNA 
D. in the cytoplasm 

Q9. In this activity, hydrogen peroxide was the catalyst that was used to speed up the reaction. 
A. True B. False 

Q10. When you used boiled catalase, you probably noticed a very slow reaction rate. Predict why this 
happened. 

 
 
 

Q11. Which trial should have had the fastest rate of reaction? The trial using the flask that had ________. 
A. room temperature catalase 
B. boiled catalase 

C. catalase on ice 
D. catalase in warm water 

Q12. What was the result of increasing the amount of catalase used? 
 
 
 

Q13. What was the result of decreasing the amount of catalase used? 
 
 
 

Q14. What graphical evidence is there to suggest that the rate of the reaction did not stay constant 
throughout the data collection? 

 
 
 

Q15. As a variation of the experiment you could increase the amount of catalase but keep the amount of 
peroxide the same. How would the final pressure in the flask compare to that of the initial 
experiment (the control)? 

A. It would be higher. B. It would be lower. C. It would be at the same level. 
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Science Objectives 
• Students will describe the difference between anabolism and 

catabolism. 
• Students will identify factors that affect the rate of chemical 

reactions. 
 

Vocabulary 
• anabolic • catalyst 
• catabolic • denatured 
• catalase • globular proteins 
 
About the Lesson 
• In this activity, students will use an enzyme catalase to speed up 

the breakdown of hydrogen peroxide into oxygen. They will 
measure the pressure produced by the oxygen that is released in 
this reaction. Students will draw a conclusion about factors that 
increase or decrease the rate of this chemical reaction. 

• As a result, students will: 
• Measure and graph changes in gas pressure during a 

chemical reaction 
• Relate the change in gas pressure to the rate of the chemical 

reaction 
• Draw conclusions about which variables affect the rate of 

reaction. 
 

TI-Nspire™ Navigator™ 
• Send out the Enzyme_Catalysts.tns file. 
• Monitor student progress using Screen Capture. 
• Use Live Presenter to spotlight student answers. 
 

Activity Materials 
• Enzyme_Catalysts.tns document 
• Vernier EasyLink™or Go!®Link interface 
• Gas Pressure Sensor & Syringe 
• H2O2 
• 125 mL flask and 10 mL graduated cylinder 
• Enzyme suspension 
• Boiled enzyme suspension 

 

 
TI-Nspire Technology Skills: 

• Download a TI-Nspire 
document 

• Open a document 
• Move between pages 
• Collect Data with Probes 
 
Tech Tips: 

Make sure the font size on your 
TI-Nspire handhelds is set to 
Medium. 
 
Lesson Materials: 

Student Activity 

• Enzyme_Catalysts_Student 
.doc 

• Enzyme_Catalysts_Student 
.pdf 

TI-Nspire document 

• Enzyme_Catalysts.pdf 
 
Visit www.sciencenspired.com 
for lesson updates and tech tip 
videos. 
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Teacher Preparation and Classroom Management  

• Prepare an enzyme suspension: Place a 250 mL flask into a large beaker filled with ice so that the 
enzyme suspension remains cold. Place a funnel that has been lined with 2–3 layers of cheesecloth 
into the flask. Obtain a 2 cm cube of fresh liver (chicken, beef, or pork). Place the meat in a blender 
with 200 mL distilled water and blend on the highest setting for 10–15 seconds. Slowly pour the 
suspension through the cheesecloth and into the flask. Discard the cheesecloth with the residue. 
Cover the flask and keep it on ice until you are ready to use it. For best results, prepare fresh 
enzyme prior to each lab period. 

• Prepare the boiled enzyme suspension: Pour 50–100 mL (depending on the amount needed) of the 
prepared suspension into a 125 mL flask, and place the flask into a boiling water bath for about 5 
minutes. 

• Students may record their answers to the questions on blank paper or answer in the .tns file using 
the Notes application. 

• In some cases, these instructions are specific to those students using TI-Nspire handheld devices, 
but the activity can easily be done using TI-Nspire computer software. 

• The following questions will guide student exploration during this activity: 
• How does the amount of pressure of the oxygen released relate to the chemical reaction rate? 

• Which variables affect the reaction rate?  

Discussion Points and Possible Answers 

Problem 1 – Prelab Questions 

Move to page 1.2. 

1. Students should open the file Enzyme_Catalysts.tns and read 
page 1.2. 

 

 

Move to pages 1.3–1.7. 

Have students answer the questions on either the handheld, on the 
activity sheet, or both. 
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Q1. The bubbles that appear when H2O2 is put on an open wound are ____________. 
 
 Answer: B. oxygen gas 
 
Q2. Why do you think hydrogen peroxide is stored in a brown bottle? 
 

 Answer: A. Because it is photosensitive. 
 
Q3. The following reaction would be anabolic: A + B  AB 
 
 Answer: A. True 
 
Q4. The process of cellular respiration, which is breaking glucose into water and carbon dioxide, would 

be a (an) ____________ reaction. 
 
 Answer: B. catabolic 
 
Q5. Photosynthesis, which builds glucose from CO2 and H2O, would be a (an) ____________ reaction. 
 
 Answer: A. anabolic 
 

Problem 2 – Reaction Rate Data Collection 

Move to page 2.1. 

2. First students set up the experimental apparatus. They connect 
the EasyLink to the TI-Nspire and connect the Gas Pressure 
Sensor to the EasyLink. Students should set the TI-Nspire to 
collect data every 1 second for 30 seconds. 

3. Secondly, they attach the tube to the sensor and the black 
stopper to the tube. 

4. Next students use the graduated cylinder to measure 5 mL of 
hydrogen peroxide and pour it into the flask. 

 

5. They draw 1 mL of the enzyme suspension into the syringe. 
6. Then students click start on the TI-Nspire and immediately add the enzyme suspension to the flask. 

They should quickly put the stopper firmly in the mouth of the flask. 
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Move to page 2.2. 

7. They should view the collected data in the Data & Statistics 
application on page 2.2. Use the Entry Line to set the x-axis to 
the variable run1.time and the y-axis to run1.pressure. Students 
next fit a line to the data using the Moveable Line tool. They 
should use only the initial “uphill” part of the graph for best 
analysis. Sometimes, this includes only 5–10 seconds of the 
graphed data. 

 

Move to page 3.2. 

8. Students should observe the slope of the fitted line to determine 
the rate of the chemical reaction. They should record these data 
in the Lists & Spreadsheet application on page 3.2. 

 

TI-Nspire Navigator Opportunity 

 

Quick Poll can be used here to ensure that students understand the relationships in this experiment. Ask 
students to explain the correlation between the rate of gas pressure changes and the rate of chemical 
reaction. Students should note that the rate of gas pressure change is directly proportional to the rate of 
the reaction. 

Problem 3 – Manipulation of Reaction Variable 

9. Students modify a variable in the investigation and then repeat steps 1–8. Remind students that the 
reaction flask should be rinsed out and dried between each experiment. 

10. Each time they repeat the experiment, students should view the collected data on page 2.2. 
11. For each set of newly collected data, students determine the rate of reaction and record it on 

page 3.2. 

Problem 4 – Analysis 

Q6. Catalase is an enzyme; it is also a protein. What are the monomers of proteins? 
 
 Answer: A. amino acids 
 
Q7. Since catalase is a protein, where in the cell is it probably made? 
 
 Answer: D. on ribosomes 
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Q8. Because catalase is a protein, where are the instructional blueprints for making catalase? 
 
 Answer: B. in the DNA in the nucleus 
 
Q9. In this activity, hydrogen peroxide was the catalyst that was used to speed up the reaction. 
 
 Answer: A. False 
 
Q10. When you used boiled catalase, you probably noticed a very slow reaction rate. Predict why this 

happened. 
 
 Answer: The catalase was denatured by the boiling. 
 
Q11. Which trial should have had the fastest rate of reaction? The trial using the flask that had _______. 
 

 Answer: D. catalase in warm water 
 
Q12. What was the result of increasing the amount of catalase used? 
 

 Answer: The rate increased. 
 
Q13. What was the result of decreasing the amount of catalase used? 
 

 Answer: The rate decreased. 
 
Q14. What graphical evidence was there to suggest that the rate of the reaction did not stay constant 

throughout the data collection? 
 

 Answer: The graph was not linear. 
 
Q15. As a variation of the experiment you could increase the amount of catalase but keep the amount of 

peroxide the same. How would the final pressure in the flask compare to that of the initial 
experiment (the control)? 

 
 Answer: C. It would be at the same level. 
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TI-Nspire Navigator Opportunity 

 

Use the TI-Nspire Navigator System to collect, grade, and save the .tns file to the Portfolio. Use Slide 
Show to view student responses. See Note 1 at the end of this lesson. 
 

 

Wrap Up 

Upon completion of the lab and discussion, the teacher should ensure that students are 
able to understand: 

• The difference between anabolism and catabolism. 

• Factors that affect the rate of chemical reactions. 

 
Assessment 
The students should collect data and can complete the embedded multiple choice questions in the 
Enzyme_Catalysts.tns file. In addition, students can answer questions on the student activity sheet. 
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 14 

Adapted from Experiment 11B, “Cell Respiration”, from the Biology with Vernier lab book 14 - 1 

Cell Respiration 
Cell respiration refers to the process of converting the chemical energy of organic molecules into 
a form immediately usable by organisms. Glucose may be oxidized completely if sufficient 
oxygen is available and is summarized by the following reaction: 

C6H12O6 + 6 O2(g) ← →  6 H2O + 6 CO2(g) + energy 
All organisms, including plants and animals, oxidize glucose for energy. Often, this energy is 
used to convert ADP and phosphate into ATP. It is known that pea seeds undergo cell respiration 
during germination. Do pea seeds undergo cell respiration before germination? Using your 
collected data, you will be able to answer this question concerning respiration and non-
germinated peas. 

Using the CO2 Gas Sensor, you will monitor the carbon dioxide produced by pea seeds during 
cell respiration. Both germinated and non-germinated peas will be tested. Additionally, cell 
respiration of germinated peas at two different temperatures will be tested. 

 
OBJECTIVES 
In this experiment, you will 

• Use a CO2 Gas Sensor to measure concentrations of carbon dioxide during cell respiration. 
• Study the effect of temperature on cell respiration rate. 
• Determine whether germinating peas and non-germinating peas respire. 
• Compare the rates of cell respiration in germinating and non-germinating peas. 

 

 
Figure 1 

 
MATERIALS 

TI-Nspire handheld or  250 mL respiration chamber 
   computer and TI-Nspire software  25 germinated pea seeds 
data-collection interface 25 non-germinated pea seeds 
Vernier CO2 Gas Sensor ice cubes 
100 mL beaker thermometer 
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PROCEDURE 
1. If your CO2 Gas Sensor has a switch, set it to the Low (0–10,000 ppm) setting. Connect the 

sensor to the data-collection interface. Connect the interface to the TI-Nspire handheld or 
computer. 

2. Choose New Experiment from the  Experiment menu. Choose Collection Setup from the 
 Experiment menu. Enter 300 as the experiment duration in seconds. The number of points 

collected should be 76. Select OK. 

3. Measure the room temperature using a thermometer and record the temperature in Table 1. 

4. Obtain 25 germinated pea seeds and blot them dry between two pieces of paper towel. 

5. Place the germinated peas into the respiration chamber. 

6. Place the shaft of the CO2 Gas Sensor in the opening of the respiration chamber. 

7. Wait one minute, then start data collection ( ). Data will be collected for 300 seconds. 

8. When data collection has finished, a graph of carbon dioxide gas vs. time will be displayed. 

9. Remove the CO2 Gas Sensor from the respiration chamber. Place the peas in a 100 mL 
beaker filled with cold water and an ice cube. The cold water will prepare the peas for part II 
of the experiment. 

 10. Use a notebook or notepad to fan air across the openings in the probe shaft of the CO2 Gas 
Sensor for 1 minute. 

 11. Fill the respiration chamber with water and then empty it. Thoroughly dry the inside of the 
respiration chamber with a paper towel. 

 12. Determine the rate of respiration. 
a. Examine the graph and identify the most linear region and select the data points in the 

most linear region. 
b. Choose Curve Fit ►Linear from the  Analyze menu. 
c. Record the slope, m, as the rate of respiration in ppm/s in Table 2. 

 
 13. Click the Store Data button ( ) to save the first run data. Repeat Steps 5–12 substituting the 

germinated peas with non-germinated pea seeds. In Step 9 place the non-germinated peas on 
a paper towel and not in the ice bath. 

Part II  Germinated peas, cool temperatures 

 14. Remove the germinated pea seeds from the cold water and blot them dry between two paper 
towels. 

 15. Click the Store Data button ( ) to save the second run data. Repeat Steps 5–12 using the 
cold peas. 
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Science with TI-Nspire Technology 14 - 3 

 16. Graph all three runs of data on a single graph. 
a. Click run3 and select All. All three runs will now be displayed on the same graph axes. 
b. Use the displayed graph and Tables 1 and 2 to answer the questions below. 

 
 
DATA 

Table 1 

Room Temperature (°C)  

 
Table 2 

Peas Rate of respiration  
(ppm/s) 

Germinated, room temperature  

Non-germinated, room temperature  

Germinated, cool temperature  

 
 
QUESTIONS 
1. Do you have evidence that cell respiration occurred in peas? Explain. 

2. What is the effect of germination on the rate of cell respiration in peas? 

3. What is the effect of temperature on the rate of cell respiration in peas? 

4. Why do germinated peas undergo cell respiration? 

 
EXTENSIONS 
1. Compare the respiration rate among various types of seeds. 

2. Compare the respiration rate among seeds that have germinated for different time periods, 
such as 1, 3, and 5 days. 

3. Compare the respiration rate among various types of small animals, such as insects or 
earthworms. 

73



 

This page intentionally left blank 

 

74



 Experiment 

TEACHER INFORMATION 14 

Adapted from Experiment 11B, “Cell Respiration”, from the Biology with Vernier lab book 14 - 1 T 

 
Cell Respiration 

1. Editable Microsoft Word versions of the student pages and pre-configured TI-Nspire files can 
be found on the CD that accompanies this book. See Appendix A for more information. 

2. Allow the seeds to germinate for three days prior to the experiment. Prior to the first day, 
soak them in water overnight. On subsequent days, roll them in a moist paper towel and place 
the towel in a paper bag. Place the bag in a warm, dark place. Check each day to be sure the 
towels remain very moist. If time is short, the peas can be used after they have soaked 
overnight. For best results, allow them to germinate for the full three days. 

3. The CO2 Gas Sensor has a 90 second warm-up period.  Any data collected during this warm 
up will not be accurate. When using the TI-Nspire Lab Cradle, the text in the CO2 sensor 
meter will be displayed in light gray until the sensor has warmed up. At that time, the meter 
text will be displayed in black. 

4. Heavy condensation buildup in the respiration chamber can interfere with readings from the 
CO2 Gas Sensor. This can be a source of error if the peas are very wet when placed in the 
respiration chamber. Before placing the peas in the respiration chamber, blot them dry with a 
paper towel. 

5. The CO2 Gas Sensor relies on the diffusion of gases into the probe shaft. Students should 
allow a couple of minutes between trials so that gases from the previous trial will have exited 
the probe shaft. Alternatively, the students can use a firm object such as a book or notepad to 
fan air through the probe shaft. This method is used in Step 10 of the student procedure. 

6. The morning of the experiment fill a 1 L beaker with ice and water so that students will have 
cold water. Students will also need access to ice. 

7. When doing this experiment with a TI-Nspire handheld, your batteries will drain quickly. 
This is especially true when using an EasyLink or Go!Link interface. Be sure your handheld 
has fresh or fully charged batteries. 

8. The older-style CO2 sensor cannot be used with an EasyLink or Go!Link interface. To use 
this probe, you must use a multi-channel sensor interface. 

9. The stopper included with the older-style CO2 Gas Sensor is slit to allow easy application 
and removal from the probe. When students are placing the probe in the respiration chamber, 
they should gently twist the stopper into the chamber opening. Warn the students not to twist 
the probe shaft or they may damage the sensing unit. 
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SAMPLE RESULTS 

 
CO2 respired by germinating – room temperature (○),  

non-germinating (■), and germinating – cool temperature peas (). 
 

Table 1 

Room Temperature (°C) 22.4 

 
Table 2 

Peas Rate respiration 
(ppm/s) 

Germinating, room temperature 1.78 

Non-germinating, room temperature 0.02 

Germinating, cool temperature 0.78 
 
 
ANSWERS TO QUESTIONS 
1. Yes, the carbon dioxide concentration vs. time graph clearly indicates that carbon dioxide is 

being produced at a steady rate when germinating peas are in the respiration chamber. 

2.  Germination greatly accelerates the rate of cellular respiration. This reflects a higher rate of 
metabolic activity in germinating seeds. In most experiments, non-germinating seeds do not 
seem to be respiring. Occasionally, however, some respiration is detectable. 

3. Warm temperatures increase the rate of respiration. This reflects a higher rate of metabolic 
activity in warm germinating seeds than in cool seeds. 

4. It is necessary for germinating seeds to undergo cellular respiration in order to acquire the 
energy they need for growth and development. Unlike their mature relatives, seeds do not yet 
have the necessary photosynthetic abilities needed to produce their own energy sources. 
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Open the TI-Nspire document Recipe_for_a_Living_World.tns. 
Very few recipes have an ingredients list that is so short or so simple. 
The recipe card could read like this: 
 1. Take equal parts carbon dioxide, gas, and water. 
 2. Allow the CO2 and H2O to meet inside a plant cell. 
 3. Expose the plant cell to light. 
 4. Make sure the correct equipment is available in the plant cell, 

 and that the temperature is right. 
 5. In only a few minutes, you will have some sugar and some 

 oxygen gas. Get rid of the oxygen and feed Planet Earth with 
 the sugar! 

 6. Repeat. 

 

Seriously? Who would believe this?! And yet, it’s true! Plants, as well as some simpler organisms such 
as algae, carry on photosynthesis. This process involves using a gas (CO2) from the air, liquid water 
(H2O) from the ground, light energy, and some cellular equipment and supplies. The end result is to 
produce enough food for almost every organism on Earth—including themselves! Next time you look at a 
plant and think to yourself, “BORING! They just stay in one place and don’t do ANYTHING!” – think 
again! There is enough going on inside that plant to put the busiest kitchen to shame! 
Many variables affect the rate and efficiency of photosynthesis. In the first simulation, you will adjust and 
observe the effect of the color (wavelength) of visible light on the rate of photosynthesis. In the second 
simulation, you will manipulate the intensity of the light on a plant and observe how this variable impacts 
photosynthesis rates. 

Move to pages 1.2–1.3. 
Read the background information on page 1.2. 
1. On page 1.3 you will see a picture of a leaf with 6 stomata that 

will be used as a monitor of the rate of photosynthesis as the 
illuminance (or intensity) of light is increased. In real life, stomata 
are microscopic, and there are often thousands of them on one 
leaf. During this simulation, the more stomata are open, the 
greater the rate of photosynthesis. Pay attention to the stomata 
as you make your adjustments. 

2. When you are ready, click on the start arrow . Then click on the 
“up arrow” to change the wavelength of light (λ) to which the leaf 
is exposed. Again, watch both the stomata and the illuminance 
value as you proceed. Continue to increase the wavelength until it 
will no longer change, then move to the graph on page 1.4. 
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Move to pages 1.4–1.5. 
Q1. Sketch your graph in the space to the right. To reset the 

simulation and run it again, click on the reset button . 
 

 

Move to pages 1.6–1.8. Answer the following questions here or in the .tns file. 

Q2. As the light intensity increases, the rate of photosynthesis __________. 
A. increases B. decreases C. stays the same 

Q3. As the rate of photosynthesis increases, which of the following substances would you expect to 
decrease? 
A. oxygen 
B. carbon dioxide 

C. glucose 
D. chlorophyll 

Q4. During which of the following months would you expect photosynthesis rates to be highest in the 
Southern Hemisphere? 
A. January 
B. April 

C. June 
D. August 

 
Move to page 2.1–2.5. 
Read the brief background information on page 2.1. 
3. On page 2.2, you’ll see another picture of a leaf with stomata. 

However, for this simulation, you will change the wavelength of 
visible light to which the leaf is exposed. The visible spectrum 
(ROYGBIV) is displayed across the top of the screen. As with the 
simulation in Problem 1, the more stomata that are open, the 
greater the rate of photosynthesis. Pay attention to both the 
spectrum and the stomata as you make your adjustments. When 
you are ready, select the start arrow . Then click on the “up 
arrow” to change the wavelength. Changing wavelength changes 
the color, of the light to which the leaf is exposed. After you reach 
the upper limit of the wavelength (780 nm), move to pages 2.3 
and 2.4 and observe the graphs that were generated. 
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Q5. Sketch both graphs in the spaces to the right. 
 
Q6. Explain why the graphs look the way they do. 

Photosynthesis Rate: 
 
 
 
 
 

 
 

CO2 Level: 
 
 
 
 
 
 

 

 

 

 

 

Q7. Why do you think ROYGBIV was displayed backward on page 2.2? 
 

 
 

Q8. Which wavelengths of light were best for photosynthesis? How can you tell? 
 
 
 
Q9. Which colors of light were best for photosynthesis? 
 
 
 
Q10. Which wavelengths of light were least used for photosynthesis? 
 

 
 

Q11. Which colors of light were least used for photosynthesis? 
 

 
 

79



  Recipe for a Living World  Name   
Student Activity  Class   

 

©2013 Texas Instruments Incorporated 4 education.ti.com 

Q12. How does your answer to Question 11 explain the color of most plants? 
 
 
 
Q13. During the simulation, how could you tell which wavelengths were best for photosynthesis and 

which ones were not? 
 
 
 
Q14. What would happen if a plant were exposed ONLY to green light? Why? 
 
 
 
 
Q15. Describe a place on Earth where photosynthesis rates would tend to be consistently very high. 

Explain. 
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Science Objectives  
• Students will develop a deeper understanding of the variables 

affecting the rate of photosynthesis in plants. 
• Students will manipulate variables, such as light intensity and 

wavelength of light, to observe the effects on photosynthesis 
rates. 
 

Vocabulary 
• illuminance 
• photosynthesis 
• stomata 
• visible spectrum 
• wavelength 

 
About the Lesson 
• In this lesson students will observe the effects of certain variables 

on the rate of photosynthesis in a plant.  
• As a result, students will: 

• Better understand the importance of the visible portion of the 
electromagnetic spectrum. 

• Develop an understanding of reflection and absorption of light 
energy by a pigment. 

 

TI-Nspire™ Navigator™ 
• Send out the Recipe_for_a_Living_World.tns  file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
• Collect embedded assessment questions from Problem 1. 
 

Activity Materials 

• Compatible TI Technologies: TI- Nspire™ CX Handhelds, 

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 

 

 
 
Tech Tips: 
• This activity includes screen 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using. 

• Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  

 
Lesson Files: 
Student Activity 
• Recipe_for_a_Living_World

_Student.doc 
• Recipe_for_a_Living_World

_Student.pdf 

TI-Nspire document  
• Recipe_for_a_Living_World 

.tns 
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Discussion Points and Possible Answers 

Move to page 1.2. 
Students read the brief background information on page 1.2. Because light is typically not included as a 
substance in the generalized equation for photosynthesis, it is often overlooked. Without light, however, 
the entire process of photosynthesis would grind to a halt. Many components must be in place in order 
for photosynthesis to occur. Yet if there is no energy input at the outset, no food can be made. In the 
simulation found in Problem 1, students will observe the effects of light intensity (illuminance, measured 
in kiloLux) on the rate of photosynthesis. 
 
Move to page 1.3.  
1. On page 1.3, students need to click on the start arrow  and 

then repeatedly click on the “up arrow” to increase the light 
intensity from 0 to the maximum to 120 kiloLux. They will see the 
screen background go from black to bright as the illuminance is 
increased. The number of stomata that are open can be used as 
a guideline for the rate of photosynthesis as the light intensity is 
increased.  

2. To run the simulation again, students may click on the reset arrow 
 and start over. As they increase the light intensity, they 

generate a graph on page 1.4. Following the graph, the three 
questions below are found in the .tns document. 

 

 

 

Move to pages 1.4-1.5. 
Q1. Students sketch graph in the space to the right. To reset the 

simulation and run it again, click on the reset button . 
 

Answer: See the graph to the right. 

 

Move to pages 1.6–1.8. 
Have students answer the questions on either the handheld, on the activity sheet, or both. 

Q2. As the light intensity increases, the rate of photosynthesis __________. 
 

Answer: A. increases 
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Q3. As the rate of photosynthesis increases, which of the following substances would you expect to 
decrease? 

 
Answer: B. carbon dioxide 

 
Q4. During which of the following months would you expect photosynthesis rates to be highest in the 

Southern Hemisphere? 
 

Answer: A. January 
 
Discussion Points and Possible Answers 
 

 
 

Move to pages 2.1–2.5. 
Students will read the brief background information on page 2.1.  
3. In this interactive simulation, students will observe the impact of 

the wavelength (color) of light on the rate of photosynthesis. To 
start the simulation on page 2.2, students click on the start arrow. 
They then click repeatedly on the “up arrow” to increase the 
wavelength of visible light to which the leaf is exposed. They 
should continue to increase the wavelength until they reach the 
upper limit of 780 nm. As they increase the wavelength, an 
indicator moves across the visible spectrum (ROYGBIV) at the 
top of the screen. The background of the screen also changes as 
the wavelength increases, as do the number of stomata that are 
open and closed. Remind students to pay attention to the opening 
and closing of the stomata at various wavelengths. This is an 
indication of the rate of photosynthesis. Sample screens are 
below. Sample graphs are on the right. 

 

 Light certainly plays a huge role in the efficiency and rate of photosynthesis. However, other 
variables not addressed in this activity, are involved. You may wish to discuss the importance of 
water to the photosynthetic process. And the most critical limiting factor to the rate of photosynthesis 
is often carbon dioxide, since the atmospheric concentration is only 0.04%. If environmental 
conditions are really good for photosynthesis, the plant can actually deplete the level of carbon 
dioxide around the leaf. This can lead to an undesirable result called “photorespiration.” If desired, 
discuss this problem with your students, and introduce the idea of C4 and CAM plants to them. 
These plants manage to avoid photorespiration because of an alternative pathway to glucose 
production. 
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Students will answer the following questions on the student activity sheet.  

Q5. Sketch both graphs in the spaces to the right. 
 

Answer: See the sketches to the right.  
 
 
 
 

Q6. Explain why the graphs look the way they do. 

 

Photosynthesis Rate: The plant can absorb and use light 
energy with wavelengths in the blue and red ranges, but not 
with wavelengths in the green range. This is why there are 
peaks of activity in the blue and red ranges and a valley in the 
green range. 

 
CO2 Level: The CO2 level in the air around a leaf will be 
inversely proportional to the rate of photosynthesis. Therefore 
the levels of CO2 will be lower when the rate of photosynthesis 
is higher, and vice versa. 
 

 

 

 

Q7. Why do you think ROYGBIV was displayed backward on page 2.2? 
 

Answer: The spectrum is arranged by increasing wavelength, with the shorter wavelengths to 
the left (violet) and the longer wavelengths to the right (red). 

 
Q8. Which wavelengths of light were best for photosynthesis? How can you tell? 
 

Answer: About 440–460nm and 660–700nm. These regions of the spectrum showed the 
peaks in photosynthesis rate. 

84



 Recipe for a Living World   TEACHER NOTES 

SCIENCE NSPIRED   
 

©2013 Texas Instruments Incorporated 5 education.ti.com 

 
Q9. Which colors of light were best for photosynthesis? 
 

Answer: Blue and red. These regions of the spectrum showed the peaks in photosynthesis 
rates. 

 
Q10. Which wavelengths of light were least used for photosynthesis? 
 

Answer: from about 530–620nm 
 
Q11. Which colors of light were least used for photosynthesis? 
 

Answer: mostly green and colors around green in the spectrum 
 
Q12. How does your answer to Question 11 explain the color of most plants? 
 

Answer: Plants are green because they have chlorophyll, which reflects green light, rather 
than absorbing it and using it for photosynthesis. 

 
Q13. During the simulation, how could you tell which wavelengths were best for photosynthesis and 

which ones were not? 
 

Answer: You could tell by looking and the “peaks” and “valleys” on the first graph. 
 
Q14. What would happen if a plant were exposed ONLY to green light? Why? 
 

Answer: Photosynthesis would occur very slowly, or not at all, and the plant would eventually 
die of starvation. 

 
Q15. Describe a place on Earth where photosynthesis rates would tend to be consistently very 

high. Explain. 
 

Answer: Best answer would be either a tropical rain forest or tropical oceans and seas. Light 
intensity is high and there is plenty of water available. 
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TI-Nspire Navigator Opportunities 

Ask students to share their screens as they pause at various wavelengths in Problem 2. Discuss the 
results with the entire class. Question responses from Problem 1 may be collected and assessed using 

TI-Nspire Navigator. 
 

Use TI-Nspire Navigator to capture screen shots of student progress and to retrieve the file from each 
student at the end of the class period. The student questions can be electronically graded and added to 

the student portfolio. 
 

 
 

Wrap Up 
When students are finished with the activity, pull back the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. 
 
Assessment 

• Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved. The Slide Show will be utilized to give students immediate 
feedback on their assessment. 

• Summative assessment will consist of questions/problems on the chapter test. 
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Open the TI-Nspire document When_Water_Leaves.tns. 
 
You have always known that plants needed water. When a plant goes 
only a few days without water, it starts to look pretty bad. What factors 
influence how quickly plants lose water? This will be explored during 
this activity. 

  

 
Water is one of the reactants in the photosynthetic process, and it maintains the turgor pressure 
(pressure against cell walls) in plant cells.  This outward pressure keeps the leaves of the plant from 
drooping. Droopy leaves display less surface area to the sun, thereby reducing photosynthesis. This 
causes the plant to produce fewer nutrients. 
Plants take in water through their roots, and the water travels through the plant to the leaves. The water 
that is not used for either photosynthesis or maintaining turgor pressure is released from the leaves. In 
fact, most of the water that a plant takes in is never used by the plant. And the amount of water that 
leaves the plant is staggering. A 50 foot tall maple tree loses about 60 gallons of water per hour from the 
surfaces of its leaves. 
Transpiration is the process of water escaping from leaves through pores called stomata. Stomata also 
allow for gas exchange (CO2 and O2) for the plant. A number of environmental factors affect transpiration 
rate, such as temperature, relative humidity, and wind. In the simulation in this activity, you will be able to 
manipulate these environmental factors and see what effect they have on transpiration rates. 
 
Move to pages 1.2–1.4.  
 
After reading the background information on page 1.2, move to page 
1.3. Page 1.3 shows a picture of a leaf, along with some 
environmental conditions that you will eventually manipulate. 

1. For the first simulation, leave the conditions as they are and click 

on the start arrow . The simulation takes a couple of minutes 
to run to completion. While the simulation is running on page 1.3, 
periodically move to 1.4 so you can see both the diagrammatic 
and graphical representations. When the simulation is finished, a 
graph with four plots will display patterns for you to analyze. 
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Answer the following questions (Q1- Q7) here. 
Q1. In the graph space to the right, sketch and label the four plots. 
 

 
 

Q2. Why did the “peaks” in the temperature and transpiration plots occur at nearly the same time? 
 
 
 
Q3. Predict how the graph would change if you increased the temperature. 
 
 
 
Q4. Predict how the graph would change if you decreased the temperature. 
 
 
 
Q5. Does the transpiration rate change when the temperature changes? Explain. 
 
 
 
2. Reset the animation on page 1.3 by clicking on the  icon. Run the simulation two more times—one 

with the temperature set at 90oF and the other with the temperature set at 50oF. To adjust the 
temperatures, click on the up and down arrows next to the “Temp” control. 

3. Sketch the graphs below. 
 
Q6.  Graph at 90oF. 
 
 
 
 
 
 
 

Q7.  Graph at 50oF. 
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4. Now you may change the environmental conditions in any ways you would like. Run the simulation at 

least four more times, record the conditions, and then sketch your resulting graphs. 
 
Simulation 1: 
Temp: ______ Humidity: ______ Wind: ______ 
Graph: 
 
 
 
 
 

Simulation 2: 
Temp: ______ Humidity: ______ Wind: ______ 
Graph: 
 
 
 
 
 

Simulation 3: 
Temp: ______ Humidity: ______ Wind: ______ 
Graph: 
 
 
 
 
 

Simulation 4: 
Temp: ______ Humidity: ______ Wind: ______ 
Graph: 
 
 
 
 
 

Analysis Questions 

Move to page 2.1-2.5.  
Answer the following questions here or in the .tns file. 

Q8. Which one of the following is true? 
A. Plants make use of almost all of the 

water they take in. 
B. Most of the water that a plant takes in is 

released through the leaves. 

C. Water and oxygen are the two reactants in the 
process of photosynthesis. 

D. Transpiration happens through the roots. 

Q9. Water actually leaves the plant through small pores called ________________________. 
 
 
 
Q10. Select all of the following that would increase the rate of transpiration. (More than one response 

may be correct.) 
A. high humidity 
B. strong winds 
C. cool temperatures 

D. low humidity 
E. hot temperatures 
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Q11. What process in humans is most similar to transpiration in plants? 
 
 
 
Q12. Which of the following could result if a plant does not have enough water? Choose all that would be 

correct. (More than one response may be correct.) 
A. Photosynthesis rates would decrease. 
B. Carbon dioxide usage would increase. 

C. All of the stomata would open and stay open. 
D. Turgor pressure in leaf cells would decrease. 

Answer the following questions here. 

Q13. Describe how the environmental temperature affects the rate of transpiration. 
 
 
 
Q14. Describe how relative humidity affects the rate of transpiration. 
 
 
 
Q15. Describe how wind affects the rate of transpiration. 
 
 
 
Q16. Describe the weather conditions on a day when transpiration rates would most likely be high. 
 
 
 
Q17. Describe the weather conditions on a day when transpiration rates would most likely be low. 
 
 
 
Q18. How do you think plants regulate the rate of transpiration? 
 
 
 
Q19. Describe how wind affects the rate of transpiration. 
 
 
 

90



  When Water Leaves!                                               Student Activity 
SCIENCE NSPIRED   

  

©2013 Texas Instruments Incorporated 5 education.ti.com 

Q20. What structural adaptations do you think desert plants have to reduce transpiration? Explain how 
these adaptations reduce transpiration. 

 
 
 
Q21. Describe a terrestrial environment in which plants might have really large leaves with lots of 

stomata. 
 
 
 
Q22. Water regulation is critical for all animals and plants—including humans. Perspiring is one means by 

which humans regulate water for our bodies. How are perspiring and transpiration similar? How are 
they different? 
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Science Objectives  
• Students will investigate and discover relationships among 

dissolved oxygen levels, pH, and temperature.   

• Students will manipulate the levels of temperature and pH to 
determine the effects on dissolved oxygen, population and 
species richness in a freshwater system. 

Vocabulary 
• gradient 
• photosynthesis 
• relative humidity 
• stomata 
• transpiration 
• turgor pressure 

 
About the Lesson 
• This lesson involves students using TI-Nspire™ technology to 

model the effects of various environmental conditions on the rate 
of transpiration from the leaves of a plant.  

• As a result, students will: 
• Better understand the process of transpiration. 

• Predict the effect of these environmental conditions on the 
plant. 

TI-Nspire™ Navigator™ 
• Send out the .tns file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
 

Activity Materials 

• Compatible TI Technologies: TI- Nspire™ CX Handhelds, 

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 

 
 
Tech Tips: 
• This activity includes screen 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using. 

• Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  

 
Lesson Files: 
Student Activity 
• When_Water_Leaves_Student.d

oc 
• When_Water_Leaves_Student.p

df 
TI-Nspire document 
• When_Water_Leaves.tns 
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Discussion Points and Possible Answers 
 
Water moves through a plant from roots to stem to leaves to air. The most important driving force behind 
this movement is transpiration. More generally, the movement of water is based on a gradient of water. 
The plant acts as a conduit between the soil and air. Since there is more water in the soil than in the air, 
water moves upward. Eventually water leaves the plant through stomata, and then more water moves up 
to replace it. The more water that leaves, the more is needed to replace it. A tree can transpire hundreds 
of gallons of water every day. 
 
Move to pages 1.2–1.4. 
After reading the background information on page 1.2, students will 
move to page 1.3. Page 1.3 shows a picture of a leaf, along with some 
environmental conditions that students will eventually manipulate. 
 
1. The simulation in this activity models transpiration rates as 

environmental conditions change. First, the students should run 
the simulation at the default settings on Page 1.3 of the .tns file—
and in the image at the right above. When they run this simulation, 
the graph that they see looks like the one at the right below. Notice 
that the relative humidity and wind plots do not change. The 
transpiration rate follows a similar pattern as the temperature went 
through the daily cycles. 

 

 

 

Tech Tip: Ensure students reset the animation between trials. 

Resetting the animation deletes previous data and clears the graph. 

Now, have students answer the Questions Q1- Q5 on the student activity sheet. 

Q1. In the graph space to the right, sketch and label the four plots. 
 
 Answer: See the graph to the right of students’ activity sheets. 
 
Q2. Why did the “peaks” in the temperature and transpiration plots occur at nearly the same time? 
 
 Answer: Increases and decreases in temperature cause corresponding increases and decreases in 

molecular movement. Therefore, the rate of water evaporation corresponds to the temperature. 
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Q3. Predict how the graph would change if you increased the temperature. 
 
 Sample answer: Answers will vary. 
 
Q4. Predict how the graph would change if you decreased the temperature. 
 
 Sample answer: Answers will vary. 
 
Q5. Does the transpiration rate change when the temperature changes? Explain. 
 
 Answer: The transpiration rate increases or decreases with the temperature. 
 
Changing the Environmental Conditions 
 
2. After running the simulation at the default settings, the students 

are asked to do two more simulations at different temperatures—
one warmer at 90oF and one cooler at 50oF. The warmer one will 
show a corresponding increase in transpiration and the cooler one 
will show a decrease. A simulation that was run at 90oF is shown 
to the right. 

3. After students run the simulations, they are asked to sketch the 
graphs. 

 

 

 
Now, have students answer the Questions Q6- Q7 on the student activity sheet. 
Q6.  Graph at 90oF. 
 

  

Q7.  Graph at 50oF. 
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4. Finally, the students are asked to run the simulation at least four 
more times and adjust the environmental conditions in any way 
that they choose. They need to write down their chosen conditions 
and then sketch the resulting graphs in the spaces provided. One 
example of environmental conditions is shown to the right. The 
students need to simply click on the up and down arrows to the left 
of each condition to adjust that condition. Here is what the graph 
looks like with the conditions shown above the graph. 

 

 

Analysis Questions 

Move to page 2.1. 
Have students answer the following questions on either the handheld, on the activity sheet, or both. 
 
Q8. Which of the following is true? 
 
 Answer: B: Most of the water that a plant takes in is released through the leaves. 
 
Q9. Water actually leaves the plant through small pores called ______________________. 
 
 Answer: stomata 
 
Q10. Select all of the following that would increase the rate of transpiration. (More than one response 

may be correct.) 
 
 Answer: B. strong winds / D. low humidity / E. hot temperatures 
 
Q11. What process in humans is most similar to transpiration in plants? 
 
 Answer: perspiring 
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Q12. Which of the following could result if a plant does not have enough water? Choose all that would be 
correct. (More than one response may be correct.) 

 
 Answer: A. Photosynthesis rates would decrease / D. Turgor pressure in leaf cells would decrease 
 
Have students answer these final questions on the activity sheet. 
 
Q13. Describe how environmental temperature affects the rate of transpiration. 
 
 Answer: Higher temperatures promote higher rates of transpiration—unless the stomata close up. 
 
Q14. Describe how relative humidity affects the rate of transpiration. 
 
 Answer: Higher humidity reduces transpiration because the gradient is not as “steep” 
 
Q15. Describe how wind affects the rate of transpiration. 
 
 Answer: Wind increases evaporation, thus increasing transpiration rates. 
 
Q16. Describe the weather conditions on a day when transpiration rates would most likely be high. 
 
 Answer: Hot, low humidity, windy 
 
Q17. Describe the weather conditions on a day when transpiration rates would most likely be low. 
 
 Answer: Cool, high humidity, calm winds 
 
Q18. How do you think plants regulate the rate of transpiration? 
 
 Answer: Open and close their stomata at “strategic” times. 
 
Q19. Describe how wind affects the rate of transpiration. 
 
 Answer: It increases the rate of evaporation and, therefore, the rate of transpiration. 
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Q20. What structural adaptations do you think desert plants have to reduce transpiration? Explain how 
these adaptations reduce transpiration. 

 
 Answer: Leaves have less surface area (like spines on cacti) and very few stomata. With fewer 

stomata, leaves lose less water through transpiration. 
 
Q21. Describe a terrestrial environment in which the plants might have exceptionally large leaves with 

lots of stomata. 
 
 Answer: An example is a tropical rain forest, where lack of water is not a limiting factor. 
 
Q22. Water regulation is critical for all animals and plants—including humans. Perspiring is one means by 

which humans regulate water for our bodies. How are perspiring and transpiration similar? How are 
they different? 

 
 Answer: Similar—both involve the loss of water from the organism through small pores on the 

surface. Different—the main purpose of perspiring is temperature regulation, while the main 
purpose of transpiration is to get rid of excess water. Humans have other ways of releasing excess 
water, namely urination and breathing. 

 

TI-Nspire Navigator Opportunities 

Ask students to share their screens showing the environmental conditions that they selected. They 
should also show the resulting graphs that they generated. Discuss the results with the entire class. 

 

 

 
Wrap Up 
When students are finished with the activity, pull back the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. 
 
Assessment 

• Analysis questions are written into the student worksheet. 
• Formative assessment will consist of questions embedded in the .tns file. The questions will be 

graded when the .tns file is retrieved. The Slide Show will be utilized to give students immediate 
feedback on their assessment. 

• Summative assessment will consist of questions/problems on the chapter test. 
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Activity Overview 
In this activity, you will explore basic features of the TI-Nspire™ Teacher Software. You will explore the 
Welcome Screen, add pages with Calculator and Graphs applications, and explore the menus and 
submenus of each application. You will explore the five tabs within the Documents Toolbox, as well as the 
options available in the Documents toolbar and the Status bar. 
 
 

Materials 
• TI-Nspire™ or TI-Nspire™ CAS Teacher Software 

 
 
 

Step 1: 

Open the Teacher Software. The Welcome Screen 
displays an icon for each of the eight applications: 
Calculator, Graphs, Geometry, Lists & Spreadsheet, 
Data & Statistics, Notes, Vernier DataQuest™, and 
Question. To see a brief description of each 
application, hover the cursor over each icon.  

 

The Welcome Screen also allows you to view content, manage handhelds, transfer 
documents, and open documents. To see a description of each option, hover the cursor 
over each icon. To view the Welcome Screen at any time, go to Help > Welcome Screen.  
 
A new TI-Nspire™ document may be opened by clicking any of the applications on the Welcome Screen. 
Alternatively, a new document may be opened by going to File and selecting New TI-Nspire™ 
Document – Handheld Page Size or New TI-Nspire™ Document – Computer Page Size. 

• The Handheld Page Size allows documents to be viewed on all platforms. The content will be 
scaled when viewed on a tablet or larger screen. 

• In Computer Page Size, content will not be scaled when viewed on smaller platforms and all 
content may not be visible on a handheld device. 

 
Step 2:  
Go to File > New TI-Nspire™ Document – Handheld Page Size.  Select  1:Add Calculator. 
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Step 3: 

The Calculator application allows you to enter and evaluate 
mathematical expressions as well as create functions and 
programs. 
 
In most cases, each application has a unique menu of 
commands and tools. To view the Calculator menu, go to the 
Documents Toolbox and select the  Document Tools tab. 
Each item in the Calculator menu has a submenu.  
 
Explore the various menus and submenus by entering and 
evaluating your own expressions. 
 
Note: To access the Calculator menu on the handheld, 

press b. 

  

Step 4: 

The  Utilities tab contains Math Templates, Symbols, 
Catalog, Math Operators, and Libraries panes. Only one pane is 
displayed at a time, and the Math Templates pane is the default 
pane. Explore each of the other panes by clicking them. 
 
To insert a Math Template into the Calculator application, 
double-click it. Explore various Math Templates by evaluating 
your own expressions involving fractions, exponents, square 
roots, logarithms, and absolute value expressions. 
 
Note: When evaluating expressions, the Calculator application 

displays rational expressions by default. To display a 
decimal approximation on a PC, press CTRL + Enter. 
To display a decimal approximation on a Mac, press 
Command + Enter. 
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Step 5: 

The  Insert menu allows you to insert 
problems and pages, along with each of the eight 
applications. A problem can contain multiple 
pages, and variables that are linked within a 
problem are linked across pages.  
 
Insert a Graphs application by selecting  Insert > 

 Graphs.  
 
The Graphs application allows you to graph and 
analyze relations and functions. Explore the 
various menus and submenus available in the 
Graphs application. 
  

Step 6: 

Graph the function f(x) = x by typing x into the 
function entry line and pressing Enter. 
 
Rotate the line by hovering the cursor over the 
upper-right or lower-left corner of the graph. When 
the rotational cursor, é, appears, rotate the line 

by clicking and dragging it. 
 
Translate the line by hovering the cursor over the 
line near the y-intercept of the graph. When the 
translational cursor, ö, appears, translate the line 

up or down by clicking and dragging it. 

 
 

 

101



 Getting Started with the TI-Nspire™ Teacher Software 
TI PROFESSIONAL DEVELOPMENT 

 

 

©2014 Texas Instruments Incorporated 4 education.ti.com 

Step 7: 

Since you have inserted a Calculator application 
and a Graphs application, your TI-Nspire™ 
document now has two pages. The Page Sorter 
view allows you to view thumbnail images of all 
pages in the current TI-Nspire document. 
 
Access the Page Sorter by going to the 

Documents Toolbox and clicking the  Page 
Sorter tab. Pages can be rearranged by grabbing 
and moving them. Right-clicking allows for pages 
to be cut, copied, and pasted. 
 
Note: To access Page Sorter in the handheld, 

press /£. To right-click in the 
handheld, press /b. 

 

 

Step 8: 

The Vernier DataQuest™ app can be used to 
collect, view, and analyze real-world data. Insert a 
page with the Vernier DataQuest app by selecting 

 Insert >  Vernier DataQuestTM. 
 
Though no data will be collected during this 
activity, the data meter will automatically launch 
when a Vernier sensor is connected to the 
computer’s USB port. 
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Step 9: 

The Documents toolbar allows you to create, open, and save a TI-Nspire document. 
Commands such as Undo, Redo, Cut, Copy, and Paste are also available. Explore these 
options by hovering the cursor over each icon. Pages, problems, and applications can be 
inserted and variables can be stored.  
 
Take a Screen Capture of the current page by selecting  Take Screen Capture >  

Capture Page. This Screen Capture can be saved as an image. 
 

 
 
Page layouts allow multiple applications to appear on one screen. Explore the various 
page layouts that are available by clicking  Page Layout.  

The Document Tools menu contains tools and commands for the 
current application. 
 
To change the fill color, line color, or text color, select an object 
and then select a color from the appropriate menu. To receive 
additional information about a given menu, hover the cursor over 
it. Not all color menus are available on all applications. 
 

 

 

Step 10: 

The Status Bar allows the user to access Document Properties, Settings, and to adjust the 
zoom of the SideScreen.  
 

 
 
Increase the zoom of the SideScreen to 200% by selecting 200% in the Zoom menu. The 
Boldness feature is enabled when using a PublishView™ document.  
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Step 11: 

View the Document Properties by going to File > 
Document Properties. The Document Properties 
also can be viewed by going to the Status Bar and 
double-clicking Page Size: Handheld or Page Size: 
Computer. The page size displayed depends upon 
the type of TI-Nspire document originally opened. 

 
 

Step 12: 

View the Document Settings by going to File > 
Settings > Document Settings. The Document 
Settings can also be viewed by going to the Status 
Bar and double-clicking Settings. 

 

Note: To move across fields in the Document Settings window, press TAB. To change the 
setting in a given field, press the down arrow, select the desired setting, and press 
TAB to move to the next field. To exit the window, press ENTER. 

Step 13: 

Preview the document in Handheld or Computer view by clicking                                    . 
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Step 14: 

To access the TI-SmartView™ emulator for TI-Nspire, 
go to the Documents Toolbox and select the 
  TI-SmartView tab. 
 
TI-SmartView emulator has three available views: 
Handheld only, Keypad + SideScreen, and Handheld + 
Side Screen. Explore each of these views. 
 
The TI-SmartView emulator has three available keypads:  

• TI-Nspire™ CX 
• TI-Nspire™ with Touchpad 
• TI-Nspire™ with Clickpad 

 
Each keypad has three available views: Normal, High 
Contrast, and Outline. Click the  Keypad Options 
menu and explore each keypad and view. 

 

Step 15: 

Documents can be transferred between the computer 
and connected handhelds using the Content Explorer 
in the Documents Workspace. Explore the Content 
Explorer by clicking the  Content Explorer tab. 
 
To transfer a TI-Nspire document from the computer to 
the connected handheld, locate the document in the 
Computer panel. Click, drag, and drop it into the 
desired handheld or folder in the Connected 
Handhelds panel. 

 
To transfer a TI-Nspire document from the connected 
handheld to the computer, locate the document in the 
Connected Handhelds panel. Click, drag, and drop it 
into the desired folder in the Computer panel. 
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Objectives  
• Students will be able to insert various question types. 
• Students will be able to send a Quick Poll. 
• Students will be able to insert an image. 
• Students will be able to use a Chem Box. 
 
Vocabulary 
• Quick Poll 
• Chem Box 
 
About the Lesson 
• This lesson involves key tips for writing and reviewing effective 

open-response questions . 
• As a result, participants will... 

• Learn to ask better questions. 
• Learn to write better questions. 
• Learn how to use the Chem Box question type. 

 
Materials 
• TI-Nspire™ or TI-Nspire™ CAS Teacher Software 

 
 
TI-Nspire™ Technology Skills:  
• Format Text 
• Send a Quick Poll 
• Insert an Image 
• Insert a Question 

 
 
Creating Questions 
 
 Start a new document. 
 
1. Insert a Notes Page and enter text shown in the screen to the 

right. Use the text formatting features to create the desired effect. 
 
 
Label Question 

2. Press Insert. 
 
3. Select Image > Label. 
 
4. Enter the following text into the question box: “State the 

coordinates of the red points.” 
 
5. Change the color of the word red. 
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6. Modify the Configuration settings (in the Documents Tools) to 
allow 2 responses with the correct answers as shown to the right. 

  
7. Insert the line image by pressing Insert, selecting Image, 

and browse for the file line.bmp. 
 
8. Adjust the size of the A answer field and move it to an 

appropriate location on the image. 
 
9. Similarly, modify the size and location of the B answer field. 
 
Comments about Label Questions:  

The Label response prompt is a text box similar to Open 
Response Text Match. Students can insert a Math Box or 
Chemistry Box in the response prompt. An image can only be 
inserted into the response area, not the question area. All 
responses will be graded based on exact text match with the 
option to ignore case.  

 

 
 
 

 

Point On Question 
 
10. Press Insert and select Image > Point on. 
 
11. Enter the following text into the question box: “Select the 

relative minimum point(s) on the given polynomial.” 
 
12. Modify the Configuration settings (in the Documents Tools) 

to allow 5 responses with ‘multiple response’ and correct 
answers B and E. 

 
13. Insert the line image by pressing Insert, selecting Image, and 

browse for the file polynomial.bmp. 
 
14. Adjust the location of the points as shown in the figure to the 

right. 
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Comments about Point On Questions: 

For Point on image questions all responses are graded exactly the same as multiple-choice 
questions. For example, if a student selects 3 responses as correct when there are 2 correct 
responses, and the student selects only 1 response, the question will be graded as being 
incorrect. An image can only be inserted into the response area, not the question area. 
 
Chemistry Question 
 
15. Press Insert and select a Chemistry question. 
 
16. Enter the following text into the question box: “Tin oxide is 

heated with hydrogen gas to form tin metal and water vapor. 
Write the balanced equation that describes the reaction. 

 Unbalanced Equation: SnO2 + H2 → Sn + H2O” 
 
Note:   You will need to insert a Chemistry Box to type the 

unbalanced equation. It is located in the Question area 
of in the Document Tools. Select Insert > 2: Chem Box. 

 
17. Modify the Configuration settings (in the Documents Tools) 
       by entering the correct answer. 
 
18. To help enter the answer quicker, the unbalanced equation 

can be typed into the Student Response field. 
 
19. Save the document in a known location on your computer 

and name it New_Question_Types.tns. 
 
 
Comments about Chemistry Box Questions: 

Teachers can utilize Chemical Notation by inserting a Chemistry 
Box in the question. The student response area is pre-defined as 
a Chem Box. This enables entry of chemical formulas such as 
H2O.  The teacher needs to enter all forms of the correct answer. 
For example, if the correct answer is: 6H2O + Cu3(PO4)2, the 
teacher should include the correct answer: Cu3(PO4)2 + 6H2O. 
The software has no way to evaluate 2 chemical equations and 
determine if they are equivalent. 
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Sending a Question as a Quick Poll with the  
TI-Nspire™ or TI-Nspire™ CAS Navigator 
Teacher Software 
 
20. Teacher: Modify the quick poll options. 

• Allow students access to documents on their handheld. 
• Allow students to resubmit their quick poll answers. 

 
21. The current question in the Document Workspace can be 

sent as a quick poll by clicking the “Start Poll” icon. 
 
22. Answer the quick poll question. Then submit the answer by 

pressing ~1. 
 
 
Reviewing Class Results 
 
The teacher can view the results of the poll while they are being 
received or after the poll has been stopped. 
 
23. As soon as the quick poll is sent to the class, the software 

switches to the Review Workspace and displays the quick 
poll question that was sent to the class. (If more than one 
quick poll question has been sent to the class, the question 
will be contained in one Review document for up 15 
questions. After the 15th question, a new review space 
document will start for the next 15 quick poll questions.) 

 
24. To view the class results for the quick poll questions, click on 

the “Class Results” icon underneath the question page in the 
page sorter view. Or scroll down using the scroll bar to the 
right of the large view of the quick poll question. 

 
25. To view the student submitted answers in detail, click on the 

Students icon in the Review Toolbox. 
• The display name and response are shown in a table. 
• To hide the student names, click the “student name 

format” icon and select <hidden>. 
• The results from all quick poll questions sent during a 

class session are compiled in a Review document and 
they can be saved for review at a later time. The results 
will be placed in the Portfolio for the class. 
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Wrap Up 
 
What are the different purposes for asking questions in class? 
 
Are there general guidelines to follow when writing questions? 
 

26. Click the Stop Poll and then Save icon (or select “Save to 
Portfolio” from the File menu.  

 
Teacher Tip: Be sure to clarify the difference from sending questions as a 
document versus sending questions as a Quick Poll 

 
 

  TI-Nspire™ Navigator™ Opportunity 

Use Class Capture to observe student participation and progress. 
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Activity Overview 
This activity provides an introduction to the basics of graphing functions and data.  
 

 
Part One — Graphing Functions  

Step 1:   

Press c and select New Doc to open a new document.  

Choose Add Graphs. 
 

Note:  To add a new Graphs page to an existing document, 
press /~ and choose Add Graphs. Alternatively, 
press c, and make a selection using the Touchpad. 

 
Step 2:  

The cursor will be in the entry line at the bottom of the screen to 
the right of f1(x) =. To graph, type the function and press ·.  
For example, to graph f1(x)=x2, type Xq and press ·. 
 

Note:  To graph multiple functions without closing the entry line, 
press ¤ after entering a function definition. After 
entering the last function definition, press ·. 

 
 

 
 

 

Step 3:  

Press b to see the selections available in the Graphs application. To exit the menu, 
press d. Menu options change depending upon the application. 

Part Two — Transforming Functions 

Step 4:   

As the cursor moves toward certain regions of the graph, two 
different tools—the Dilation tool or the Translation tool—will 
display. When the symbol for the Dilation tool, õ, is displayed, 

the graph of the quadratic function can be dilated.  

Step 5:   

Move the cursor toward the edges of the function to access the dilation tool. Press /x 

or hold the x key down until the hand closes to grab the graph, and use the Touchpad to 

dilate the function. Notice how the equation changes as the graph changes. Dilate the 
graph so it opens upward and downward. When finished, press x or d. 
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Step 6:  

To translate the graph of a quadratic function, move the cursor 
near the vertex of the parabola. When the Translation tool, ö, 
is displayed, press / x or hold the x key down until the 

hand closes to grab the graph, and use the Touchpad to 
translate the graph of the function. Notice how the equation 
changes as you translate the graph.  

Note:    Not every function can be translated and dilated by grabbing it. Linear, quadratic, 
exponential, logarithmic, and sinusoidal are the types of functions that can be 
manipulated this way. 

Tech Tip: If you move the cursor near a point on the graph and there are two 
different objects that can be selected, you might see the e show up on the 
screen. Press the e key to select the item that you want.  

 
Step 7:  

Add the linear equation. To graph the linear function, first press 
/ G to view the entry line. 

The cursor will now be to the right of f2(x) =. 
Graph a linear equation like f2(x) = x. 

 

Step 8:  

As you move the cursor toward certain regions of the graph of a 
linear function, two different tools—the Rotation tool or the 
Translation tool—may be displayed. To rotate the graph of the 
line, move the cursor to the graph of a line near the edge of the 
graph screen. When the rotation symbol, é, appears, grab and 
rotate the line. When finished, press x or d.  

Step 9:  

To translate the graph of a linear function, move the cursor near the center of the graph. 
The symbol for the Translation tool for a linear function is the same as that for a quadratic 
function. When the Translation tool is displayed, press / x to grab the graph, and use 

the Touchpad to translate the graph of the function. 

114



 Graphing Functions & Data   
TI PROFESSIONAL DEVELOPMENT 

 

©2014 Texas Instruments Incorporated 3 education.ti.com 

Part Three — Entering Data  

Step 10:   

To add a new Lists & Spreadsheet page to an existing 
document, press /~ and choose Add Lists and 
Spreadsheet. 
 
Step 11:   

Press  £ to move cursor to the top of column A.  Type conc as 

the column label.  Label column B absorp. 
 

 
 

Step 12:   

Enter the following data into columns A and B. 
                    conc             absorp 
                    0.080              0.089 
                    0.160              0.186 
                    0.240              0.281 
                    0.320              0.374 
                    0.400              0.463 
 

 

Part Four — Graphing Data  

Step 13:   

To add a new Graphs page to an existing document, press 
/~ and choose Add Graphs. 
 
Step 14:   
Change graph type to scatter plot. Select Menu > Graph Entry/Edit 
> Scatter Plot. Type conc (or press hand choose variable 
conc) for the x-axis and absorp for the y-axis. Press ·. 

 

 
 

Step 15:   

The data should now appear on the graph.  To adjust window to 
data, select Menu > Window/Zoom > Zoom-Data. 
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Part Five — Fit Data to a Linear Regression Line 
 

Step 16:   

Go back to the previous page—the Lists & Spreadsheet page.  
Select Menu > Statistics > Stat Calculations > Linear 
Regression (mx+b). Enter conc and absorp as the X List and 
Y List variables.  

 

 
Step 17:   

Press ·. The results of the linear regression are show in the 

spreadsheet and stored in function f3(x). 

 
 

Part Six — Graph Linear Regression Line and Interpolate 
 
Step 18:   

Go to the Graphs page. Change graph type back to function. 
Select Menu > Graph Entry/Edit > Function. Press  £ to select 
function f3 and press ·. 

 
 

Step 19:   

Place a point on the line. Select Menu > Geometry, Points and 
Lines > Point On. Move cursor to line and press · to mark 
the point. Press d to exit the Point On tool. 

 
 

Step 20:   

Double click on the y-coordinate of the point. The value should 
be highlighted. Type the value of the y-coordinate for which you 
wish to know the corresponding x-coordinate on the regression 
line. In this case the y-coordinate is the absorbance (0.308) of 
the unknown concentration. The interpolation indicates the 
concentration of the unknown is 0.265 M. 
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Adapted from Experiment 10, “Transpiration”, from the Biology with Vernier lab book 13 - 1 

Transpiration 
Water is transported in plants, from the roots to the leaves, following a decreasing water potential 
gradient. Transpiration, or loss of water from the leaves, helps to create a lower osmotic 
potential in the leaf. The resulting transpirational pull is responsible for the movement of water 
from the xylem to the mesophyll cells into the air spaces in the leaves. The rate of evaporation of 
water from the air spaces of the leaf to the outside air depends on the water potential gradient 
between the leaf and the outside air. 

Various environmental factors, including those conditions which directly influence the opening 
and closing of the stomata, will affect a plant’s transpiration rate. This experiment will measure 
transpiration rates under different conditions of light, humidity, temperature, and air movement. 
The data will be collected by measuring pressure changes as the plant takes up water into the 
stem. 

 
OBJECTIVES 
In this experiment, you will 

• Observe how transpiration relates to the overall process of water transport in plants. 
• Use a handheld interface and a Gas Pressure Sensor to measure the rate of transpiration. 
• Determine the effect of light intensity, humidity, wind, and temperature on the rate of 

transpiration of a plant cutting. 
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Figure 1 

MATERIALS 
TI-Nspire handheld or  100 watt light source 
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   computer and TI-Nspire software  metric ruler 
data-collection interface masking tape 
Vernier Gas Pressure Sensor plastic gallon size bag with twist tie 
utility clamps heater, small electric 
ring stand fan with slow speed 
plant cuttings aerosol spray container or plant mister 
plastic tubing clamps plastic syringe 
dropper or Beral pipette graph paper 
razor blade or scalpel  

 
 
PROCEDURE 
1. Position the ring stand, utility clamps, and Gas Pressure Sensor as shown 

in Figure 1. 

2. Prepare the plastic tubing. 
a. Connect the plastic syringe to one end of a 36–42 cm piece of plastic 

tubing. 
b. Place the other end of the tubing into water and use the syringe to draw 

water up into the tubing until it is full. Tap the tubing to expel any air 
bubbles that form inside the tube. 

c. Slip a plastic tubing clamp onto the tubing as shown in Figure 2. 
d. Bend the tubing into a U shape with both ends up. Remove the syringe, 

leaving the tubing full of water. 
 
3. Select a plant which has a stem roughly the same diameter as the opening of the plastic 

tubing. Using a scalpel or razor blade, carefully cut the plant one inch above the soil. Place 
the plant under water against a hard surface and make a new cut at a 45° angle near the base 
of the stem. 

4. Connect the plant to the tubing. 
a. The plastic tubing has a white plastic connector at one 

end that allows you to connect it to the valve on the Gas 
Pressure Sensor. Raise the end of the tubing with the 
connector until you see water beginning to drip out of 
the other end. 

b. Carefully push the cut stem of the plant down into the 
end of the tubing where the water is dripping out. Be 
careful not to allow any air bubbles to form between the 
cut portion of the stem and the water in the tube. 

c. Push the plant down as far as it will go without 
damaging the plant. At least one centimeter of the plant 
stem should fit into the tubing. If the stem is too large 
for the tubing, cut the stem at a higher point where it is 
smaller. 

d. Squeeze the tubing clamp shut as tight as possible as 
shown in Figure 3. 

 
5. When the tubing clamp is shut tight, invert your plant cutting to check for any leaks. If water 

does leak out, turn the plant right-side up and try tightening the clamp further. 

Figure 2 

Figure 3 
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 Important: Be sure the tubing is filled completely with water. The water column must be 
flush with the stem. There should be no air visible at the base of the stem. If water moves 
down the tube away from the stem after it has been inserted, check for a leak in the system. 

6. Connect the plastic tubing to the sensor valve. Caution: Do not allow water to enter the valve 
of the Gas Pressure Sensor. 

7. Secure the plant in an upright position with the utility clamps as shown in Figure 1. It should 
be positioned so that the cut stem is about 8 cm below the water level at the other end of the 
tubing, as shown in Figure 1. 

8. Place a mark on the tube at the starting water level to allow you to refill the tube to the proper 
level when you repeat data collection. 

9. Place your plant setup in an area where the wind, humidity, and temperature are reasonably 
constant. This will be your control setup. 

 10. Allow the system 5 minutes to adjust to the environment. While the system is adjusting, 
continue with this procedure to complete setting up the sensor and data-collection 
parameters. 

 11. Connect the Gas Pressure Sensor to the data-collection interface. Connect the interface to the 
TI-Nspire handheld or computer. 

 12. Choose New Experiment from the  Experiment menu. Choose Collection Setup from the 
 Experiment menu. Enter 0.25 as the rate in samples per second and 900 as the experiment 

duration in seconds (15 minutes). The number of points collected should be 226. Select OK. 

 13. Check the base of the plant stem in the water tube to make sure that no air bubbles or air 
pockets have formed that will prevent the plant from taking up water. If an air pocket has 
formed, refit the plant in the tubing before initiating data collection in Step 14. 

 14. After the plant has equilibrated for 5 minutes, start data collection ( ). Data will be 
collected for 900 seconds. If necessary, you can stop data collection early ( ). 

 15. When data collection has stopped, perform a linear regression to calculate the rate of 
transpiration. 
a. Examine the graph and identify the most linear region. 
b. Select the linear region of the data. 
c. Choose Curve Fit ►Linear from the  Analyze menu. The linear-regression statistics for 

these two data columns are displayed for the equation in the form 
y = mx + b 

where x is time, y is pressure, m is the slope, and b is the y-intercept.  
d. Enter the absolute value of the slope, m, as the rate of transpiration in Table 1. 
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 16. Design an experiment to simulate one of the following environmental conditions, as assigned 
by your teacher: 
• the effect of light intensity 
• the effect of the wind blowing on the plant 
• the effect of humidity 
• the effect of temperature 
• the effect of another self-identified environmental variable 

 
  Be sure to address the following questions in your design: 

• What is the essential question being addressed? 
• What assumptions are made about the system being measured? 
• Can those assumptions be easily verified? 
• Will the measurements provide the necessary data to answer the question under study? 

 
 17. After checking your procedure with your teacher, obtain the materials needed for the 

experiment and perform the tests. Be sure to Store Data button ( ) before each new trial. 
Record your values in Table 1. 

 18. Identify the environmental condition you tested in the blank provided in Table 1. 

 
PROCESSING THE DATA 
1. Determine the surface area of all the leaves on your plant cutting by the following method: 

a. Cut all the leaves (not stems) off your plant and determine their mass using a balance. 
b. Estimate the total leaf surface area in cm2 for your plant by cutting out a section of leaf 

5 cm X 5 cm. 
c. Determine the mass for this leaf section and divide by 25 cm2 to find the mass of l cm2 of 

leaf. 
d. Divide the total mass of the leaves by the mass of l cm2 to find the total leaf surface area. 
e. Record the calculated surface area in Table 1. 

 
2. Divide the slope by the surface area for each test and record in the rate/area column of 

Table 1. These rate values should be expressed as kPa/s/cm2. 

3. Subtract the control (rate/area) value from the experimental value. Record this adjusted rate 
in the last column of Table 1. 

4. Record the adjusted rate for your experimental test on the board to share with the class. 
Record the class results in Table 2 for each of the environmental conditions tested. If a 
condition was tested by more than one group, take the average of the values and record in 
Table 2. 

5. Make a bar graph that shows the effect of different environmental conditions on the 
transpiration of water in plant cuttings. Using the data in Table 2 plot the adjusted rate for 
each test on the y-axis and the test label on the x-axis. 
a. Insert a new problem in the document, then Insert a new DataQuest App into the problem. 

Click on the Table View tab ( ) to view the Table. 
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b. Double click on the X column to access the column options. Enter Test for the column 
name. Change the Display Precision to 0 decimal places. Select OK. 

c. Double click on the Y column to access the column options. Enter Rate for the column 
name. Enter kPa/s/cm2 as the units. Select OK. 

d. Insert a Data and Statistics application into the problem. 
e. Move the cursor over the Click to Add Variable label in the lower center of the screen and 

access the contextual menu. (/b on a handheld or right-click on a computer.) 
f. Choose the Add X Variable with Summary List option. 
g. Choose run1.Test as the X List and run1.Rate as the Summary List, then Select OK. 

 
DATA 

Table 1 

Test Slope 
(kPa/s) 

Surface area 
(cm2) 

Rate/area 
(kPa/s/cm2) 

Adjusted rate 
(kPa/s/cm2) 

Experimental _______________  
 

  

Control    
 

Table 2 - Class Data 

Test Adjusted rate  
(kPa/s/cm2) 

Light  

Humidity  

Wind  

Temperature  

 
 
QUESTIONS 
1. How was the rate of transpiration affected in each of the experimental situations as compared 

to the control? 

2. Which variable resulted in the greatest rate of water loss? Explain why this factor might 
increase water loss when compared to the others. 

3. What adaptations enable plants to increase or decrease water loss? How might each affect 
transpiration? 
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EXTENSIONS 
1. Using a compound microscope, identify the vascular tissues of a plant stem. Describe the 

function of each tissue type identified. 
a. Obtain a section of stem from the plant you used during the transpiration experiment. 
b. Using a nut-and-bolt microtome, carefully cut 6 cross sections of the plant stem. The cross 

sections should be cut as thin as possible. 
c. Place each of the cross sections in a dish or cup of 50% ethanol solution for 5 minutes. 
d. Remove the cross sections from the alcohol and place them in a dish containing toludine 

blue O stain for 5 minutes. 
e. Rinse the cross sections with distilled water and mount them on a microscope slide with a 

drop of 50% glycerin. Place a cover slip on the slide and examine the cross sections using 
a compound microscope. 

f. On a separate sheet of paper, make a drawing of the cross sections. Identify and label the 
cell and tissue types described by your teacher. 

2. Test cuttings from a variety of different plant species. How does each compare? 

3. Count the number of stoma/cm2 for each of the plants in Extension 1. How does this relate to 
the plant’s ability to transpire water? 

4. Design an experiment to test for the variables in Question 3. 
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Adapted from Experiment 10, “Transpiration”, from the Biology with Vernier lab book 13 - 1 T 

Transpiration 
1. Editable Microsoft Word versions of the student pages and pre-configured TI-Nspire files can 

be found on the CD that accompanies this book. See Appendix A for more information. 

2. You should leave water out overnight in a beaker or cup to allow any excess dissolved air to 
escape. This will ensure that no air bubbles form in the tube at the cut end of the stem. If air 
bubbles form, it may be necessary to restart your experiment. If bubbles do form, remove the 
plant and tubing from the two utility clamps and allow the plant to hang towards the ground 
with the other end of the tubing pointing up. Carefully tap on the sides of the tubing to loosen 
any bubbles—they will float to the water’s surface at the other end. Once all bubbles are 
removed, check the plant’s seal at the tube. Secure your plant in the tubing and restart the 
data collection. 

3. There is not always an immediate change in the transpiration rate. Allow the plant to spend a 
few extra minutes under a particular condition before initiating data collection. This will give 
the plant the necessary time to adjust. When the transpiration rate changes drastically, the 
stomata will close, decreasing the transpiration rate. If the length of data collection is 
extended, you will be able to see on the graph when the stomata have closed and the rate 
slows down. 

4. Many plants work well for this experiment. Plants that have been used include tomato, 
strawberry, bean, geranium, cyclamen, and even honeysuckle. For best results, we 
recommend using plants with numerous leaves. Tomato plants work very well and have been 
used to collect the sample data for this activity. One possible extension of this experiment 
would be to have the students use different plant species under similar conditions and 
evaluate how different plants have adapted to prevent water loss. 

5. The thick-wall plastic tubing that comes with the Gas Pressure Sensor is well suited for this 
lab. The inner diameter of the tubing is 3 mm and may be too small for some plant 
specimens. Science supply companies carry thick-wall plastic tubing, with a larger inner 
diameter, that will work well on larger plant stems. They also sell tubing connectors that will 
allow you to connect the larger tubing to the tubing provided with the Gas Pressure Sensor. 

6. Emphasize to your students the importance of providing an airtight fit with all plastic-tubing 
connections. 

 7. The plastic tubing clamps (order code PTC) used in the student procedure may be purchased 
in packages of 100 from Vernier Software & Technology. 
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SAMPLE RESULTS 

Test Adjusted rate  
(kPa/s/cm2) 

Control – 4.0 × 10-5 

Light – 9.4 × 10-5 

Humidity – .87 × 10-5 

Wind – .27 × 10-5 
 

 
 
ANSWERS TO QUESTIONS 
1. It is typically predicted that the light and wind will increase the rate of transpiration. This may 

not be apparent until after correction for surface area differences. Sometimes the wind, if too 
strong, may cause the leaves to droop or fold up, and in this case they may transpire less. 
Stomates may close to counter the dehydration. If this happens, discuss the nature of science 
experimentation, e.g., the expected may not always be the result. Usually, after correction for 
surface area, the high humidity plant will transpire less than a control. A student may 
question whether the light increased the temperature of the leaf. If the light was too close to 
the plant, temperature may indeed be a variable without a control. 

2. Answers will vary—usually the light will produce the greatest rate of water loss. High light 
intensity increases water loss due to increased photosynthesis. Wind removes water vapor 
from the surface of the leaf more rapidly. It may increase the evaporation rate by increasing 
the gradient between water in the leaf air spaces and water vapor in the air. 

 3. Plants can increase or decrease water loss by 
• closing the stomata during water stress. 
• reducing the number of stomata. 
• waxy cuticles. 
• fleshy, thick leaves. 
• hairy surfaces. 
• reducing the overall leaf surface area. 
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Open the TI-Nspire document DNA_Structure.tns. 
 
The “instructions” for the structure and function of all living things are 
contained in their DNA. All organisms rely on the same basic genetic 
code, using the same 4 building blocks (nucleotides) to make 
organisms ranging in complexity from yeast to you. A single 
deoxyribonucleic acid molecule, or DNA, can be millions of 
nucleotides long! 
 

 

Life as we know it is possible because DNA can replicate, allowing us to grow and reproduce. 
Understanding the structure of DNA is important for understanding how DNA is replicated. The structure 
of DNA was first solved in 1953 by James Watson and Francis Crick. In this lesson, you’ll learn about 
DNA structure by exploring several simulations. 

 
Part 1: Introduction 

Move to pages 1.2 and 1.3. 

DNA provides the molecular instructions that guide the building of all living organisms. It contains the 
genetic instructions to make an organism as complex as YOU As you will see in this lesson, the structure 
of DNA is actually very simple and quite repetitive. The basic building blocks are the same in all 
organisms from tiny bacteria to your pets! 

1. By interacting with several simulations in this lesson you will learn, about the structure of DNA and 
how that structure influences its characteristics. On the next page, you'll see a diagram of some 
DNA. Follow the instructions on the page to learn about DNA before answering the questions on the 
following pages. 

 

Move to page 1.4 

This page shows a double helix, which is the basic three dimensional 
structure of DNA. Tap the “next” arrow to see some parts of DNA. 
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Move to pages 1.5 – 1.6. Answer questions 1 and 2 here and/or in the .tns file. 

Q1. How many separate strands of DNA are in the double helix? 

A. 0 
B. 1 
C. 2 
D. 3 
 

Q2. The phosphate backbone is covalently bonded to a  ____________ . 
 

A. nucleotide base 
B. base pair 
C. double helix 
D. phosphate 

 
Part 2: Chargaff’s Rules 
 
Move to pages 2.1 – 2.2. 

2. Chargaff was a scientist who studied DNA before the structure or function of this molecule was fully 
understood. He made two key observations that were essential for solving the structure of DNA. 
Read about him and his observations on pages 2.1 and 2.2.  
 
DNA has 4 nucleotide building blocks, also called “bases”: adenine (A), thymine (T), cytosine (C), 
and guanine (G). Before the structure of DNA was known, Erwin Chargaff, an Austrian professor at 
Columbia University, made two essential observations about the bases which helped lay the 
groundwork for others to solve the double-helical structure of DNA. 
 
The first of Chargaff's rules was that in ANY sample of DNA from ANY organism, there is always 
about the same percentage of A as there is of T, and the same percentage of C as G. The second 
rule was that the amounts of A and T or C and G were similar on a single strand of DNA.  

 
Move to page 2.3.   

3. In this simulation, you can change the amount of each base in a 
hypothetical sample of DNA to see how it affects the percentages 
of the other three nucleotides, based on Chargaff’s rules. Try 
several different combinations. 

 

126



  DNA Structure Name   
Student Activity   Class   

 

©2014 Texas Instruments Incorporated 3 education.ti.com 

Move to pages 2.4 – 2.6. Answer questions 3–5 here and/or in the .tns file. 
 
Q3. Based on Chargaff's rules, which are the correct base pairs?  (Select all that apply). 
 

A. Adenine and Thymine  
B. Thymine and Cytosine 
C. Cytosine and Guanine 
D. Guanine and Guanine 
 

Q4. If a DNA molecule is 29% Guanine, what percent will be Thymine? 
 

A. 21% 
B. 25% 
C. 27% 
D. 29% 

 
Q5. Are there limits to the amount of any base pair in DNA?  For example, can you have DNA that is 

52% A? Explain. 
 
 

Part 3: DNA Structure 
 
Move to page 3.1 – 3.2. 
Now that you know more about the overall structure of DNA, you will take a closer look at the nucleotides 
to understand how each component of the structure influences the function of DNA. When the structure 
of DNA was solved, it became clear that both strands can be a template to create new DNA strands. 
 
4. Next, you will look more closely at the molecular structure of 

DNA, including the specific types of molecular interactions and 
charges on the DNA molecule. When finished reading the 
Directions Box, select  in the top right corner to close the pop-

up box. Tap the wrench icon if you need to view the directions 
again. 
 
Explore this simulation thoroughly before moving on to answer 
the questions on the following pages. 
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Move to pages 3.3 – 3.5. Answer questions 6–8 here and/or in the .tns file. 
 
Q6. Does DNA have an overall charge? Explain. 
 
  
Q7. Which structure(s) is/are found in the backbone of DNA? (Select all that apply). 
 

A. Deoxyribose 
B. Hydrogen bond 
C. Base pair 
D. Phosphates 

Q8. Is the base pair A-T bound more tightly than the base pair G-C? Explain. 
 
 
 
Part 4: Base Pairing 
 
Move to page 4.1 – 4.2. 
5. Now that you have explored the structure of DNA, you will try to 

predict DNA sequences. On page 4.2, you will see a sequence 
of DNA. Use the up and down arrows to select the appropriate 
base to make a base pair for each base in the sequence. When 
you have completed all five bases, check your answer by taping 
the Play button. If you get one or more bases incorrect, press the 
Pause button to try again. To try a new sequence, select the 
Reset button.  
 

 

 

Move to pages 4.3 – 4.4. Answer questions 9–10 here and/or in the .tns file. 
 
Q9. Both strands have the same sequence of DNA. 
 

A. True 
B. False 
 

Q10. One strand of DNA can be used to solve the sequence of its pair. 
 

A. True 
B. False 
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Science Objectives  
Students will  

• Learn about the structure of DNA, including base pairing. 
• Be able to predict paired sequences of DNA. 
• Understand how the structure of DNA affects its function. 
 

Vocabulary 
• nucleotide • base pair 
• phosphate backbone • double helix 
• adenine • thymine 
• cytosine • guanine 
• ribose • deoxyribonucleic acid 
 
About the Lesson 
• Using a variety of simulations, students will interact with the 

structure of DNA to explore the building blocks and double helical 
structure of DNA.  Assessments are embedded in the activity to 
engage discussion and gauge learning. 

• As a result, students will: 
• Learn to recognize the general structure of DNA and its 

nucleotides: a nitrogen base, a deoxyribose sugar, and a 
phosphate. 

• Learn to apply Chargaff’s rules for base pairing, including 
predicting the sequence of paired DNA strands. 

 

TI-Nspire™ Navigator™ 
• Send out the DNA_Structure.tns file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
 
Activity Materials 

• Compatible TI Technologies:  TI-Nspire™ CX Handhelds,  

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 
 

 
 
Tech Tips:  
• This activity includes class 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other 
technologiesbesides the 
handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.  

• Access free tutorials at 
http://education.ti.com/ 
calculators/pd/US/Online-
Learning/Tutorials 

 
Lesson Files: 
Student Activity 
• DNA_Structure_Student.doc 
• DNA_Structure_Student.pdf 

TI-Nspire document  
• DNA_Structure.tns 
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Discussion Points and Possible Answers 
Have students read the background information on the student activity sheet. 

Part 1: Introduction 

Move to pages 1.2 – 1.4. 
1. Students should read the background information on pages 1.2 

and 1.3, and then look at the figure on page 1.4. Following those 
pages, there are several questions that assess the students’ 
general knowledge of DNA structure.  
  

Move to pages 1.5 – 1.6. 
Have students answer questions 1–2 on the device, the activity sheet, or both. 
 
Q1.  How many separate strands of DNA are in the double helix? 

 
Answer: C. 2 

 
Q2.  The phosphate backbone is covalently bonded to a __________ . 
 

Answer: A. nucleotide base 
 
Each single strand of DNA is a single molecule, and the pair of DNA strands are held together by 
hydrogen bonds, as you’ll see later. 
 

Part 2: Chargaff’s Rules 
 
Move to pages 2.1 – 2.2. 
2. Students will get a brief introduction to Chargaff’s rules as they read these pages. Before the 

structure of DNA was determined to be a double helix, Chargaff’s rules indicated that A pairs with T, 
and G pairs with C. Students will learn about this from the text and the simulation.  
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 Move to page 2.3. 

3. Have students change the relative quantities of each base in a 
hypothetical DNA sample to see how it affects the other three 
nucleotides. They should try several different combinations 
before moving on the questions. 

 
  

Tech Tip: Select the arrows to change the values of the chart. 

 
Move to pages 2.4 – 2.6. 
Have students answer questions 3–5 on the device, the activity sheet, or both. 
 
Q3. Based on Chargaff's rules, which are the correct base pairs?  (Select all that apply). 
 

Answer: A. Adenine and Thymine and C. Cytosine and Guanine 
 

Q4. If a DNA molecule is 29% Guanine, what percent will be Thymine? 
 

Answer: A. 21%; 29% G will require 29% C, for a total of 58%. The remaining 42% will be half T 
and half A, 21% each. 
 

Q5. Are there limits to the amount of any base pair in DNA? For example, can you have DNA that is 
52% A? Explain. 

 
Suggested Answer: Yes, there are limits to the relative amounts of each base pair. A percentage 
equal to 52% of any nucleotide is not possible because each base requires a pair to satisfy 
Chargaff’s rules.  
 

Part 3: DNA Structure 
 
Move to pages 3.1 – 3.2. 
4. Students will receive a brief introduction to the next simulation on 

page 3.2. Have students read the directions in the pop-up box. 
They can select  to close the directions and view the 

simulation.  
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Tech Tip: Press b if you need to view the directions again. 

Tech Tip: Select  Tools > Directions to view the directions again. 

 
This interactive page will allow students to select different parts of the molecular structure of DNA to 
learn about each component. Students should explore this simulation thoroughly before moving on 
to answer the questions on the following pages. 

 
Move to pages 3.3 – 3.5. 
Have students answer questions 6–8 on the device, the activity sheet, or both. 
 
Q6. Does DNA have an overall charge? Explain. 
 

Suggested Answer: Yes, DNA has a negative charge which comes from the phosphates in the 
backbone. The longer the DNA strand, the greater the total charge. 

 
Q7. Which structure(s) is/are found in the backbone of DNA? (Select all that apply). 
 

Answer: A. Deoxyibose, D. Phosphates 
 

Teacher Tip: This question is a bit tricky. Have students try to visualize the 
structures that give the DNA ladder length, in contrast to the rungs, which 
are the bases. 

 
Q8. Is the base pair A-T bound more tightly than the base pair G-C? Explain. 
 

Suggested Answer: No. G-C pairs have three hydrogen bonds which are stronger than the two 
hydrogen bonds of A-T base pairs. 

 
Part 4: Base Pairing 

 
Move to page 4.1 – 4.2. 
5. Students will get instructions for the final simulation. This 

demonstration helps to check their base pair rules as they match 
a DNA sequence. On page 4.2, students should use the up and 
down arrows to select a nucleotide, and the play button to check 
their answer. Finally, they can use the reset button on the slide 
to create a new sequence to match.   
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  TI-NspireTM NavigatorTM Opportunities 
This would be a good activity to use the Class Capture and Presenter tools to have students work 
together on the same sequence, as sequences will be randomly generated. 
 
 
 

Move to pages 4.3 – 4.4. 
Have students answer questions 9–10 on the device, the activity sheet, or both. 
 
Q9. Both strands have the same sequence of DNA. 
 

Answer: False 
 

Q10. One strand of DNA can be used to solve the sequence of its pair. 
 

Answer: True  
 
 

  TI-NspireTM NavigatorTM Opportunities 
Choose a student to be a Live Presenter to demonstrate the simulations. The questions in the activity 
may be distributed as Quick Polls or used as a formative or summative assessment 
 

 
 

Wrap Up 
When students are finished with the activity, retrieve the .tns file using TI-NspireTM NavigatorTM. Save 
grades to Portfolio. Discuss activity questions using Slide Show. 
 
Assessment 

• Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved. The Slide Show will be utilized to give students immediate 
feedback on their assessment. 
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Open the TI-Nspire document DNA_Replication.tns. 
 
All living organisms carry their genetic information in DNA. As the 
organisms grow or reproduce, it is important that DNA replicates 
without making errors. The human genome is more than 3 billion 
base pairs long; imagine copying that much information without 
making a single mistake! The very elegant manner in which DNA 
replicates is generally the same for all organisms, from bacteria to 
you! 

 

 

Move to pages 1.4 – 1.5.  

1. In this lesson you will learn about DNA replication by interacting with some simulations that will 
demonstrate some of the key features of this process. Before that, you'll answer some questions to 
help you start thinking about DNA replication. 

Answer questions 1–2 here and/or in the tns file. 
Q1. Why is it important to replicate DNA without errors? What might happen if there were errors in DNA 

replication? 
 
 
Q2. When should DNA be replicated? What life events would include DNA replication? 
 
 
Move to pages 1.6 – 1.7.  
2. Read the information on page 1.6 about semi-conservative DNA 

replication. On page 1.7, you will see a simulation of two rounds 
of DNA replication. Click the right arrow to view the rounds of 
replication. 

 
 
Answer questions 3–5 here and/or in the .tns file. 

 

Q3. If one double helix of DNA replicates 3 times, how many double helices will there be? 
 

A. 4 
B. 6 
C. 8 
D. 10 
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Q4. What happens to the original template DNA after a round of replication? Explain. 
 

 
Q5. DNA polymerase, the enzyme that replicates DNA, can add about 1,000 bases per second. How 

many seconds would it take DNA polymerase to replicate the human genome (3,000,000,000 
bases long)? 

 
 
Move to pages 2.1 – 2.3. 

3. Read the information on pages 2.1 and 2.2 about the enzymes 
that are used in DNA replication. On page 2.3, read the directions 
given and then explore the enzymes that are involved in the 
replication of DNA.  

 
 

Select  to close the directions and view the simulation.  

Tech Tip: Press b if you need to view the directions again. 

Tech Tip: Select  Tools > Directions to view the directions again. 

Answer questions 6–10 here and/or in the tns file. 

Q6. Which enzyme acts first in DNA replication? 
 

A. Helicase 
B. Primase 
C. Polymerase 
D. Ligase 

 
Q7. DNA replication uses two different polymerases. Why do you think that is? 
 
 
Q8. What is the difference between the leading strand and the lagging strand? 

 
 

Q9. What is the purpose of primase? 
 

A. Recruits other enzymes for replication 
B. Creates an RNA primer that polymerase III can elongate 
C. Elongates the replicating DNA 
D. Connects DNA fragments together 
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Q10. Which enzyme(s) add(s) new DNA nucleotides to an existing strand? (Select all that apply.) 
 

A. Primase 
B. Ligase 
C. Polymerase I 
D. Polymerase III 
 

Move to pages 3.1 – 3.3. 

4. Read the information on pages 3.1 and 3.2 about Okazaki 
Fragments. On page 3.3, you will use a simulation of DNA 
replication to see how Okazaki fragments are built and then 
joined. Drag the circle along each segment slowly, following the 
directions. Be sure to read the information that appears as you 
drag the circle.  

Answer questions 11–14 here and/or in the tns file. 

Q11. Replication of the leading and lagging strands requires different enzymes. 
 

A. Agree 
B. Disagree 

 
Q12. Which order best describes the order that these enzymes will act during normal replication? 

 
A. Polymerase I, Polymerase III, Ligase, Primase 
B. Primase, Polymerase III, Ligase, Polymerase I 
C. Polymerase III, Primase, Polymerase I, Ligase 
D. Primase, Polymerase III, Polymerase I, Ligase 

 
Q13. How is replication of the leading and lagging strands different? 

 
 
 

Q14. Why are there no Okazaki fragments on the leading strand? 
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Science Objectives  
In this lesson, students will 
• Explore how the structure of DNA supports its semi-conservative 

replication 
• Identify the name and function of several key enzymes in DNA 

replication 
• Recognize the function of Okazaki fragments in DNA replication 
 
Vocabulary 
• double helix • leading strand 
• lagging strand • polymerase I 
• polymerase III • helicase 
• base pairs • Okazaki fragments 
• primase  
 
About the Lesson 
• Using three simulations, students will interact with DNA 

replication to explore semi-conservative replication and identify 
specific enzymes and their roles in replication. Assessments are 
embedded in the activity to engage discussion and gauge 
learning. 

• As a result, students will: 
• Learn the basic functions of the following DNA replication 

enzymes: helicase, primase, ligase, polymerase I and III. 
• Learn how the double helix reproduces in a semi-

conservative fashion 
• Learn the role and function of Okazaki fragments in 

replication of the lagging strand. 
 

TI-Nspire™ Navigator™ 
• Send out the DNA_Replication.tns file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
 
Activity Materials 

• Compatible TI Technologies:  TI-Nspire™ CX Handhelds,  

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 

 
 
Tech Tips:  
• This activity includes class 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other 
technologiesbesides the 
handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.  

• Access free tutorials at 
http://education.ti.com/ 
calculators/pd/US/Online-
Learning/Tutorials 

 
Lesson Files: 
Student Activity 
• DNA_Replication_ 

Student.doc 
• DNA_Replication_ 

Student.pdf 

TI-Nspire document  
• DNA_Replication.tns 
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Discussion Points and Possible Answers 
Allow students to read the background information on the student activity sheet and in the tns file on 
pages 1.2–1.3. 
 
Move to pages 1.4 – 1.5. 
 
1. Students are introduced to DNA replication. Before they learn 

about the key features of this process, they will answer some 
questions to get them thinking about DNA replication. This may 
be a good time to have a class discussion where students share 
their answers.  

Have students answer questions 1–2 on the device, the activity sheet, or both. 

Q1. Why is it important to replicate DNA without errors? What might happen if there were errors in DNA 
replication? 

 
Sample Answers: To prevent mutations and preserve genetic material. The organism could start 
producing something it doesn’t need or stop producing something it does need. 

 

Q2. When should DNA be replicated? What life events would include DNA replication? 
 

Sample Answers: cell division, growth, reproduction 

 

Move to pages 1.6 – 1.7. 
2. Students are to read the information on page 1.6 about semi-

conservative DNA replication. On page 1.7, they will view a 
simulation that shows two rounds of DNA replication. They are to 
select the right arrow to view the rounds of replication. 

 

 

Have students answer questions 3-5 on the device, the activity sheet, or both. 

Q3. If one double helix of DNA replicates 3 times, how many double helices will there be? 
 

Answer: C. 8 
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Q4. What happens to the original template DNA after a round of replication? Explain. 
 

Sample Answers: It is incorporated into new DNA. The semi-conservative replication of DNA 
means that “new” DNA is half new and half old DNA. 

 
Q5 DNA polymerase, the enzyme that replicates DNA, can add about 1,000 bases per second. How 

many seconds would it take DNA polymerase to replicate the human genome (3,000,000,000 
bases long)? 

 
Answer: 3,000,000 seconds 

This is 50,000 minutes. This is one reason that there are many copies of polymerase involved in 
replicating the human genome. 
 

Move to pages 2.1 – 2.3. 
3. Students are to read the information on pages 2.1 and 2.2 about 

the enzymes that perform DNA replication. On page 2.3, students 
are given a simplified image of DNA replication, showing the 
leading and lagging strands. After reading the directions given, 
students can select  to close the directions and view the 

simulation. They are to explore the enzymes that are involved in 
the replication of DNA by tapping different parts of the image. 
 

 

Tech Tip: Press b if you need to view the directions again. 

Tech Tip: Select  Tools > Directions to view the directions again. 

Have students answer questions 6–10 on the device, the activity sheet, or both. 

Q6. Which enzyme acts first in DNA replication? 
 

Answer: A. Helicase 

Helicase exposes the strands of DNA for other enzymes to access. 
 
Q7. DNA replication uses two different polymerases. Why do you think that is? 
 

Sample Answers: Each polymerase works at a different site; Polymerase I replicates short 
segments, Polymerase III replicates longer segments. 

Each polymerase performs differently; Polymerase III can stay bound to and replicate long 
segments of DNA, while Polymerase I does not. 
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Q8. What is the difference between the leading strand and the lagging strand? 
 

Sample Answer: direction of replication, requires additional primers 

Both strands replicate with the same enzymes, but the lagging strand must replicate in short 
segments to make up for replicating away from the direction of the helicase.   

Q9. What is the purpose of primase? 
 

Answers: B. Creates an RNA primer that polymerase III can elongate 

DNA must be added to a substrate (during replication, an RNA primer), 5’ to 3’. Polymerases only 
elongate DNA, they do not initiate it. 
 

Q10. Which enzyme(s) add(s) new DNA nucleotides to an existing strand? (Select all that apply.) 
 
Answers: C. Polymerase I and D. Polymerase III 

Only the polymerases actually add DNA nucleotides to the existing strand. 
 
Move to pages 3.1 – 3.3. 

4. Students are to read the information on pages 3.1 and 3.2 about 
Okazaki fragments. On page 3.3, students will see a strand of 
DNA. In this simulation, students drag the circle along each 
segment on the left side of the page slowly. This simulation will 
show how Okazaki fragments are built and then joined. 
Encourage students to pause the dragging of the circle to read 
the information about DNA replication that appears.  

 

 

Tech Tip: The simulation can be ‘reset’ by running backwards. If 

students move the sliders backwards, they may not see the same 
labels, so the simulation should be run forwards to avoid confusion.  

Have students answer questions 11–14 on the device, the activity sheet, or both. 

Q11. Replication of the leading and lagging strands requires different enzymes. 
 

Answer: Disagree 

The same set of enzymes is used in both. Primase, polymerase I and ligase are much more active 
on the lagging strand. 
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Q12. What order best describes the order that these enzymes will act during normal replication? 
 

Answer: D. Primase, Polymerase III, Polymerase I, Ligase 

Students may want to revisit page 2.3 to answer this question. Primase adds and RNA primer, so 
polymerase III can work. The RNA primer is removed and filled in by polymerase I, and ligase 
closes the remaining gap (at the 3’ end). 
 

Q13. How is replication of the leading and lagging strands different? 
 

Answer: There is one primer at the start of the leading strand, but this strand can replicate without 
additional primers. The laggings strand replicates in fragments and therefore needs several 
primers. 

 
Q14. Why are there no Okazaki fragments on the leading strand? 
 

Sample Answers: Unwinds the same direction as replication 

 
 

  TI-Nspire Navigator Opportunities 
Choose a student to be a Live Presenter to demonstrate how to negotiate the simulations. The questions 
in the activity may be distributed as Quick Polls or used as a formative or summative assessment 
 

 
 
Wrap Up 
When students are finished with the activity, retrieve the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. 
 
Assessment 

• Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved. The Slide Show will be utilized to give students immediate 
feedback on their assessment. 
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Open the TI-Nspire document Transcription_Translation.tns. 
 
DNA is the blueprint of life, but how does a long piece of DNA control 
the activity of a cell? DNA is transcribed into RNA, which can be 
translated into the proteins that drive the activity in a cell.   
This is the Central Dogma of biology: 

DNA → RNA → Protein 
In this lesson, you will explore transcription and translation. 

 

Part 1: The Central Dogma 

Move to pages 1.3–1.4. 
1. Read the information about the Central Dogma on page 1.3, and 

then move to page 1.4 to explore the different parts of the Central 
Dogma. Look at the image and select different parts to open an 
information box about them. Tap the  to close the box.  

 

 

Tech Tip: To access the Directions again, select b or 
Document Tools ( ) > Transcription and Translation > Directions. 

Tech Tip:  To access the Directions again, select > Directions. 

Move to pages 1.5–1.7. Answer questions 1-3 here and/or in the .tns file. 
Q1. Where does transcription happen? 
 

A. nucleus 
B. cytoplasm 
C. mitochondria 
D. cell membrane 
 

Q2. Which statement is correct?  
 

A. DNA is translated into protein. 
B. RNA is translated in protein. 
C. DNA is translated in RNA. 
D. Protein is translated in RNA. 
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Q3. Which enzyme(s) is/are used in transcription and translation? (Select all that apply.) 
 

A. DNA 
B. polymerase 
C. phosphatase 
D. ribosome 
 

Part 2: DNA and RNA- Two Nucleic Acids 
Move to pages 2.1–2.2. 
2. Read the information about DNA and RNA on page 2.1. Then 

move to page 2.2 to explore characteristics of DNA and RNA. 
Select the right arrow to view the similarities and differences. 

 
Move to pages 2.3–2.4. Answer questions 4-5 here and/or in the .tns file. 
 
Q4. State one difference between DNA and RNA. 
 
 
 
Q5. What do RNA and DNA have in common? 
 

 
 
Part 3: Transcription 
Move to pages 3.1–3.3. 
3. Read the information about the process of transcription on 

pages 3.1 and 3.2. Then move to page 3.3 to simulate 
transcription of a DNA strand. Follow the directions on the 
screen, grabbing the indicated slider. 

 
Move to pages 3.4–3.5. Answer questions 6-7 here and/or in the .tns file. 

 
Q6. What is the product of transcription? 

 
A. polymerase 
B. protein 
C. new DNA 
D.   new RNA 
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Q7. What is one purpose of transcription? 
 

 
Part 4: Translation 
Move to pages 4.1–4.3. 
4. Read the information about translation on pages 4.1 and 4.2. 

Then move to page 4.3 to explore the sequential components of 
translation. Look at the image and select different parts to open 
an information box about them. Select  the  to close the box.  

 

Move to pages 4.4–4.7. Answer questions 8-11 here and/or in the .tns file. 

Q8. Which type(s) of RNA is/are essential for translation? (Select all that apply.) 

A. rRNA 
B. tRNA 
C. mRNA 
D. DNA 
 

Q9. What does the ribosome do?  (Select all that apply.) 

A. translate mRNA to protein 
B. transcribe mRNA from DNA 
C. match tRNA anti-codons to mRNA codons 
D. match amino acids in proteins to mRNA codons 

 
Q10. What is the product of translation?  

 
 
Q11. Based on what you know about the Central Dogma, which molecule will be affected by a mutation 

in DNA? 
 
 

Part 5: Translation Game 
Move to pages 5.1–5.2. 
5. Read the additional information about the process of 

translation on page 5.1. Then move to page 5.2 to play the 
translation game. Select the up and down arrows to choose 
a tRNA to match the mRNA codon in the ribosome. Then 
drag the tRNA to the ribosome. Select the Reset button  
to go back to the beginning of the game.  
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Science Objectives  
• Students will understand what the Central Dogma of Biology 

entails. 
• Students will identify the locations and outcomes of transcription 

and translation in eukaryotes. 
• Students will describe the key cellular machinery used in 

transcription and translation. 
 

Vocabulary 
• DNA • RNA 
• protein • enzyme 
• nucleus • transcription 
• translation • ribosome 
• polymerase • nucleic acid 
• amino acid • codon 
• anti-Codon  
 
About the Lesson 
• Using simulations and models, students will interact with both the 

transcription and translation machinery. Assessments are 
embedded in the activity to engage discussion and gauge 
learning. 

• As a result, students will: 
• Learn the components involved in transcription of RNA, 

including DNA and RNA polymerase. 
• Be introduced to three types of RNA and their functions: 

mRNA, rRNA, and tRNA. 
• Learn the components involved in translation, including the 

ribosome and amino acids. 
 

TI-Nspire™ Navigator™ 
• Send out the Transcription_and_Translation.tns file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
 
Activity Materials 

• Compatible TI Technologies:  TI-Nspire™ CX Handhelds,  

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software  

 
 
Tech Tips:  
• This activity includes class 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other 
technologiesbesides the 
handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.  

• Access free tutorials at 
http://education.ti.com/ 
calculators/pd/US/Online-
Learning/Tutorials 

 
Lesson Files: 
Student Activity 
• Transciption_and_ 

Translation_Student.doc 
• Transcription_and_ 

Translation_Student.pdf 

TI-Nspire document  
• Transcription_and_ 

Translation.tns 
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Discussion Points and Possible Answers 
Allow students to read the background information on pages 1.2 and 1.3 of the .tns file. 
 
Part 1: The Central Dogma 
Move to pages 1.3 – 1.4. 

 
1. Students are to read the information about the Central Dogma on 

page 1.3. Then they will move to page 1.4 to explore the different 
stages of the Central Dogma. As they explore the image, they 
can tap on different parts of it to open information boxes. They 
can tap  to close the box. Be sure that they have visited all five 
information boxed before they move on.  

 

 

Tech Tip: To access the Directions again, select b or 
Document Tools ( ) > Transcription and Translation > Directions. 

Tech Tip:  To access the Directions again, select > Directions. 
Move to pages 1.5 – 1.7. 
Have students answer questions 1-3 on the device, the activity sheet, or both. 
 
Q1. Where does transcription happen? 
 

Answer: A. nucleus 
 
DNA is stored in the nucleus, and never leaves this organelle. 

 
Q2. Which statement is correct? 
 

Answer: B. RNA is translated into protein. 
 
Be careful to use transcription and translation properly. DNA and RNA are the same code- so the 
language of DNA is transcribed into RNA. This must be translated into the new language of amino 
acids. 

 
Q3. Which enzyme(s) is/are used in transcription and translation? (Select all that apply.) 
 

Answers: B. polymerase and D. ribosome 
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The polymerase transcribes RNA, and the ribosome (a ribozyme made of catalytic RNA) translated 
mRNA. 
 

Part 2: DNA and RNA – Two Nucleic Acids 
Move to pages 2.1 – 2.2. 
2. Have students read the information about DNA and RNA on 

page 2.1. Then they can move to the simulation on page 2.2 to 
explore characteristics of DNA and RNA. Tapping the right arrow 
¢, students will see the similarities and differences. There are 
three categories of characteristics; bases, shape, and types. 

 
 

Move to pages 2.3 – 2.4.  
Have students answer questions 4-5 on the device, the activity sheet, or both. 
 
Q4. State one difference between DNA and RNA. 
 

Sample Answer: shape (double helix or single strand); bases (U and T); types (one or three) 
 
Q5. What do RNA and DNA have in common? 

 
Sample Answers: both are nucleic acids; both use the bases A, C and G; both have a phosphate 
backbone 

 
Part 3: Transcription 
Move to pages 3.1 – 3.3. 
3. Have students read the information about the process of 

transcription on pages 3.1 and 3.2. Then they are to move to 
page 3.3 to simulate transcription of a DNA strand. Students 
should follow the directions on the screen, grabbing the indicated 
slider. Be sure that they only move the slider indicated and that 
they release the slider at the end. 

 

 

Move to pages 3.4 – 3.5.  
Have students answer questions 6-7 on the device, the activity sheet, or both. 

 
Q6. What is the product of transcription? 

 
Answers: D. new RNA 
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Transcription creates new RNA based on a sequence of DNA (often a gene). 
 
Q7. What is one purpose of transcription? 

 
Sample Answer: make new RNA for ribosomes, new messages to create new protein 
 
The key machine to create proteins is the ribosome, cells can use many ribosomes to make more 
protein (including during cell division). 

 
Part 4: Translation 
Move to pages 4.1 – 4.3. 
4. Have students read the information about the translation on 

pages 4.1 and 4.2. Then they are to move to the simulation on 
page 4.3 to explore the components of translation.  

 

As they explore the image, students select different parts and an information box will appear. Be sure 
that they have visited all seven information boxes before they move on. 

 
Move to pages 4.4 – 4.7.  
Have students answer questions 8-11 on the device, the activity sheet, or both. 
 
Q8. Which type(s) of RNA is/are essential for translation? (Select all that apply.) 
 

Answers: A. rRNA, B. tRNA, C. mRNA 
 
All three types of RNA play an important role in translation, not just the message being translated. 
 

Q9. What does the ribosome do? (Select all that apply.) 
 

Answers: A. translate mRNA into protein, C. match tRNA anti-codons to mRNA codons 
 
The ribosome is a large machine that performs many important functions, including quality control 
of tRNAs and building protein from amino acids. 
 

Q10. What is the product of translation?  
 

Sample Answers: new protein  
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Q11. Based on what you know about the Central Dogma, which molecule will be affected by a mutation 
in DNA? 

 
Sample Answers: RNA, and if applicable, protein as well 
 
This is how mutations in DNA can lead to diseases, the mutations is incorporated into other 
molecules as well. 
 

Part 5: Translation Game 
Move to pages 5.1 – 5.2. 
5. Have students read the additional information about the process 

of translation on page 5.1. Then they can move to page 5.2 to 
play the translation game. Students are to select the up and down 
arrows in the top right corner of the screen to choose a tRNA to 
match the mRNA codon in the ribosome. Then they should grab   
and drag the tRNA to the ribosome. When they release it, either the ribosome will move to the codon 
or the tRNA will be rejected. Students can select the Reset button  in the top left corner to go 

back to the beginning of the game. 
 
You may want to remind students that while DNA pairs A to T and G to C, RNA will pair A to U (or U 
to A), and G to C. 

 

  TI-Nspire Navigator Opportunities 
Choose a student to be a Live Presenter to demonstrate how to negotiate each simulation. The questions 
in the activity may be distributed as Quick Polls or used as a formative or summative assessment 
 

 
 
Wrap Up 
When students are finished with the activity, retrieve the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. 
 
Assessment 

• Formative assessment will consist of questions embedded in the .tns file. The questions will be 
graded when the .tns file is retrieved. The Slide Show will be utilized to give students immediate 
feedback on their assessment. 
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Activity Overview 
You’re standing in the batter’s box waiting for the pitch from a guy who throws a fastball at 95 
miles per hour. The pitcher’s mound is 60’6” from home plate. In the time it takes for the ball to 
get from the pitcher’s hand to the plate, you must decide whether to swing the bat, where to 
swing the bat, or whether you need to dive out of the way to avoid getting hit by the ball! How 
long do you think you have to make those decisions? You’ll figure that out later in this activity. 
Until then, you will determine your own reaction time using a meter stick and a CBR 2. 

 
Materials 

• TI-Nspire™ CX handheld 
• CBR 2™ with USB cable to connect to the TI-Nspire CX handheld 
• Large paper plate and thumbtack 

 

Procedure 
1. Work in groups of three. 
2. Use a thumbtack to attach a paper plate to one end of a meter stick. 
3. Turn on the TI-Nspire handheld. Connect the CBR 2 to the TI-Nspire using the black linking cord. At 

this point, the TI-Nspire should auto-ID the CBR 2.  
4. Reset the data collection parameters to 50 samples per second for a total of 3 seconds of data 

collection time (151 total samples). You are now ready to collect data! There are three roles: stick 
dropper, stick catcher and TI-Nspire operator. You will rotate through all three roles so that you do 
each. 

5. Place the CBR 2 on the floor. Have one partner hold the meter stick so that the plate is about a meter 
from the CBR 2, and make sure the plate is centered over the CBR 2. 

6. The TI-Nspire operator should click the START/PLAY arrow when ready to start collecting data. The 
stick dropper will listen for the start of the data collection (tick, tick, tick……) and then drop the stick. 
The stick-catcher should watch the stick and catch it as quickly as possible after it starts to fall. 
Remember that the CBR 2 will collect data for 3 seconds, so the releaser can slightly vary the release 
time from trial to trial. Don’t let your partner know when you will drop the meter stick! 

7. When data collection is finished, two graphs will appear. You are only interested in the top graph 
(distance/time), so you can select Menu > Graph > Show Graph > Graph 1.  

8. Check out what is plotted on each axis. Now stop and think about the goal of this activity. Think about 
the way that the graph tells you how to determine reaction time……. 

9. Press the right arrow key until the cursor is as the point just before the graph starts “dropping”. The 
x-value (“time”) at the bottom of the screen represents the starting time you will record in the data 
table. Continue to press the right arrow until the graph levels off again. Record this x-value in the 
data table as well. Subtract the two numbers to determine the reaction time for that trial. 

10. To run subsequent trials, simply click the START arrow again. 
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11. After each person has had 10 trials, calculate the average reaction time from the 10 trials for each 
person and record that average in the data table. 

 
Student #1 Student #2 Student #3 

Trial Start 
Time 

End 
Time 

Reaction 
Time 

Start 
Time 

End 
Time 

Reaction 
Time 

Start 
Time 

End 
Time 

Reaction 
Time 

1          
2          
3          
4          
5          
6          
7          
8          
9          

10          
Avg.          

 
 
Analysis 
1. What is the range of values where the middle 50% of your data is located? 

2. Discuss the shape of the box part of your graph and what this shape will tell you about the average 
reaction time of the class. 

3. Where is your median line? 

4. What does it tell you about this data in the middle of your data set? 

5. How many of your classmates were in the 1st, 2nd, and 3rd quartiles? 

6. How many classmates were between the 1st and 3rd quartile? 

7. What are the shortest and longest average reaction times for the class? 

8. If you have a whisker that is longer, explain what this means about the reaction times for the class? 

9. What would happen to your box-and-whisker plot if someone had a reaction time of 0.58 second? 
How would this change the box-and-whisker plot? 

10. Look back at the data for your 10 trials. Is there a trend in the data? Did you get faster from one trial 
to the next? Did you get slower? Explain what may have caused the variation. 

11. Compare your average reaction time from the 10 trials to the box-and-whisker plot. Where does your 
reaction time fit on that plot? 
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12. Use the following equation to determine how far the meter stick fell before you were able to catch it. 
Use your average reaction time in your calculation. 

d = (½)gt2 

In this equation, d represents the distance the meter stick fell, g represents the pull of gravity on a 
falling object (9.8 meters/second2), and t represents the time it took the meter stick to fall. So, the only 
number you need to calculate is how far the meter stick fell (d). Now, calculate that distance using 
your average reaction time.  

13. Distance the meter stick fell in meters_________________m. 

14. Distance the meter stick fell in centimeters_____________cm. 

15. Distance the meter stick fell in millimeters_____________mm. 

16. OK, back to the pitch coming at you at 95 miles per hour. If the ball is released 60’ from home plate, 
how much time do you have to make your decision where, when, and if to swing? How about if a ball 
is coming at you at 72 miles per hour?  

Hint: distance = rate x time. 

17. Just a small amount of alcohol in your bloodstream can slow your reaction time by as much as 30%. 
Using this information, describe some dangers of alcohol use as they relate to your life’s activities. 

18. Describe everything that took place in your body in order for you to catch the meter stick. 
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Open the TI-Nspire document Traveling_Blue_Genes.tns. 

In this simulation, you will observe DNA gel electrophoresis in action. 
Then you will adjust several factors that affect the process of gel 
electrophoresis and observe the impact they have on the process. 

 

 
James Watson and Francis Crick figured out the structure of the DNA (deoxyribonucleic acid) molecule in 
the early 1950’s. Watson and Crick probably had no idea that the term “double helix” would be so often 
used in classrooms and in conversations everywhere. 
 
The DNA from every organism is composed of the same basic parts and assembled in the same way. 
Looking like a twisted ladder, the outside supports, or backbone, of the DNA molecule consist of 
phosphate groups and deoxyribose sugar. The rungs of the DNA ladder are composed of pairs of the 
nitrogenous bases, adenine (A), thymine (T), guanine (G), and cytosine (C). Because phosphate 
groups on the backbone are negatively charged, they are attracted to anything that is positively charged. 
The process of DNA Gel Electrophoresis relies on this chemical property of phosphate. DNA from the 
cells of organisms can be “cut up” with special molecules called restriction enzymes. Then these 
differently-sized DNA fragments can be “pulled” through a gel, which is made of agarose and feels like 
gelatin, by running an electrical current through it. Small fragments of DNA move through the gel faster 
and further than larger fragments. When these fragments of DNA are stained with a dye, they appear as 
bands embedded within the gel. The distances of the bands from an original starting point can be used to 
calculate the size of the DNA fragments. 
 
Move to pages 1.2-1.5.  
On page 1.2–1.4, you will find instructions for using the simulation and analysis on 1.5. They are also 
included below. Read these before you move ahead. 
 
Directions:  

1. Use the up and down arrows to set the simulation voltage and 
agar concentration.  

2. Select the Play button  to begin the gel electrophoresis 

simulation. Select the Pause button  to stop when 
fragments are close to the end, or right side, of the gel.  
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3. Move the cursor over the fragment until the cursor changes into a cross hair . Then select the 
fragment once to measure the migration distance and fragment weight and add them to the 
spreadsheet. This data is automatically entered into the List & Spreadsheet on page 1.14. 

4. Continue to measure all ladder fragments and the two unknowns. 
5. Graphically analyze the data using a best-fit equation on page 1.16.  

6. Select the Reset button  to run the simulation again on page 1.6.  
7. Select Erase Measurements from the simulation menu to clear the data. 

 
Move to page 1.5.  
Here you will see a “gel” setup with electrodes (the black and red 
objects at bottom left and top right) indicating the direction of the 
electrical current and four “wells” with a different sample of DNA 
indicated. Much like a Jell-o mold, a gel is poured while hot into a 
box, and a comb is placed in it. Once the gel sets, the comb is 
removed, leaving wells to put different DNA samples in. In the gel, 
there are two samples of known size, Lambda Phage DNA cut with 
the restriction enzymes, EcoRI and HindIII. These are both common 
controls for this type of experiment. The other wells contain two 
unknown samples of DNA. You will be determining the size of the 
unknown DNA. 
 
Move to page 1.6.  
Here you can simulate running a gel and observing how the DNA 
samples separate. Follow the instructions provided to run the gel and 
measure the known and unknown band sizes. The blue boxes on the 
left are the wells and the pink bands are DNA. 
 
1. Follow the directions given above to run the gel and watch how 

the bands progress. 
2. Using the mouse to move the cursor, select each band to 

measure the distance traveled. This data is captured in the 
spreadsheet on page 1.14. 

3. You may want to repeat the simulation by adjusting the voltage of 
the current running through the gel and adjusting the density of 
the gel, or Agarose, before answering the following questions. 

 

 
 

 

 

 

 

 

Tech tip: The cursor will change to a cross  when you are in 
the correct spot to take the measurement of the band. 
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Tech Tip:  To take a measurement of a band, tap the band as it 
moves across the screen. 

 
Move to pages 1.7-1.13. 
Answer questions 1-7 here and in the tns file. 
 
Q1. The DNA moves 

A. as a result of diffusion. 
B. due to the charge on the molecule 
C. because the gel is tilted downward. 
D. as a result of a temperature difference across the gel. 

 

Q2. True or False: Increasing the voltage across the gel causes the DNA to migrate slower. 
 
Q3. True or False: Increasing the agar concentration in the gel causes the DNA to migrate slower.  
 
Q4. True or False: Reversing the voltage causes the DNA to migrate the opposite direction.  
 
Q5. True or False: The longer the gel runs the further the DNA migrates. 
 
Q6. If the gel runs too long, the DNA... 

A. collects at the end of the gel. 
B. runs off the end of the gel. 
C. stays in the same position. 
D. evaporates. 

 
Q7. True or False: The purpose of a DNA ladder is to have a standard between migration and 

fragment size. 
 
Move to page 1.14. 
4.   Here you will see that the known bands have two numbers, 

migration distance (which you just measured) and number of 
base pairs. The size of DNA is measured in “base pairs” (bp). 
One bp is one “rung” on the DNA ladder: either a T-A pair or a G-
C pair. 
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Move to pages 1.15-1.16. 
4. Read the directions on page 1.15. On page 1.16, you will see a 

Data & Statistics page that will allow you to view a graph showing 
the relationship between the size of each fragment of DNA and its 
migration distance.  

5. Page 1.17 is a similar graph showing the HindIII migration and 
size. Observe the similarities and differences in these two graphs. 
Follow the directions on page 1.15 to fit a regression to this data. 

 

6. Sketch your graph to the right and draw in a non-linear, best-fit 
model that fits the data. Your teacher will ask you to make 
predictions about migration distances of unknown fragment sizes 
and predictions about sizes of fragments that migrate certain 
distances.  

 

Sketch of Graph 

Move to pages 1.17-1.18. 

Answer questions 8-9 on this worksheet and in the .tns file. Answer questions 10-16 on this worksheet.  

Q8. Based on the graphical analysis of the data, the DNA fragment size of unknown 1 is approximately: 
A. 6,000 bp 
B. 8,000 bp 
C. 10,000 bp 
D. 12,000 bp 
 

Q9. If the two unknowns are the same gene harvested from two different individuals... 
A. both have the same genotype. 
B. unknown 1 is homozygous and unknown 2 is heterozygous. 
C. unknown 2 is homozygous and unknown 1 is heterozygous. 
D. not enough information to determine. 

 
Q10. What is a restriction enzyme? 
 
 
Q11. What is the relationship between DNA fragment size and migration distance? 
 
 
Q12. What is meant by a “base pair”? 
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Q13. What is the relationship between the amount of time that a gel runs and the migration distance of 
the DNA fragments? 

 
 
Q14. Describe the effect of gel density on the movement of DNA fragments through the gel. 
 
 
Q15. If you want to run a DNA gel electrophoresis experiment with only a short time available, what 

general parameters would ensure the best results? 
 
 
Q16. If you want to run a gel from the time you leave class until the start of class the next day, what 

general parameters would ensure the best results? 
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Science Objectives 
• Students will observe a time-lapse simulation of the process of 

DNA Gel Electrophoresis. 
• Students will electronically measure the results of gel 

electrophoresis and then graph, and analyze these results. 
• Students will discover the effects of time, voltage, and agarose 

gel density on the results of gel electrophoresis. 
 
Vocabulary 
• adenine • double helix 

• thymine • interpolation 

• guanine • extrapolation 

• cytosine • nucleotide 

• agarose • phosphate 

• base pair • deoxyribose 

• NA gel electrophoresis • restriction enzymes 

 
About the Lesson 
• This lesson involves students using TI-Nspire technology to 

simulate, observe, and manipulate the variables that affect the 
results of DNA gel electrophoresis. 

• As a result, students will: 
• Reinforce understanding of the structure of DNA; 
• Understand the process of gel electrophoresis; 
• Recognize the effects of time, gel density, and voltage on the 

outcome of gel electrophoresis. 
 

TI-Nspire™ Navigator™ 
• Send out the Traveling_Blue_Genes.tns file. 
• Monitor student progress using Class Capture. 
• Use Live Presenter to spotlight student answers. 
 
Activity Materials 

• Compatible TI Technologies:  TI-Nspire™ CX Handhelds,  

 TI-Nspire™ Apps for iPad®,  TI-Nspire™ Software 

 
 
Tech Tips:  
• This activity includes class 

captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld. 

• Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.  

• Access free tutorials at 
http://education.ti.com/ 
calculators/pd/US/Online-
Learning/Tutorials 

 
Lesson Files: 
Student Activity 
• Traveling_Blue_Genes 

_Student.doc 
• Traveling_Blue_Genes 

_Student.pdf 
 

TI-Nspire document  
• Traveling_Blue_Genes.tns 
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Discussion Points and Possible Answers 
Have students read the background information on their student activity sheet. 
 
Move to pages 1.2- 1.5. 
1. Have students read the directions for running and measuring the 
bands on a gel. The restriction enzymes EcoRI (pronounced ‘eco R 
1’, which is short for E. coli restriction enzyme 1) and HindII (‘hin D 3,’ 
which comes from H. influenza) were first used to “cut” up some viral 
DNA. (Phage are viruses that infect bacteria). Bacteria cause these 
enzymes to defend against foreign DNA from viruses by cutting DNA 
with unique sequences. Then, this “cut up” DNA is placed into the 
wells next to two unknowns and an electrical current is applied.  
 
Restriction enzymes are used to cut DNA into a size that can run 
through a gel. A full chromosome is millions of base pairs long and 
would be very difficult to assess by electrophoresis. 
 
The unknowns are human samples being tested for some genotype. 
They are compared to Lambda phage DNA, a virus that infects E.coli 
(known as a phage), and they are cut into predictable band sizes 
which can be used as a control, or a ladder, for this type of 
experiment. 
 

 
 

 

 

Move to page 1.6. 
2.   Students should follow the directions to run the simulation and 

measure the size of each band, which will be recorded to the 
spreadsheet on page 1.14. 

3.   The fragments—shown as the pink bands—migrate different 
distances based on their size. Smaller fragments move further 
because it is easier for them to get “pulled” through the gel toward 
the positive electrode (shown in red, at top right of gel). 

 

 

Tech Tip: The cursor will change to a cross  when you are in 
the correct spot to take the measurement of the band. 

Tech Tip:  To take a measurement of a band, tap the band as it 
moves across the screen. 

166



 Traveling Blue Genes  TEACHER NOTES 

SCIENCE NSPIRED   
 

©2014 Texas Instruments Incorporated 3 education.ti.com 

Move to pages 1.7-1.13. Have students answer questions 1-7 below and/or in their .tns files. 
 
Q1. The DNA moves 
 

Answer: B. due to the charge on the molecule. 
 
Q2. True or False: Increasing the voltage across the gel causes the DNA to migrate slower. 
 

Answer: false 
 
Q3. True or False: Increasing the agar concentration in the gel causes the DNA to migrate slower.  

 
Answer: true 

 
Q4. True or False: Reversing the voltage causes the DNA to migrate the opposite direction.  
 

Answer: true 
 
Q5. True or False: The longer the gel runs the further the DNA migrates. 

 
Answer: true 

 
Q6. If the gel runs too long, the DNA... 
 

Answer: B. runs off the end of the gel 
 
Q7. True or False: The purpose of a DNA ladder is to have a standard between migration and 

fragment size. 
 

Answer: true 
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Move to page 1.14. 
4. After measuring all the bands, the distances will appear in each 
labeled column, including the known sizes of the digested phage 
DNA. 

 
 

Move to pages 1.15-1.17.  
4. Have students read the directions on page 1.1.5. When they 

move to pages 1.16 and 1.17, the students will see a graph of the 
distance vs. the size of DNA, measured in base pairs.  

5. They should be encouraged to explore the best line of fit to 
describe these data. On each page, use Window/Zoom > Zoom-
Data to scale the graph. Next, use  Analyze > Regression and 
try different regression equations to find the best-fit. Lastly, use 
Analyze > Graph Trace to find the fragment size associated with 
the migration of the unknowns. 

  

 

6. At this point, students are asked to sketch the graph on their 
activity sheet. You may also require them to draw in a non-linear 
best-fit model for the data. From this, you can ask students to 
predict how far other fragments would have moved. Use both 
interpolation and extrapolation for the other fragments. The line of 
best fit of the data should look similar to the graph above for 
EcoR1 band migration. 

 
 

Move to pages 1.18-1.19. Open response questions 10-16 should be answered on Student Activity 
worksheet. 
 
Q8. Based on the graphical analysis of the data, the DNA fragment size of unknown 1 is approximately: 

 
Answer: C. 10,000 bp 

 
 
Q9. If the two unknowns are the same gene harvested from two different individuals... 

 
Answer: B. unknown 1 is homozygous and unknown 2 is heterozygous. 
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Q10. What is a restriction enzyme? 
 

Answer: A molecule that “cuts” DNA at specific “base sequences”. Many species of bacteria 
produce restriction enzymes so that invading DNA, normally from viruses, can be “cut” and 
rendered harmless. 
 

Q11. What is the relationship between DNA fragment size and migration distance? 
 

Answer: The smaller the fragment size, the further it can move from the well, and the larger the 
fragment size, the shorter it can move from the well. 

 
Q12. What is meant by a “base pair”? 
 

Answer: It is a pair of nucleotides (either an adenine-thymine (A-T) pair or a cytosine-guanine  
(C-G) pair) that makes up one “rung” of the DNA double helix. 

 
Q13. What is the relationship between the amount of time that a gel runs and the migration distance of 

the DNA fragments? 
 

Answer: If the gel density and voltage remain constant, then the longer the time, the further the 
fragments move. 

 
Q14. Describe the effect of gel density on the movement of DNA fragments through the gel. 
 

Answer: The denser the gel is, the slower the DNA fragments move. The less dense, the faster 
they move. 

 
Q15. If you want to run a DNA gel electrophoresis experiment with only a short time available, what 

general parameters would ensure the best results? 
 

Answer: Less dense gel and a high voltage. 
 
Q16. If you want to run a gel from the time you leave class until the start of class the next day, what 

general parameters would ensure the best results? 
 

Answer: Dense gel and low voltage. 
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  TI-Nspire Navigator Opportunities 
Allow students to volunteer to be the Live Presenter and demonstrate how to adjust the parameters of 
time, gel density and voltage. Use Quick Poll to check for understanding during the course of the activity. 
 

 
Wrap Up 
When students are finished with the activity, pull back the .tns file using TI-Nspire Navigator. Save 
grades to Portfolio. Discuss activity questions using Slide Show. Additionally, completed Student 
Activity sheets may be collected.   
 
Assessment 

• Analysis questions are written into the student worksheet. 
• Formative assessment will consist of questions embedded in the .tns file. The questions will be 

graded when the .tns file is retrieved. The Slide Show will be utilized to give students immediate 
feedback on their assessment. 

• Summative assessment will consist of questions/problems on the chapter test. 
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Open the TI-Nspire™ document Grow_Up.tns. 

Because we are humans, we tend to believe that we are “the 
norm” in every way. It’s only natural for us to use ourselves as the 
model animal because we’ve never been anything BUT human!  

  

Actually, however, most animals are not all that much like us. The vast majority of animals 
on the planet are insects. Get this: There are about 1.5 TRILLION insects for each person 
alive on Earth! The total number of insects is estimated to be about 1019! Thankfully for us, 
most insects are really, really small and they don’t live very long. Some live for just a few 
hours; long enough to reproduce, then they die. So maybe we DO have it better than bugs! 
 
In this activity, you’ll take a look at the lifespans and growth rates of several familiar 
animals. Animals that are more like you than an ant or a grasshopper. 

 
Move to page 1.2. 
 
1. Start working your way through the document, and answer the questions on pages 1.4 through 1.7. 
2. Examine the bar graph on page 1.9 and then answer the questions on pages 1.10 through 1.12. 
3. Examine the graph on page 1.13 and then answer the question on page 1.14. 
4. Examine the graphs on pages 1.15 and 1.16. Then answer the questions on pages 1.18 through 1.23. 

 
Questions 

Q1. From the bar graph on page 1.3 showing the lifespans of various 
animals, estimate the approximate lifespan of a human. 

Q2. Estimate the lifespan of a sheep. 

Q3. Which animal has a lifespan of about 7 years? 

Q4. Look at the animals included in the graph. Give it some thought 
and name one thing that all of the animals have in common. 

 

Q5. Based on the bar graph on the previous page, which animal has 
the fastest growth rate? 

Q6. In general, the _____ the animal is, the _____ its growth rate. 
(Select all that are true.) 

A. Larger; faster                   B. Larger, slower 
C. Smaller; slower                D. Smaller, faster  
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Q7. Describe what is shown by the graph on page 1.13. 
 

 
Q8. In the graph on page 1.16, what is represented by the yellow 

bars? 

A. The type of animal 
B. Growth rate 
C. Life span 

 

 
Q9. In the graph, what is represented by the blue bars? 

A. The type of animal 
B. Growth rate 
C. Life span 

 

 

Q10. Which of the following adds new body cells to an animal? 
A. Mitosis 
B. Meiosis 

 
Q11. Which animal in this activity do you think has the fastest rate of cell division? 
 

Q12. Based on the information in this activity, which animal would you predict would take the longest to 
reach an age when it can reproduce? 

A. Mouse 
B. Dog 
C. Human 

Q13. Which words to you think would most accurately complete this 
statement: The _____ the lifespan, the _____ babies the animal 
has. (Select all that are true.) 

A. Longer; more 
B. Longer; fewer 
C. Short; more 
D. Short; fewer 
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Science Objectives 
• Students will draw conclusions about the relationship between 

the lifespan and the growth rate of various animals. 
• Students will make a connection between growth rate and the 

rate of mitosis. 
• Students will evaluate various types of graphs. 
 
Vocabulary 
• growth rate 

• lifespan 

• bar graph                                     

• mitosis 

• meiosis 
 
About the Lesson 
• This lesson has students working their way through a TI-Nspire™ 

document dealing with the relationship between the lifespan and 
the growth rate of several warm-blooded (endothermic) animals. 

• Different types of bar graphs are used to show this relationship. 
A scatterplot is also used. 

 
TI-Nspire™ Navigator™ 
• Monitor student progress using Class Capture. 
• Use Live Presenter to allow students to show how they are 

analyzing the graphs in the document. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
TI-Nspire™ Technology Skills: 
• Open a document 
• Move between pages 
• Answer questions embedded 

in a document 
 

Tech Tips: 
• Students can move between 

pages by clicking / ¢ and 
/ ¡. 

 
Lesson Files: 
Student Activity 
• Grow_Up_Student.doc 
• Grow_Up_Student.pdf 
TI-Nspire document 
• Grow_Up.tns 
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Discussion Points and Possible Answers 

Have students answer all questions on their activity sheet. 

 
Questions 

Q1. From the bar graph on page 1.3 showing the lifespans of various 
animals, estimate the approximate lifespan of a human. 

 
Sample answer: 73 years 
 

Q2. Estimate the lifespan of a sheep. 
 

Sample answer: 14 years 
 

Q3. Which animal has a lifespan of about 7 years? 
 

Answer: Chicken 

 
Q4. Look at the animals included in the graph. Give it some thought 

and name one thing that all of the animals have in common. 
 

Sample answer: They are all warm blooded. 

 

Q5. Based on the bar graph on the previous page, which animal has 
the fastest growth rate? 

 
Answer: Mouse 
 

Q6. In general, the _____ the animal is, the _____ its growth 
rate.(Select all that are true.) 

A. Larger; faster                   B. Larger, slower 
C. Smaller; slower                D. Smaller, faster 

 

Q7. Describe what is shown by the graph on page 1.13. 
 

Answer: The longer the lifespan, the slower the growth rate. 
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Q8. In the graph on page 1.16, what is represented by the yellow 
bars? 

A. The type of animal 
B. Growth rate 
C. Life span 

 

 
Q9. In the graph, what is represented by the blue bars? 

A. The type of animal 
B. Growth rate 
C. Life span 

 

 

Q10. Which of the following adds new body cells to an animal? 
A. Mitosis 
B. Meiosis 

 

Q11. Which animal in this activity do you think has the fastest rate of cell division? 
 

Answer: Mouse 

 
Q12. Based on the information in this activity, which animal would you predict would take the longest to 

reach an age when it can reproduce? 

A. Mouse 
B. Dog 
C. Human 

Q13. Which words to you think would most accurately complete this 
statement: The _____ the lifespan, the _____ babies the animal 
has. (Select all that are true.) 

A. Longer; more 
B. Longer; fewer 
C. Short; more 
D. Short; fewer 

 

TI-Nspire Navigator Opportunities 
Allow students to volunteer to be the Live Presenter.  
Use Quick Poll to check for understanding during the course of the activity. 
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Wrap Up 
When students are finished with the activity, discuss with them the suggested answers to the questions. 
 
Assessment 

• Answers to questions are written into the student worksheet. 
• Use Quick Poll to collect answers to questions given in the student worksheet. 
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Activity Overview 
In this activity you will become familiar with the most commonly used keys on the TI-Nspire™ CX family of 
handhelds. 
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Activity Overview 
In this activity, you will learn how to check the operating system (OS) on a TI-Nspire™ handheld and 
update it using the TI-Nspire™ Teacher Software. 
 
 

Materials 
• TI-Nspire™ or TI-Nspire™ CAS Teacher Software and standard-A to mini-B USB cable 

 
 
 

Viewing Handheld Status 

The Handheld Status screen displays the battery status, (OS) 
version, available space, the network (if any), and your student 
login name and whether you are logged in. 

To view the Handheld Status, press c and select Settings > 
Status. The Handheld Status dialog box opens.  

Note:   The About screen displays the handheld type and product ID. To view the About screen 
from the Handheld Status screen, click About. To return to the home screen, press ·. 

Updating the Handheld OS 

You can update the OS on your TI-Nspire™ handheld using the TI-Nspire™ Teacher Software or by 
transferring the OS from one handheld to another. OS upgrades do not delete user documents. If there is 
not enough room on the receiving handheld for the upgrade, the sending device is notified. The only time 
documents can be affected by an OS installation is if the receiving handheld has a corrupted OS. It is a 
good practice to back up important documents and folders before installing an updated OS. 

Important OS Download Information 

In the TI-Nspire™ family of handhelds, different handheld types require different operating systems: 

• The OS for the TI-NspireTM CX handheld has the file extension .tco. 
• The OS for the TI-NspireTM CX CAS has the file extension .tcc. 
• The OS for the TI-NspireTM with Touchpad or Clickpad has the file extension .tno. 
• The OS for the TI-NspireTM CAS with Touchpad or Clickpad has the file extension .tnc. 

Always make sure the TI-Nspire CX handheld is fully charged before beginning an OS download (or, if 
using the TI-Nspire with Touchpad or Clickpad, install new batteries).  

Finding Operating System Upgrades 

Your TI-Nspire™ Teacher Software has convenient links to a number of useful Texas Instruments web 
sites, including those with handheld OS updates. You will need an Internet connection and the USB 
connection cable to download and install the updates. 
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Using TI-Nspire Teacher Software to Update the Handheld OS 

Open the TI-Nspire Teacher Software and connect a TI-Nspire handheld to the computer using the 
USB connection cable. Go to the Document Workspace, select the Content Explorer tab, and click 
TI-Nspire™ Connected Handhelds. Multiple handhelds can be connected to the computer using 
multiple USB ports, USB hubs, or the TI-NspireTM Docking Station. If multiple handhelds are 
connected to the computer, then multiple handhelds appear in the list of Connected Handhelds. 

The connected handheld appears in the Content Window. Click on the name of the handheld to 
display battery, storage, and OS information. More detailed information appears in the Handheld 
Information window. 

 

To see if a new OS is available, right-click on the row that includes the handheld’s name. Select 
Check for OS Update. If there is a newer version of the OS available, follow the directions to install it. 
A window will inform you that any unsaved data will be lost. If you want to continue, select Yes. 
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Activity Overview 
The Press-to-Test feature enables you to quickly prepare student handhelds for exams by temporarily 
disabling folders, documents, and select features and commands. Steps 1-7 in this activity enables 
Press-to-Test. To disable Press-to-Test, you will need to follow Steps 8-9 using either an additional TI-
Nspire handheld or a computer with the TI-Nspire Teacher Software. 
 
 

Materials 

• TI-Nspire™ handheld-to-handheld or handheld-to-computer USB connection cable  
 
 
 

Step 1: 

To enable Press-to-Test on the TI-Nspire™ with Touchpad and 
TI-Nspire CX™, first ensure that the handheld is turned off. Press 
and hold d and c until the Press-to-Test screen appears. 

Note:   To enable Press-to-Test on TI-Nspire™ with Clickpad, 
press and hold d, c, and w. 

 
Step 2: 

By default, Press-to-Test disables pre-existing Scratchpad data, 
documents, and folders as well as many other functionalities of the 
handheld. The angle settings can be changed by pressing ¢, 
selecting the appropriate setting, and pressing ¢ or ·. 

By default, all of the commands and features listed are disabled. 
To enable a feature or command, uncheck its box. Keep all boxes 
checked, and enter Press-to-Test by clicking Enter Press-to-Test. 

 

 

Step 3: 

Once the handheld is in Press-to-Test mode, the handheld 
reboots. A dialog box confirms that the handheld is in Press-to-
Test mode and the restrictions are listed. Click OK. 

Step 4: 

When in Press-to-Test mode, the LED at the top of the handheld 
begins blinking. Green indicates that all restrictions are selected 
(default), while yellow indicates that one or more restrictions are 
unselected. During the initial reboot, the LED alternates between 
red and, depending on the restrictions, either green or yellow. 
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Step 5: 

Create a new document, add a Geometry page, and press b. 

Since geometry functions are limited, observe that the Measurement, 
Construction, and Transformation menus are not accessible. 

Note: The lock icon at the top of the screen indicates that the 
handheld is in Press-to-Test mode.  

Step 6: 

Add a Calculator application by selecting ~  > Insert > 
Calculator. Type cot(π/2) and press ·. Since trigonometric 

functions are limited, an error message appears. The dialog box 
tells students how to access additional information about the 
restrictions. Click OK. 

 

Step 7: 

Select c > My Documents. While in Press-to-Test mode, a 

Press-to-Test folder appears in My Documents. All other folders 
and documents present on the handheld before Press-to-Test 
mode was entered are inaccessible. 

Step 8: 

To exit Press-to-Test mode, connect two handhelds using the 
handheld-to-handheld USB connection cable. Then select ~ > 

Press-to-Test > Exit Press-to-Test. The Exit Press-to-Test option 
appears regardless of whether the other handheld is in Press-to-
Test mode. 

Press-to-Test can also be exited with the TI-Nspire™ Navigator™ 
Teacher Software. Once a class has been started, students can 
select ~ > Press-to-Test > Exit Press-to-Test. 

 

 

Step 9: 

Press-to-Test can also be exited with TI-Nspire Teacher Software or 
TI-Nspire Navigator Teacher Software by creating a document named 
Exit Test Mode.tns, and transferring it to connected handhelds.  

Note:    The name of the TI-Nspire document must be spelled exactly as it is above. 

Go to the Tools menu and select Transfer Tool. Click Add to Transfer List and select 
Exit Test Mode.tns. In the Edit Destination Folder, enter the name of the folder Press-to-
Test, and click Change. Then, click Start Transfer. 
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Activity Overview 
In this activity, you will learn how to transfer a document from one TI-Nspire™ CX handheld to another. 
 
 
Materials 

• Two TI-Nspire CX handhelds 
• Unit-to-unit connection cable (Mini-A to Mini-B USB) 

 
 

Transferring a Document or a Folder 

Documents can be transferred between two TI-Nspire CX handhelds 
by connecting them with the unit-to-unit mini USB cable. The USB A 
port is located at the top of the handheld on the right side. 

 
Step 1: 

Firmly insert the ends of the mini USB unit-to-unit cable into the 
USB A ports of the handhelds. The handhelds will automatically 
turn on when the cable is plugged in. 

Step 2: 

Open My Documents on the sending handheld. 

Step 3: 

Press the £ and ¤ keys to highlight the document or folder to send. 

 

 

Step 4: 

Press b and select Send. No action is required by the user of 

the receiving TI-Nspire CX handheld. Once the transfer begins, a 
progress bar displays the status of the transfer. When the 
transfer is complete, a message displays on the receiving 
handheld. If the document was renamed on the receiving 
handheld, the new document name appears. 

 

Note:   When sending a folder from one handheld to another, the file structure in the sending folder is 
retained. If the folder does not exist on the receiving handheld, it will be created. If the folder 
does exist, files will be copied into it, with appended names added to any duplicate files. 

Note:   To cancel a transmission in progress, select Cancel in the dialog box of the sending handheld. To 
cancel a transfer from the receiving handheld, press d. The receiving handheld, however, 
cannot cancel a transfer of folders. If an error message appears, press d or · to clear it. 
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Guidelines for Transferring Documents or Folders 

The guidelines for sending an individual document also apply to documents within folders that are sent. 

• If you send a document with the same name as an existing document on the receiving TI-Nspire 
CX handheld, the system renames the sent document by appending a number to the name. For 
example, if you send a document named Mydata to another TI-Nspire handheld that already 
contains a document named Mydata, the document you send will be renamed Mydata(2). Both 
the sending and receiving units display a message that shows the new name. 

• There is a 255-character maximum length for a document name, including the entire path. If a 
transmitted document has the same name as an existing document on the receiving handheld 
and the document names contain 255 characters, then the name of the transmitted document will 
be truncated to allow the software to follow the renaming scheme described in the previous bullet. 

• All variables associated with the document being transmitted are transferred with the document. 

• Transmissions will time out after 30 seconds. 
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Activity Overview 
In this activity, you will use the Documents and Content Workspaces of the TI-Nspire™ Teacher Software 
to transfer TI-Nspire™ documents between the computer and the handheld.  
 
 

Materials 
• TI-Nspire™ or TI-Nspire™ CAS Teacher Software  

• TI-Nspire™ handheld and standard-A to mini-B USB cable 
 
 
 

Transferring Documents in the Documents Workspace 

Step 1: 

Open the Teacher Software. Go to the Documents Workspace 
by clicking the Documents tab. 

 

Step 2: 

Connect a TI-Nspire™ handheld to the computer using the USB 
connection cable. Multiple handhelds can be connected using 
multiple USB ports, USB hubs, or the TI-Nspire™ Docking 
Station. If multiple handhelds are connected, then multiple 
handhelds appear in the Connected Handhelds panel. 

 

Step 3: 

Documents can be transferred between the computer and 
connected handhelds using the Content Explorer in the 
Documents Toolbox. Open the Content Explorer by clicking the 

 Content Explorer tab. 

 

 

Step 4: 

To transfer a TI-Nspire document from the computer to the handheld, locate the document in the 
Computer panel. Click, drag, and drop it into the handheld in the Connected Handhelds panel. 

 
Step 5: 

To transfer a TI-Nspire™ document from the connected handheld to the computer, locate the document 
in the Connected Handhelds panel. Click, drag, and drop it into the desired folder in the Computer panel.   
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Transferring Documents in the Content Workspace 

Step 6: 

Go to the Content Workspace by clicking the Content tab. In the 
Resources panel, select Connected Handhelds. 

 

Step 7: 

The connected handheld appears in the Content window, along 
with battery, storage, and OS information. To view the documents 
on a connected handheld, click the name of the handheld.  

 

 

Step 8: 

Locate a TI-Nspire™ document on your computer by browsing Computer Content in the Resources 
panel. Send the document by dragging and dropping it to the connected handheld. The document can 
also be sent by right-clicking it and selecting  Send to Connected Handhelds.  
 

 
 

Step 9: 

The Transfer Tool window appears with the current 
document. Documents can be added to or removed 
from the transfer list, and the destination folder on the 
handheld(s) can be edited or changed. To send the 
document to the handheld(s), click Start Transfer. 
Once the Status tab indicates that the transfer is 
complete, click Stop Transfer. 
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Activity Overview 
In this activity, you will learn how to use the TI-Nspire™ Teacher Software to insert images into the 
Graphs and Geometry applications. You will also learn how to move, resize, compress, and stretch an 
image, as well as make it appear more transparent.  
 
 

Materials 
• TI-Nspire™ or TI-Nspire™ CAS Teacher Software 

 
 
 

Step 1: 

Open the Teacher Software. If the Welcome Screen appears when the software is opened, 
click  to create a new document with a Graphs application as its first page. Otherwise, 
insert a Graphs application by selecting  Insert >  Graphs. 

Note:    Images can be inserted into Graphs, Geometry, Data & Statistics, Notes, and 
Question applications. 

Step 2: 

Insert an image into the Graphs application by selecting  
Insert >  Image. A selection of images is preloaded in the 
My Documents >TI-Nspire > Images folder. Select Ferris 
Wheel.jpg and click Open. 

Note:    Although the Teacher Software comes with a selection 
of preloaded images, all jpg, jpeg, bmp, and png images 
are supported. The optimal format is .jpeg 560 × 240. 
Larger images may take the document longer to load on 
the handheld. Images appear in grayscale for TI-
Nspire™ handhelds with Touchpads and Clickpads. 

 

 

Step 3: 

Images can be moved, resized, and vertically or horizontally 
stretched or compressed. To select an image in the Graphs, 
Geometry, or Question application, right-click on the image and 
choose Select > Image. To select an image in the Notes 
application, click the image. To move the image, grab and move 
the image. To resize the image, grab and move a corner. To 
vertically stretch or compress the image, grab and move the top 
or bottom edge. To horizontally stretch or compress the image, 
grab and move the left or right edge. 
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Note:    To right-click an object on a handheld, press /b. To grab an object, press 
/x. To let go of an object, press d. 

 

Step 4:  

To make an image appear more transparent, insert the image 
in a Geometry application, and then change the page to a 
Graphs application.  

Select  Insert >  Geometry. Then insert an image by 
selecting  Insert >  Image. Again, choose Ferris 
Wheel.jpg. To change the Geometry application to a Graphs 
application, select View > Graphing. 
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Activity Overview 
In this activity, you will explore resources available at education.ti.com. You will browse for activities at 
Math Nspired or Science Nspired. You will search for activities using the Standards Search and Textbook 
Search, and you will explore additional information regarding professional development. 
 
 

Materials 
• Computer with Internet connection 

 
 
 

Step 1: 

Go to education.ti.com > Activities. Select Math Nspired or Science Nspired, which can also be 
accessed directly at mathnspired.com and sciencenspired.com. Select a subject on the left.  

Step 2: 

Select a unit from the list. When a unit is selected, a table appears with an image from each activity. The 
table contains links to download, recommend, and save each activity. It also identifies each activity type: 
 

Icon Type Description 

 
Bell Ringer 

Bell ringers are short lessons designed to help transition 
quickly into class after the bell rings. 

 

Action Consequence 

 
Simulation 

Interactive, engaging lessons allow students to perform 
actions on a mathematical object or scientific simulation, 
observe consequences, and make conjectures. 

Each lesson contains a pre-made TI-Nspire™ document, a 
Student Activity, and Teacher Notes. 

 
Create Your Own 

In addition to the Student Activity and Teacher Notes, the 
lesson also includes step-by-step instructions on how to 
create the TI-Nspire document. 

 

Data Collection with 
Probes 

Data Collection Labs give students the opportunity to collect 
and analyze real-world data with more than 50 data 
collection sensors from Vernier Software and Technology™. 

 

TI-Nspire™ Navigator™ 
Compatible 

The Teacher Notes identify opportunities to use the  
TI-Nspire Navigator System, including opportunities for 
Quick Polls, Class Captures, and Live Presenter. 
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Step 3: 

Select an activity from the list. The activity page shows objectives, 
relevant vocabulary, and additional information. A video offers a 
preview of the lesson, and related lessons are recommended below. 

Icons above the Downloads section allow you to recommend, save, 
email, and print an activity. Links to Facebook® and Twitter® are 
also available. The Downloads section contains links to activity files. 
Links for Standards Alignment, Textbook Alignment, and relevant 
Tech Tip Videos are also available.  

Step 4: 

Explore the Standards and Textbook Search channels on the left. Select a set of standards or a 
textbook from the drop-down box, select a grade, and click Search. 

 

Step 6: 

Click the Solutions tab and select Common Core State Standards or Science Tools.  Content and 
activities, technology resources, and information on professional development opportunities are provided.  

Step 7: 

Go to Professional Development > Online Learning. 

The Tutorials page contains link to free Atomic LearningSM video 
tutorials. There are video tutorials for the TI-Nspire™ handheld, the 
TI-Nspire™ software, the TI-Nspire™ Navigator™ System, and the 
TI-Nspire™ Apps for iPad®. 

The Upcoming page contains links to upcoming, free PD webinars. 
The On-Demand page contains recordings of past webinars, and 
associated webinar documents are available for download. 

 

 

 

Step 8: 

Explore each of the following pages by clicking the appropriate tab: Products, Downloads, 
Activities, Professional Development, Solutions, Support, and Where to buy. 
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After reading this guide, you will have a wealth of ideas about how you can use the TI-NspireTM to collect 
and analyze data for the experiments in this AP Chemistry lab manual.  
 

Data Collection – Getting Started 
 

1. Decide what sensor(s) is(are) appropriate for your experiment. Most likely you will be using one 
or more of the following sensors in an AP Chemistry experiment: temperature, pH, conductivity, 
voltage, or colorimeter. 

2. Choose the appropriate interface device (EasyTemp™, EasyLink™ cable, TI-Lab Cradle™) and 
attach it to the TI-Nspire™ handheld. 

EasyTemp   EasyLink   TI-Lab Cradle 

     
3. Connect the sensor(s) to the interface device. (When using the Lab Cradle and only one sensor, 

it is best to plug the sensor into Channel 1.) 
4. Launch the DataQuest™ application. (Note: In most cases the DataQuest application will launch 

automatically. If not, from the home screen on the TI-Nspire handheld, select 1 for New 
Document and then choose the DataQuest application from the applications available.) 

Data Collection – How Do I Collect Data? 
 

There are three main methods of data collection: 
1. Use the meter window. 
2. Perform a “Time Based” experiment. 
3. Perform an “Events with Entry” experiment. 

 
Using the Meter Window 
There will be some experiments in which you will need to collect only one sample of data from a chemical 
substance or solution. For example, maybe you need to measure the conductivity of an ionic compound 
in solution. In that case, using the live readout of data in the meter window (shown above) is appropriate. 
 
Performing a “Time-Based” Experiment 
There will be some experiments in which you will want to study a variable over a certain period of time. 
For example, what if you were asked to determine the effect of the amount of water on the rate at which 
an effervescent tablet reacts in water? How would you set up the collection of data for that experiment? 
On the next page, you will learn about the various steps needed to carry out that process. 
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1. Be sure that the mode is set to “Time Based.” (The 
fastest way to change the experiment mode is to 
click on the Mode area on the left side of the screen. 
Choose Time Based. 

 

2. Now set up the parameters of how you will collect data 
in your experiment by clicking on the Rate and 
Duration areas on left. For example, in the 
effervescent tablet experiment, we might want to view 
the temperature changes over a 60-second period. The 
rate could be set to 1 sample/second and the duration 
set to 60 seconds. Click OK when you are finished. 

 

3. To begin the data collection, click the green Start 
Collection  arrow in the upper-left corner of 
the screen. Or press Tab until the start arrow is 
highlighted, then press Enter when ready. Once 
data collection begins, the Meter view switches to 
the Graph view and then the graph will autoscale 
when data collection is complete. (The graph at the 
right shows how the temperature changes as a 
tablet is added to 50 mL of room temperature water.) 

 

4. If you are finished with the experiment, you can unplug 
the sensor; data is automatically saved. If not, press 
Store Latest Data Set  button to store the first run. 
Press Enter to collect a second run of data. (The graph 
at the right shows run2: how the temperature changes 
as a new tablet is added to a new sample of 100 mL of 
room temperature water. Note how the scale 
automatically changed to fit the new data.)  
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5. It is possible to see all of the runs that you collected 
at one time. Click on the current run at the left (run2 
in this case) and select All. Both runs of data will 
appear on the screen simultaneously, and you will 
be able to compare temperatures at a given time by 
clicking somewhere in the graph. A vertical line will 
appear and the View Details area will indicate the 
temperatures at that time.  

Later in this guide you will see how the TI-Nspire handheld can be used to analyze the data that you 
have collected in this mode. 
 
Performing an “Events with Entry” Experiment 
There will be some experiments in which time is NOT an important factor when collecting data. You 
might want to collect data at one set of conditions and then under a different set of conditions. For 
example, what if you were interested in knowing the effect of changing the volume of a specific amount of 
gas on the pressure of that gas? It wouldn’t really matter how long it took you to change a gas from 4 mL 
to 20 mL (in 2 mL increments) but you might want the TI-Nspire handheld to record the actual pressure at 
each volume. “Events with Entry” would be the mode that you would want to use. Below you will see 
step-by-step directions on how to collect data in this manner. 
 

1. Before we set up the collection mode, it might be helpful 
to know that you can “click” in other areas of the screen 
as well. For example, in this experiment we might want 
to change the default units for pressure (kPa) to 
atmospheres (atm). Simply click on the reading window 
at the top, and select your preferred units from the drop-

down menu. You can also click on the view buttons , 

, , and areas such as Mode.  

2. Okay, let’s set up the data collection mode. Click on the 
Mode area at the left, and select Events with Entry. To 
name the event, click on the Event Name area that 
appears below Mode. The “event” is the variable that 
you are manipulating. Input the appropriate name and 
units of the event, and then click OK. In this case, we 
are changing the volume of 10 mL of air trapped in a 
plastic syringe. We will be studying the effect of 
changing this volume on the pressure of the gas. 
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3. To begin data collection, click the green Start 
Collection  arrow in the upper-left corner of the 
screen. Or press Tab until the start arrow is highlighted, 
then press Enter when ready. Once data collection 
begins, the Meter view switches to the Graph view. 
Notice that in this mode a new icon  is visible. This 
is the Keep button, and it allows you to take a snapshot 
of the data when you are ready. (The graph at the right 
shows what the screen looks like when the Keep 
button is pressed. The value of 10 is entered to 
represent the 10 mL of air trapped in the syringe.) 

 

4. When you are ready to record data at a new set of 
conditions, press the Keep button  again. 
(Important: Do NOT press the Stop  button!!! 
This is a common mistake made by new users. If you 
press Stop, you will need to start the entire experiment 
over again.) Notice that when you press Keep, the 
window will remind you of the previous event value that 
you entered.  

5. Continue collecting data until you are finished, and then 
press the Stop  button. Notice that every time 
you enter a new event value, the screen returns to the 
graph view. It will display all of the data points that you 
have recorded plus the current event that you are about 
to record. (The screen at the right shows blue dots for 
pressures recorded at 10 mL, 8 mL and 6 mL of 
volume. The “odd” point is the pressure of the air 
confined to 4 mL of space. The reason that it is in the 
center of the screen is that the Keep button has not yet 
been pressed and the value of 4 mL has not yet been 
entered.)  
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6. You have now finished recording data in Events with 
Entry mode. Notice that the button in the upper left 
corner of the screen has returned to the Start button. 
(The screen at the right shows all of the Pressure and 
Volume data for the original 10 mL sample of air.) 

Later in this guide you will see how the TI-Nspire handheld can 
be used to analyze the data that you have collected in this 
mode. 
 

 

Data Analysis 
 
There are a few different tools available in the DataQuest application that make analysis of the data that 
you have collected quick and easy. Two important methods will be presented in this section. 
 
Method 1: Striking Data 
Remember the effervescent tablet experiment? Part of the 
graph looked very linear, and it might be interesting to know the 
slope of the two temperature curves in the early of the 
experiment. We could then compare the rate at which the 
temperature dropped in each situation (a tablet dropped in both 
50 mL and 100 mL of room temperature water). 

 

1. Click in the graph to create a vertical line. Click in the center of the touchpad for about 1 second 
until you see a double arrow appear on the line.  

2. Let go of the center of the touchpad and run your finger lightly from left to right across the 
touchpad to select the area of the graph you would like to study.  

3. Right click (ctrl > Menu) and select Strike Data > Outside Selected Region. When finished 
your graph will only show the portion of the data that you selected.  
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4. Don’t worry. Your data is still there (as you can see 
from the Table view on the right). Striking data 
allows you to analyze just a portion of the data set 
without completing removing the information. 

5. Return to Graph View. Now you are able to analyze 
each linear portion of the temperature graph to 
determine the different rates at which the 
temperature was dropping. 
• Select Menu > Analyze > Curve Fit > 

Run1.Temperature and press OK. 
• Select Menu > Analyze > Curve Fit > 

Run2.Temperature to see the other information. 
Now the rate information (the “m” values) can be 
compared in the View Details window at left for 
each graph.  

 
 

   

Method 2: Adding a Calculated Column in Table View 
In the pressure/volume experiment, you’ll recall that we 
created a curve of pressure versus volume values. To 
determine the equation of a graph, sometimes it is helpful to 
“linearize” the data. In this section, we will explore how a new 
calculated column of data can be added in Table View and 
how that new variable can be selected for study in Graph view. 

 
1. Click on the Table View tab . Then “right click” on 

the View Details area at the left; choose New 
Calculated Column.  

2. Type in a name for the new column and any other fields 
that you find appropriate.  

 
3. In the same window, scroll down to the Expression 

field. Enter the mathematical expression for the new 
column. (In this case, since it is possible to “linearize” 
the data by graphing Pressure vs. Inverse Volume, the 
expression entered is 1/volume.) When finished, click 
OK. The expression variable must match exactly the 
column name, including capital letters. 
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4. Click on the Graph view tab  to analyze the data. Press Menu > Analyze > Curve Fit > 
Linear. Obviously the data of pressure vs. volume do not fit the line created as is evidenced by 
the poor r2 value of 0.860. (Data points with a good linear fit show an r2 value close to 1.00.) 

5. Click by the x-variable at the bottom of the graph (in this case, volume) and select the calculated 
column variable (inverse volume). The new graph is very linear. Redo the linear analysis. Here 
we see that Press = 8.219 * (1/Vol) + 0.079. (Remove the prior line with Menu > Analyze > 
Remove.) 

   

Data Collection and Analysis – Using the Colorimeter 
 
The colorimeter (shown at right) is used to collect information 
about how much light of a certain wavelength is absorbed by a 
solution. This sensor uses Events with Entry mode but has a 
few extra steps involved to set it up for use.   
The following procedure will highlight using the colorimeter to collect concentration and absorbance data 
using various solutions of green food coloring in water. First, data about four solutions of known 
concentration will be collected and then absorbance data of a solution of unknown concentration will be 
collected. 
 

1. Connect the colorimeter to the TI-Nspire handheld using an EasyLink cable or a TI-Lab Cradle. 
2. Select an appropriate wavelength of light to be used in the experiment by pressing the left or 

right arrows on the colorimeter. [You will want to use a different color other than the color of the 
solution. For example, if we passed green light (565 nm) through a green solution, most of it 
would be absorbed and we wouldn’t see much difference in the data. An ideal color of light to 
pass through a green solution would be red (635 nm).] 
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3. Click on the Mode area at the left, and select Events 
with Entry. Click on the Event Name area, enter the 
variable name for the event (usually Concentration) and 
the appropriate units, and click OK. 

 
4. Now the device must be calibrated with the solvent 

being used in the solutions. Fill a plastic cuvette about 
¾ full with the appropriate solvent (most likely this will 
be water) and place the cuvette in the holder inside the 
colorimeter. It is important that one of the smooth sides 
of the cuvette is pointed towards the white arrow at the 
top of the inside of the colorimeter. Also be sure that 
the smooth sides are free of oil or smudges from skin. 
Close the colorimeter door, and press the CAL button 
until the red light stops blinking. This will take about 5 
seconds. The absorbance reading in the meter view 
should read 0.00. 

 

5. To begin data collection, click the green Start 
Collection  arrow in the upper-left corner of the 
screen. Or press Tab until the start arrow is highlighted, 
and press Enter when ready. Replace the water 
cuvette with the first sample of known concentration 
being tested. Close the door, wait for the absorbance 
reading to stabilize, and then press Keep . Input the 
concentration of the known solution, and press Enter. 
Remove the first sample, replace it with the second 
sample, close the door, and press Keep. Repeat this 
process with the other samples of known concentration. 
When you are finished with all of the samples of known 
concentration, press Stop . (The screen to the 
upper right shows absorbance readings for known 
solutions with concentrations of 0.500M, 0.250M, 
0.125M and 0.0625M.) 

6. Find the best fit line through the data points. To do this, 
select Menu > Analyze > Curve Fit > Linear.  
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7. Put the sample of unknown concentration in the 
colorimeter, and close the door. Click Meter view ; 
note the absorbance reading once it stabilizes. 

8. To determine the concentration at this absorbance, 
click Graph view  . Then select Menu > Analyze > 
Interpolate. Click somewhere in the graph to see a 
vertical line.  
• Press the left or right side of the touchpad to move 

the line around on the graph. When you have 
moved the cursor to the appropriate place, the Fit 
Linear Value will correspond to the absorbance of 
the solution. You will then be able to read the 
concentration value at the top of the View Details 
window. (Note that in this example the unknown 
solution showed an absorbance of 0.163. The 
vertical line was moved into place until the Fit 
Linear Value was also 0.163. The concentration at 
this absorbance was 0.401 M.)  

 
 

 
 

Note: To display the concentration at a higher precision, simply click on the concentration value as 
shown above and set the desired Display Precision in the pop-up window.  
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In Conclusion: 
Hopefully, you have found the information in this appendix about how you can collect and analyze data 
using the TI-Nspire handheld to be helpful. 
 
For further information about other applications within the TI-Nspire handheld, visit: 
 http://www.atomiclearning.com/k12/en/ti_nspire 
 
For further information about the Vernier sensors that you will use with these experiments, visit: 
 http://www.vernier.com/products/sensors/ 
 
You might also want to visit the Science Nspired page on Texas Instruments’ website 
(http://education.ti.com/calculators/tisciencenspired/) where you’ll find some great simulations that can 
help you better understand concepts important to the AP Chemistry curriculum. 
 

    Example Shown: Molecular Titration Simulator 
 
 

200

http://www.timath.com/


 TI Technology Exam Acceptance 
 TI PROFESSIONAL DEVELOPMENT 
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TI-Nspire™ Technology 

Approved for Tests 
TI-Nspire™ CX 

TI-Nspire™ w/Touchpad 

TI-Nspire™ CX CAS 

TI-Nspire™ CAS w/Touchpad 

SAT* • • 
AP* • • 
PSAT/NMSQT* • • 
ACT* •  
International Baccalaureate •  
Praxis™ • • 
Texas STAAR® Grade 8 •  
Texas STAAR® Algebra •  

 
 
Graphing Technology 

Approved for Tests 
TI-84 Plus C Silver Edition 
TI-84 Plus Silver Edition 

TI-84 Plus, TI-83 Plus 

TI-89 Titanium 

SAT* • • 
AP* • • 
PSAT/NMSQT* • • 
ACT* •  
International Baccalaureate •  
Praxis™ • • 
Texas STAAR® Grade 8 •  
Texas STAAR® Algebra •  

 
 
* SAT and AP are registered trademarks, and SAT Reasoning Test and SAT Subject Tests are trademarks of the College 
Entrance Examination Board. PSAT/NMSQT is a registered trademark of the College Entrance Examination Board and 
National Merit Scholarship Corporation, neither of which were involved in the production of, nor do they endorse this 
product. ACT is a registered trademark of ACT, Inc., which does not endorse this product. Policies subject to change. Visit 
www.collegeboard.com and www.act.org. 
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